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Get Help

There are a number of ways to learn more about your product and interact with Oracle and other users.

Get Help in the Applications

Some application pages have help icons ® to give you access to contextual help. If you don't see any help icons on
your page, click your user image or name in the global header and select Show Help Icons. If the page has contextual
help, help icons will appear.

Get Training

Increase your knowledge of Oracle Cloud by taking courses at Oracle University.

Join Our Community

Use Cloud Customer Connect to get information from industry experts at Oracle and in the partner community. You
can join forums to connect with other customers, post questions, suggest ideas for product enhancements, and watch
events.

Share Your Feedback

We welcome your feedback about Oracle Applications user assistance. If you need clarification, find an error, or just
want to tell us what you found helpful, we'd like to hear from you.

You can email your feedback to oracle_fusion_applications_help_ww_grp@oracle.com.

Thanks for helping us improve our user assistance!
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1 Working with HCM Extracts

Introduction to HCM Extracts

This topic introduces ways of developing outbound integrations from Oracle HCM Cloud.

These include:

HCM Extracts
- Oracle Business Intelligence Publisher (Oracle Bl Publisher)

HCM Extracts

The main way to retrieve data in bulk from Oracle HCM Cloud is by using HCM Extracts, a tool for generating data files
and reports.

HCM Extracts has a dedicated interface for specifying the records and attributes to be extracted. With this tool, you can:

Identify records for extraction using complex selection criteria.

Define data elements in an HCM extract using fast formula database items and rules.

You manage HCM Extracts either in the Data Exchange work area or using the Checklists interface in the Payroll work
area. Alternatively, you can run extracts using the Flow Actions Service web service from outside Oracle HCM Cloud.
This feature enables you to automate the outbound extract as part of an overall integration flow.

@ Watch video

HCM Extracts Output Formats

Using the built-in integration with Oracle Bl Publisher, you can generate extracts in various formats, including CSV, XML,
Microsoft Excel, HTML, RTF, and PDF.

You can download the raw hierarchical XML from a completed extract using the Extract Actions Service web service.
Alternatively, you can download the formatted Bl report (for example, the CSV file) using the Bl ScheduleService. In both
cases, the output is streamed in a byte array. Therefore, any orchestration mechanism must handle this output, possibly
by means of wrapper code.

You can also generate an HCM Extract without specifying an output format at the design stage. Later, you can generate
a Bl report based on the extract using either Oracle Bl Publisher or the Bl ReportService. This technique uses a
dedicated Bl data model that interfaces with the generated HCM Extracts XML.

Oracle Bl Publisher

Oracle Bl Publisher supports both scheduled and unplanned reporting, based on either predefined Oracle Transactional
Business Intelligence analysis structures or your own data models. You can generate reports in various formats. To use
Oracle Bl Publisher for outbound integrations, you generate reports in a format suitable for automatic downstream
processing, such as XML or CSV.
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Extract Components

The HCM Extracts feature is a flexible tool for generating data files and reports. This topic covers how you can use the
extract components to define what information you want the application to extract and report on.

It also explains how the application displays, formats, and delivers the information.
Extract Definitions

An extract definition refers to the complete setup of an extract, that consists of extract data groups, criteria, records,
attributes, advanced conditions and output delivery options. An extract definition consists of:

- One or more extract data groups, depending on how many logical entities you want to extract.

- One or more extract records depending on how many groups of information you want to collect.

- One or more attributes depending on how many individual fields of data you want to collect.

You use HCM extracts to extract, archive, transform, report, and deliver high volumes of HCM data from the Oracle
Fusion HCM database. You can generate the output in the following formats:

- CSV

- XML

-+ Excel

« HTML

- RTF

- PDF

You can distribute the extracted information by email, FTP and other delivery modes. Some common examples of
extracts are: PDF payslips delivered to employees' mailboxes, payroll or benefits data transferred to third-party service
providers, HR and talent data exchange between Oracle Fusion and legacy applications, for example in a coexistence
scenario.

® Watch video

Data Groups

Extract data groups represent a business area or logical entity, for example person, assignment, or benefits. The
application uses this information to retrieve the database item groups. You define one data group as the primary or root
data group and this data group is the starting point of the data extraction.

Extract data group connections capture the association details between the current data group and the parent data
group. The data group connections form the hierarchical relationship among the data groups.

You can define a set of filtering conditions the application must perform on an extract data group using the extract data
group criteria. You specify the criteria conditions using an expression or fast formula.

Extract Records

Extract records represent a grouping of related data or a physical collection of all fields required in the extract. For
example, the Employee data group can have records such as Basic Details, Pay Details, Location Details, and Primary
Contact. An extract record is a collection of attributes which you can organize in a required sequence. For example, if
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a data group has 3 records, then you can specify the sequence in which the application processes the records. You can
also select the next data group to identify which data group the application processes next.

Attributes

Attributes are the individual fields inside the extract record. An attribute is the lowest attribute level of a HCM extract
and represents a piece of information, for example, person first name, person last name or person date of birth.
This figure shows the hierarchy of information within a data group definition.

[:: Extract Definition :)

Department
(Data Group)

I
v -

Department Department Other
Information Information
(Record) (Record)
¥ ¥ ¥ ¥
Department Department Department Department
= Name Location (Attribute) Start Date
[Attribute) [Attribute ) (Attribute)

Threading Database Item

A threading database item is a unique identifier for a given user entity to uniquely identify an extracted record.
Configuring threading database items makes the comparison and identification of changes in Changes Only extract
runs more efficient . You can define one threading database item at the root data group or at any child data group level.

Conditional Actions

A conditional action identifies the action to perform, and optionally, print a message based on the outcome of a
conditional expression or a predefined fast formula. Conditional actions are applied on the extracted data similar to
criteria conditions that are applied before extraction. Actions and messages are predefined in lookups, and you can add
your own messages by creating new values for the lookup.

When a condition is satisfied, you can use this feature to perform certain predefined actions. For example, you can
exclude employees that satisfy a condition, such as all employees from a predefined country. You can also configure this
feature to raise a warning when an employee's salary is blank or beyond a specific level.

Note: We strongly recommend users to avoid using conditional actions which can adversely impact the runtime
performance of an extracts run.

Exclusion Rules

You can exclude or override a record that doesn't suit your requirements with your own record by using an exclusion
rule. The extract process doesn't process excluded records based on the legislative data group.
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Note: We strongly recommend not using exclusion rules as these are extremely difficult to troubleshoot when records
get excluded. Alternatively, use Bl Publisher templates to handle the processing of conditional actions and exclusion
rules.

Related Topics
« HCM Extract Types

« How Extracts are Validated
« Define Extracts
- Overview of Generating Flexfield Database Items

HCM Extract Types

The type of extract you select decide the purpose of the extract. It also decide the parameters that are automatically
generated.

For example, if you select the Payroll Interface extract type, then the application creates a changes only parameter, and
the other parameters. You can select the extract type on the Extract Definitions page.

This table lists the different extract types and why you select them.

Extract Type Purpose
Archive Retrieval Use for reports based on permanently archived data, for example, payslip.
Benefit Carrier Use for providing data to third party benefits service providers.
Full Profile Use for complete employee and payroll data archives.
HR Archive Use for all HR archives.
Large Object Use for all large data objects.
Recruiting Archive Use for all recruiting archives.
Payroll Interface Use for providing data to third party payroll service providers.
Other Payroll Archive Use for all payroll archives.
Related Topics

- Large Object User Entities
- Define Extracts

ORACLE
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Overview of Global Payroll Interface Extract

Use the Global Payroll Interface report to extract payroll and employee details, such as the salary and deduction details.

Note: Global Payroll Interface extracts and reports only employee information.

Global Payroll Interface reports historical records for salary, element entries, and bank accounts on personal payment
methods. These records are all effective dated records that are effective within the specified extraction window. For all
other data, Global Payroll Interface reports the top of the stack record that's effective within the specified extraction
window.

You can use Business Intelligence Publisher templates to send the extracted data to the payroll provider. Copy this
extract definition to generate a custom flow with the same name as the extract.

You can add custom fields to the extract definition. The extracted data includes global and country specific data.
Depending upon the LDG, the application copies country specific data. For example, when you copy a GPI extract
definition within an Australian LDG context, global and Australia specific data is copied to the new extract.

For the countries that support a calculation card, if you copy the delivered GPI V2 into the country’s LDG, you get both
global and data including the calculation card. If the country doesn't support a calculation card, only global data is
extracted with the country specific name, address and bank account formats, and so on.

Payroll Interface uses the HCM Extracts infrastructure. All delivery options available within HCM Extracts are available
for Global Payroll Interface. For example, the output file can either be sent across through SFTP or using HCM Connect
over to prespecified destinations.

Before You Begin

Set up certain elements including license type for country and territory while you configure the Global Payroll interface.
Use the Features by Country or Territory task to set up Payroll Interface as the Selected Extension.

Geographies and Legislative Data Group

In the Setup and Maintenance work area, use the Load Geographies for US task in the Enterprise Profile functional
area to load geographies and create the geography structure for each country. Ensure that you have selected the Data
Source of either GBG/Logate or your own provider.

In the Setup and Maintenance work area, use the Manage Legislative Data Groups task in the Workforce Structures
functional area to define the legislative data groups to identify the country and its currency. Define at least one
legislative data group for each country and associate it with a PSU to provide the payroll information for workers.

Legal Employer

Alegal employer is a legal entity that employs workers. Define the legal entity type depending on the organization
structure as follows:

- One legal entity that's also a payroll statutory unit and a legal employer.

Multiple legal entities which are children of one payroll statutory unit.
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Payment Methods

Use the Organization Payment Methods task in My Client Groups to create at least one payment method for each
combination of legislative data group, payment type, and currency. You can also create rules to validate or process the
distribution of payments.

When creating a payment method, select the Payment Type as Electronic Funds Transfer (EFT).

Best Practices for Viewing User Entity Details

When creating an extract definition, you need user entity details to create data groups. You can search and view the
user entity details by navigating to the search page of the View User Entity Details task from the Data Exchange work
area. You can also access the User Entity Details Ul when you create a data group in the Design tab of the Extract
Definitions task.

® Watch video

View the User Entity Details

To search and view the user entity details on the User Entity Details page:

Click Navigator > My Client Groups > Data Exchange.

In the Data Exchange work area, click View User Entity Details.

On the User Entity Details page, enter a keyword or user entity name and its associated attributes.
Click Search.

In the Search Results section, click the user entity link to view the user entity details.

vVAhWNRA

Using the User Entity Details page, you can:

o Review the type of user entity, for example, single row, multiple rows, historic, or effective dated.
o View the database items available in a user entity.

o Validate user entities for use with root data groups.

o Review the contexts used and set by the user entity.

o Review the SQL query the user entity uses.

o Calculate the number of rows in a data set.

o Verify the extracts that are using the user entity.

The following sections detail the information that you can derive on the User Entity Details page.

Review the User Entity Details

In the User Entity Information tab:
If the value of Valid for Root Data Group is Yes, then the user entity can be used as a root data group. You can
also decide if a user entity is valid for use as a root data group, if the value of Multiple Rows is Yes and Context

Required is No. For example, the PER_EXT_SEC_PERSON_UE user entity can be used as a root data group, as
the value of Multiple Rows is Yes and Context Required is No.
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If a user entity isn't a multiple row user entity, you must not use it as the root data group. If a multiple row user

entity sets the contexts required for a single row user entity, the database item groups from the single row user
entity are generally included as derived database item groups to the multiple row user entity. For example, the

PER_PER_PERSON_DETAILS_UE user entity isn't a multiple row user entity.

If a user entity is historic, it retrieves data irrespective of the effective date. For example, the
PER_EXT_ASSIGNMENT_BASIC_HISTORY_UE user entity retrieves the entire historic details of an assignment.

If a user entity isn't historic, it retrieves data as of the effective date. For example, the
PER_EXT_PAY_EMPLOYEES_V2_UE user entity retrieves Person, Assignment, and Payroll details as of the
effective date.

Review the SQL query

The User Entity Query tab lists the SQL query that the user entity uses to extract data. You can review the table structure
and aliases which is useful for creating advanced filter criteria. If the user entity is valid as a root data group, you can
calculate the rows that the SQL query will return. However, the number of rows returned is an estimate and might

not match the exact number of rows the extract will return. The actual extract output depends on the filter criteria,
expressions, and fast formulas used in the extract.

Review the User Entity Contexts

The Contexts Set tab lists the contexts that you need to set to use the user entity in the extract. For example, the
PER_PER_PHONES_UE user entity requires the PERSON_ID context; therefore, you must set the PERSON_ID context
to use this user entity. Generally, the user entities that aren't historic require the EFFECTIVE_DATE context. However,
the EFFECTIVE_DATE context is set by default, so you don't have to set this context explicitly. The Contexts Set section
lists the contexts that are set by the user entity. For example, the PER_EXT_SEC_PERSON_UE user entity sets the
PERSON_ID, ORGANIZATION_ID, and ENTERPRISE_ID contexts that can be used by other user entities.

Verify Extracts Using the User Entity

The Extracts Using User Entity tab lists the other extracts that are using the user entity. If another extract is using the
user entity, you can review the extract design to understand how the user entity is being used. You can also copy the
extract design and then change it to suit your needs.

Related Topics
- Can |l use a user entity as a root data group?

« Why can't | find a newly delivered user entity?
« User Entities in HCM Extracts

User Entities in HCM Extracts

A user entity is a logical entity associated with a data group defined using HCM extracts. This topic describes the often
used user entities and the type of data you can extract by using those user entities.

You select user entities in the application when you define a data group.

The following table lists the most often used user entities.
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User Entity Name and Code

Person (PER_EXT_SEC_PERSON_UE)

Employees (PER_EXT_PAY_EMPLOYEES_
V2_UE)

Extract Assignment Basic History (PER_
EXT_ASSIGNMENT_BASIC_HISTORY_UE)

Extract Assignment Basic Information
(PER_EXT_SEC_ASSIGNMENT_BASIC_UE)

Assignments Range (PER_EXT_SEC_
ASSIGNMENT_RANGE_UE)

Extract Current and Future Persons (PER_
EXT_SEC_PERSON_NOW_FUTURE_UE)

Extract Current and Future Assignments
(PER_EXT_SEC_ASSIGNMENT_NOW_
FUTURE_UE)

Reset Context (PER_EXT_RESET_UE)

Assignment Standard Working Hours
(PER_ASG_SEQ_HISTORY_DETAILS_UE)

Chapter 1
Working with HCM Extracts

Description

Retrieves all persons across the enterprise and all person related attributes.

Returns Person, Assignment, and Payroll details as on effective date.

Retrieves assignment history as on the assignment effective start date.

Retrieves assignment data as on the effective date.

Retrieves assignment history as on the effective date.

Retrieves current and future person details. Specify advanced filter criteria to restrict person types.

Retrieves current and future assignments.

Use the Reset Context user entity in two ways:

1.

Reset the effective date contexts set dynamically by a parent data group using a runtime input
parameter for the effective date. For example, the Extract Assignment Basic History user entity
sets the assignment effective start date as effective date first and then retrieves the data, unlike
other user entities which use the effective date only. To use the Extract Assignment Basic History
user entity to include the historical data but also want to change the effective date, then include
the Reset Context user entity to reset this date using input parameters.

Set up the Reset Context user entity as the root user entity to be a container or header. For
example, the following work structure elements: locations, positions, and legal employers aren't
related to each other. To extract all in one single extract, then you can add them as child elements
to the Reset Context user entity used as the root in the extract definition. Adding this user entity
as the root to these elements enables you to retrieve this data separately because the elements
aren't linked to a hierarchy.

The function per_extract_utility.get_standard_working_hours selects the standard working hours for a
position attached to the assignment, or for the organization, or to the legal entity, in that order.

You can view more details about the user entities using the View User Entity Details task.

Related Topics

- Best Practices for Viewing User Entity Details

« Why can't |l find a newly delivered user entity?

« Example of Generating Flexfield Database Items
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Large Object User Entities

You can use user entities in HCM Extracts to extract large object (LOB) data. The LOBs are a set of data types that are
designed to hold large amounts of data. LOBs store various data such as audio, video, documents, and so on. Storing
data in LOBs enables you to access and manipulate the data efficiently in your application.

The LOB user entities extract content that's more than 240 characters, and you can only use the Large Object extract
type to extract data from the large object user entities. The limitations for extracting Large Object extract type are:

- It supports only one block in a record.
- It doesn’'t support Changes Only extracts.
- It supports only the SFTP delivery option.

- It supports only large object user entities.

Here are the 11 user entities that you can use in HCM extracts to extract large objects:

User Entity Name Code

Job Requisition IRC_JOB_REQUISITION_LRG_OBJ_UE

Job Requisition Template IRC_JOB_REQUISITION_TEMPL_LRG_OBJ_UE
Job Offer IRC_JOB_OFFER_LRG_OBJ_UE

Goals HRG_EXT_GOAL_LRG_OBJ_UE

Evaluation Participants HRA_EVAL_PARTICIPANTS_LRG_OBJ_UE
Evaluation Ratings HRA_EVAL_RATINGS_LRG_OBJ_UE
Evaluation Sections HRA_EVAL_SECTIONS_LRG_OBJ_UE
Common Notes HRT_EXT_COMMON_NOTES_LRG_OBJ_UE
Question Responses HRQ_EXT_QSTN_RESPONSES_LRG_OBJ_UE
Content Library IRC_CONTENT_LIBRARY_LRG_OBJ_UE
Profile ltems HRT_EXT_PROFILE_ITEM_LRG_OBJ_UE
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HCM Extracts doesn't store the files that you transfer to the SFTP hosts using the SFTP configuration. You can review
these files only from the remote directory, where the files are delivered.

Related Topics
- Best Practices for Viewing User Entity Details

« Why can't | find a newly delivered user entity?
« Define SFTP Configurations

HCM Extracts Templates

Use the predefined templates to quickly set up extracts. The following table lists the templates that are available for
different Extract types:

Extracts Type Template
Payroll Interface Global Payroll Interface
Other Payroll Archive Calculation Card Report

These templates enables you to define your extracts by choosing from a comprehensive list of data elements. Thus,
selecting the list of objects you need for your integration will automatically build the Extracts definition. You can choose
the list of attributes and select predefined filter criteria for various data elements. For example, when you select address
data element, you can choose the filter criteria to only select work address based on the address types that you've
defined in your implementation.

After you select the data elements and the filter criteria, your extracts definition is complete. You can move to the final
step of defining the delivery options to complete the design process.

The extracts defined using a template as the source, is like any other Extracts that you define. You can add data groups
and data elements to this newly defined extract to include more attributes according to your requirement.

Predefined Extracts

HCM Cloud has other sample extracts that are predefined. Unlike the templates, where you can select a subset of data
elements, you can't edit the predefined extracts. You can make a copy of the predefined extracts and work on the copy
to update the extract to your requirements.

The Work Structure and Worker extracts are the examples of predefined extracts. The Work Structure extract generates
details of business units, legal entities, departments, grades, jobs, locations, and positions, while the Worker extract
generates details of person names, phones, emails, national identifiers, address, legislative data, accruals, absences,
work relation, work term, assignment, work measure, supervisor, and salary.

10
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You must not run the predefined extracts directly. Make a copy to run these extracts. When copying and using these
predefined extracts, verify the following before extracting data according to your requirements:

- Define filter criteria. For example, to extract data related to specific locations, include an expression or fast
formula in the data group filter conditions.

- Remove data groups that aren't required for your integration requirement. For example, you might choose to
remove positions data group from your extracts that you copied.

- Review the details to ensure the data groups, records, and attributes that you've included meet your
requirements.

- Generate and compile the fast formulas that you've used and validate the extracts design.

- Refine the parameters to define the default values, if any.

Using Work Structure and Worker Extract Templates

To use the Worker or Work Structure extract templates:

Copy the Worker or Work Structure extract definition to create a new extract.
Update the copied extract.

Generate and compile fast formulas.

Validate the extract design.

Refine the parameters.

UhWUNA

Related Topics
« Define Extracts

Define Extracts

This example shows the steps required to create an extract definition.
Before you create an extract definition, you should understand the following details:
- Information that you want to extract.
- Structure in which the data must be extracted.
- How you want to deliver this data (including file format, delivery mechanism, and frequency information).

FAST Bank is a global organization with subsidiaries all over the world. As part of an external business reporting
requirement, FAST Bank is required to extract the department and employee details (grouped by department) across
the entire company. This information must be sent to a third party in an XML file and to HR Managers in a PDF file using
email. The following table summarizes the key decisions in this scenario:

Decisions to Consider In This Example

How many extracts do | create to produce = You create one extract definition to define a headcount report.
this type of report?

How many data groups do | create? There are 2 functional groups of information, therefore you create two data groups, one for the
department and one for employees.

n
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Decisions to Consider In This Example
How many records do | create? You decide the number of records based on the subgroup of attributes within a data group. In this

example, you create two records for the department data group:

- Department Details

- Department Summary

You create one record for the employees' data group: Employee Details.

How many attributes do | create? You decide the number of attributes based on the specific information required for that report. Create
the following attributes for the Department Details record:
- Department Name

- Department Location

For the Department Summary record, create the following attributes:

- Record Code
- Report Date

- Employee Count

For the Employees Details record, create the following attributes:

- Full Name

- Gender

- Date of Birth
- Salary

- Bonus

- Tax Rate

Do | create any fast formulas? You can use fast formulas at the following levels:

- Extract Criteria level to decide certain conditions.
- Extract Rule level to derive attribute values.
- Extract Advanced Condition level to specify complex conditions.

- Extract Record level to automatically generate formulas using the Generate Formula option.

Create an Extract Definition

1. On the Extract Definitions page, click Add > Create New to open the Create Extract Definition page.

2. Select HR Archive and enter 01-Jan-2000 as the Session Effective Date. The session effective date is an
effective start date that applies to all date-effective interactions in the current session.

Field Name Entry

Name FAST Bank Extract

12
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Field Name Entry

Note:
The application uses this name to generate the XML output file.

Start Date 01-JAN-2010
Consumer Undefined
Note:

Selecting Report in the Consumer field indicates that the extract is used for reporting
purposes and that the data isn't interfaced with any external applications.

Note:
The Consumer field doesn't appear for the extract type Archive Retrieval.

Additional Details HR Manager

Note:
The Additional Details field doesn't appear for the extract type Archive Retrieval and when
you select Report in the Consumer field.

Changes Only No

Note: In the Consumer field you can include the consumer name or the external application to which the
data generated by the HCM Extracts is sent to or interfaced with. Also, you can add details in the Additional
Details field to capture the names of applications or consumers. The Consumer field has a list of values. If
the application or consumer name isn't found in the list, you can provide the name in the Additional Details
field. If you've a predefined extract that can be used as a template, select it from the Source Template list.

Note: Capturing the consumer name or the external application to which the data is interfaced provides
information related to integration patterns and requirements from customers. This information can help
Oracle identify common integration patterns and deliver predefined templates, thus simplifying the Extract
creation and definition process.

3. Enter FAST Bank Extract as the name of the extract definition. The application automatically creates the tag
name based on the extract name and uses this name to generate the XML output file.

4. Click OK. The application saves the extract definition and automatically generates the parameters based on the
type of extract. The parameters control the output of an extract.
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Configure Effective Date Defaulting Rule

When extracts are scheduled, the Effective Date parameter, which is a required attribute, needs to be specified for
defaulting appropriate values. For example, running an extract daily will require passing the effective date in context to
the date on which it's run. To configure the effective date rule:

1. Open the extract for which you want to specify the Effective Date parameter.

2. In the Define tab, go to the Parameters region and select Advanced View from the Show list.
3. Select the value from the Parameter Basis list.

4. C(lick Save and Close.

Rename Extract Definitions

You can rename an extract when you want to import or migrate a later version of the extract with the same name.
Renaming will help references in external applications remain unaffected, while you can update the extract with a later
version.

1. Inthe Extract Definitions page, click Actions > Copy or Rename.
2. Select Rename and enter the extract name.
3. Click OK. After renaming the extract, ensure that you run a new baseline if your extract is incremental.

Related Topics
 Guidelines for Delivering Extracts

- Extract Components
« Define the Bl Publisher Template in HCM Extracts

Create Data Groups and Extract Data Group Connections

As part of the Define Extracts process, you need to create two data groups: one for the department and one for
employees. You also need to create extract data group connections.

® Watch video

Here are the steps:

1. Click the Design tab to create the data groups and records.
2. Create the root data group with the following information:

Field Name Entry

Name Departments

Tag Name Departments

User Entity PER_EXT_SEC_ORGANIZATION_UE

Threading Database Item Extract Organization Business Group ID
3. Click Save.

14
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4. I Note: The Enable Object Snapshot option appears only for the root data group.

Select Enable Object Snapshot to allow object snapshot support through the REST service. Selecting this also
enables the object snapshot key attribute. Object Snapshot Key attribute is derived from the Threading Database
Item (Extract Organization Business Group ID).

For details on Object Snapshot REST API, see Object Snapshots REST Endpoints in REST API for the Oracle HCM
Cloud guide.

5. Click Add to define a new data group.
6. Complete the fields to create a new data group, as shown in this table:

Field Name Entry
Name Employees
User Entity PER_EXT_SEC_ASSIGNMENT_BASIC_UE

7. Click Save to create a data group for Employees.

8. Select Employees in the Object Name tree and define the data group connection details.
9. Click the Connect Data Groups tab.

10.Complete the fields to create a data group connection, as shown in the table:

Field Name Entry

Parent Data Group Database Iltem Extract Organization ID

Database Item Extract Assignment Department ID
11. Click Save.

What to do next

Define the data group filter criteria for each data group by selecting the Filters tab.

Defining a set of filtering conditions lets you restrict the data extraction. The application uses these conditions to
perform the extraction on the extract data group using the extract data group criteria.

You can specify the data group filter as an expression or as a fast formula, and you can choose one or both. You can
build criteria using the available database items, parameters, and operators (conditional and logical). The filter criteria
become efficient as HCM Extract appends it to the User Entity SQL at the time of execution. If you can't specify the
criteria as an expression, then you can place logic inside a fast formula and include this in your definition. Fast formulas
return values of Y or N to indicate whether you must extract the record or not. If both criteria and formula are specified,
then both conditions are applied.

Create Extract Records

As part of the Define Extracts process, you need to create extract records.

® Watch video
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You decide the number of records based on the subgroup of attributes within a data group. In this example, you create
two records for the Departments data group:

- Department Details
- Department Summary
You create one record for the Employees data group: Employee Details.

To create the records for the Departments data group:

1. Select the Departments data group from the Object Name tree and click Add > Record.

Extract records represent a physical collection of all required fields. If a data group has 3 records, then you can
specify the sequence in which the application processes the records using the sequence field. You can also select the
Next Data Group to identify which data group the application processes next.

2. Create two records for the Departments data group.
3. Complete the fields to create two records for the Departments data group, as shown in this table:

Field Department Summary Department Details
Name Department Summary Department Details
Sequence 15 10
Type Detail Record Detail Record
Process Type Fast Formula Fast Formula
Next Data Group NA Employees

4. Click Save.

o

Select the Employees data group from the Object Name tree and click Add > Record.

6. Create one record for the Employees data group. Complete the fields to create a record for the Employees data
group, as shown in the table:

Field Name Entry
Name Employee Details
Sequence 5
Type Detail Record
Process Type Fast Formula

7. Click Save.

Create Attributes

As part of the Define Extracts process, you need to create attributes.

16
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You decide the number of attributes based on the specific information required for that report. Create the following
attributes for the Department Details record:

- Department Name
- Department Location

For the Department Summary record, create the following attributes:
+ Record Code

- Report Date

- Employee Count

For the Employees Details record, create the following attributes:
-« Full Name

- Gender

- Date of Birth

- Salary

- Bonus

- Tax Rate

Complete the following steps to create attributes for the records:

. Select the Department Details record in the Departments data group and click the Attribute tab.
. Click Add > Database Items to search and select the following database items:

o Organization Name

o Organization Location Country

. Click Save. An extract attribute is an individual field of a record.
. Select the Department Summary record in the Departments data group and click the Attribute tab.
. Click Add and select the following attributes:
o String
o Parameter
o Summary Element
Complete the fields as shown in the table to create extract attributes and save the record:

Field Name Attribute Entry Attribute Entry Attribute Entry
Type String Parameter Element Summary Element
Name Record Code Effective Date Employee Count
Data Type Text Date Number

Output Column 1 2 3

String Value 999 NA NA

ORACLE
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Field Name Attribute Entry Attribute Entry Attribute Entry
Parameter Effective Date NA NA
Aggregate Function NA NA Count
Aggregate Record Name NA NA Employees Employee Details

6. Select the Employee Details record in the Employees data group and click the Attribute tab.
7. Click Add > Database Items to search and select for the following database items:
o Person Full Name

o Person Gender
o Person Date of Birth

8. Complete the fields as shown in this table to create extract attributes and save the record.

Field Name Attribute Entry Attribute Entry Attribute Entry
Type Database Items Decoded Database Items Database item group
Database Item Person Full Name Person Gender Person Date of Birth
Name NA Gender NA
Data Type Text Text Date
Output Column 1 2 3
Decoded Value NA 'M','1','F','0", "', NA

9. Click Save.

What to do next

Create more extract attributes for the Employee Details record, as shown in the table:

Field Name Attribute Entry Attribute Entry Attribute Entry
Type Database item group Record Calculation Rule

Database Item Group Assignment Salary Amount NA NA

Name Salary Bonus Tax rate

Output Column 4 5 6

Calculation Expression NA Salary * 0.5 NA

Rule NA NA FAST Bank Tax Rule

You can click on an attribute to see the basic and additional information for the attribute. Additionally, review the
Hidden, Required, and Wrap as CDATA check boxes for the attribute.
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Note: When business object attribute values are supplied with special characters, it can lead to extraction failures.
Select Wrap as CDATA to prevent such issues.

Define Delivery Options

As part of the Define Extracts process, you need to define delivery options. Select Extract delivery options to define the
formatting and layout for the extract definition.

@ Watch video

Here are the steps:

1. Select the Deliver tab and then click Add to define the delivery options.

2. Enter the delivery option name and type. Complete the fields for the delivery options, as shown in this table and click
OK.

B Field Value Value
Bl Publisher Template ReportLayout EFTLayout
Output Type PDF EET
Delivery Type Email FTP
Delivery Option Name Email to HR FTP to 3rd Party
Output Name HeadcountReport EFTReport

3. Define further information for each delivery option in the Additional Details region. Ensure you enter the more
information such as, the server, user name, and password for the FTP delivery type.

4. Click Validate to review the extract definition setup. Review the validation messages and ensure the structure is
valid.

5. Select Export XML Schema to download the XML Schema Definition (.XSD) file for this extract setup. This exported
file contains the structure of the extract definition: the data groups, records, and attributes.

6. Click Done.

Preview an Extract

Previewing the extract definition lets you to verify the output structure of a sample data set by providing specific
parameter values for defined parameters, if any. After validating the Extract definition, preview the Extract design before
submitting it.

1. Open the extract that you want to preview and go to the Preview tab.

Note: Preview option is available only for user-defined extracts. It isn’t available for predefined extract definitions.
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2. Enter the values in the Parameters section. To gather more diagnostics of the extracts run, run the Extracts with
Debug set to Yes under the Diagnostics section.

3. Enter a value in the Threading Object ID field to extract data for a specific threading database item defined for the
Extract. Leaving the Threading Object ID field blank extracts random sample data.

I Note: Threading Object ID appears only for extracts for which threading database item is defined.

I Note: It is recommended to define extracts with threading database item for improved efficiency.

4. Click Preview to start the preview process.

I Note: Preview button is enabled only after you validate your extract definition.

5. Click Download to download the sample XML output generated to build your Bl Publisher templates. It also
downloads the log file that you can use for troubleshooting.

Submit an Extract

An extract definition automatically creates an extract process (payroll flow) with the same name as the extract. The
extract process enables you to define an execution sequence of multiple tasks, including before and after tasks.

Before you start

Preview the output structure to verify the Extract design.
Here's what to do

1. On the Extract Definitions page, select the FAST Bank Extract process and click Submit Extracts.
2. On the Submit Extract Instance page, enter the FAST Bank Extract instance name.

3. Enter Effective Date to identify the records that are eligible for extracts. The effective date is used by all date
effective user entities delivered by HCM Cloud.

You can schedule the extract, or run it immediately.

Click Submit to review the results of the extract run.

The View Extract Results page displays the FAST Bank Extract process instance status.
Click the instance name link to view the report output details.

No v

Related Topics
« How Extracts are Validated

« Guidelines for Delivering Extracts
 Define Extracts

Extract Deleted Object Details

Extract the key details of deleted objects using the Event Object Changes user entity, HRC_EVT_OBJ_CHANGES_UE.
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The method relies on the data captured using the HCM Events framework. You need to purge this data periodically by

using the Purge HCM Event Archive Data process for an improved application response.

After extracting the details, send that information to your downstream applications. To extract the deleted object
details, you need to include the filter, Event Object Changes operation type in = (‘DELETE', 'DELETE CHANGES', 'ZAP’).
This table lists the tracked objects and keys.

Objects

SalaryEO

EvaluationEO

ProfileInterestEO

ProfileKeywordEO

Element Entry

ApplicantAssignmentDEO

ApplicantTermsDEO

CWKTermsDEO

EmployeeAssignmentDEO

EmployeeTermsDEO

NWAssignmentDEO

NWTermsDEO

OfferAssignmentDEO

OfferTermsDEO

PWAssignmentDEO

PWTermsDEO

AssignmentExtralnfoDEO

ORACLE

Tables

CMP_SALARY

HRA_EVALUATIONS

HRT_PROFILE_INTERESTS

HRT_PROFILE_KEYWORDS

PAY_ELEMENT_ENTRIES_F

PER_ALL_ASSIGNMENTS_M

PER_ALL_ASSIGNMENTS_M

PER_ALL_ASSIGNMENTS_M

PER_ALL_ASSIGNMENTS_M

PER_ALL_ASSIGNMENTS_M

PER_ALL_ASSIGNMENTS_M

PER_ALL_ASSIGNMENTS_M

PER_ALL_ASSIGNMENTS_M

PER_ALL_ASSIGNMENTS_M

PER_ALL_ASSIGNMENTS_M

PER_ALL_ASSIGNMENTS_M

PER_ASSIGNMENT_EXTRA_INFO_
M

Primary Key Attributes

Salaryld

Evaluationld

ProfileInterestld

ProfileKeywordld

ElementEntryld

Assignmentid

Assignmentld

Assignmentld

Assignmentid

Assignmentld

Assignmentld

Assignmentid

Assignmentld

Assignmentld

Assignmentid

Assignmentld

AssignmentExtralnfold

Primary Key Columns

SALARY_ID

EVALUATION_ID

PROFILE_INTEREST_ID

PROFILE_KEYWORD_ID

ELEMENT_ENTRY_ID

ASSIGNMENT_ID

ASSIGNMENT_ID

ASSIGNMENT_ID

ASSIGNMENT_ID

ASSIGNMENT_ID

ASSIGNMENT_ID

ASSIGNMENT_ID

ASSIGNMENT_ID

ASSIGNMENT_ID

ASSIGNMENT_ID

ASSIGNMENT_ID

ASSIGNMENT_EXTRA_INFO_ID

21



Oracle Fusion Cloud HCM
HCM Extracts

Objects

AssignmentSupervisorDEO

AssignGradeStepsDEO

AssignmentWorkMeasureDEO

CitizenshipEO

ContactRelationshipDEO

DriversLicenceEO

EmailAddresseO

ExternalldentifierEO

NationalldentifierEO

PassportEO

PersonExtralnfoDEO

PeriodOfServiceEO

PersonEO

PersonAddressUsageDEO

PersonNameDEO

PhoneEO

RateValueDEO

VisaPermitDEO

Tables

PER_ASSIGNMENT_
SUPERVISORS_F

PER_ASSIGN_GRADE_STEPS_F

PER_ASSIGN_WORK_MEASURES_F

PER_CITIZENSHIPS

PER_CONTACT_RELSHIPS_F

PER_DRIVERS_LICENSES

PER_EMAIL_ADDRESSES

PER_EXT_APP_IDENTIFIERS

PER_NATIONAL_IDENTIFIERS

PER_PASSPORTS

PER_PEOPLE_EXTRA_INFO_F

PER_PERIODS_OF_SERVICE

PER_PERSONS

PER_PERSON_ADDR_USAGES_F

PER_PERSON_NAMES_F

PER_PHONES

PER_RATE_VALUES_F

PER_VISAS_PERMITS_F

A few things to consider when using the operation types:

- Use the DELETE operation type to identify deletes of nondate-effective objects.

Primary Key Attributes

AssignmentSupervisorld

AssignGradeStepld

AssignWorkMeasureld

Citizenshipld

ContactRelationshipld

DriversLicenseld

EmailAddressld

Externalldentifierld

Nationalldentifierld

Passportld

PersonExtralnfold

PeriodOfServiceld

Personld

PersonAddrUsageld

PersonNameld

Phoneld

RateValueld

VisaPermitld
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Primary Key Columns

ASSIGNMENT_SUPERVISOR_ID

ASSIGN_GRADE_STEP_ID

ASSIGN_WORK_MEASURE_ID

CITIZENSHIP_ID

CONTACT_RELATIONSHIP_ID

DRIVERS_LICENSE_ID

EMAIL_ADDRESS_ID

EXT_IDENTIFIER_ID

NATIONAL_IDENTIFIER_ID

PASSPORT_ID

PERSON_EXTRA_INFO_ID

PERIOD_OF_SERVICE_ID

PERSON_ID

PERSON_ADDR_USAGE_ID

PERSON_NAME_ID

PHONE_ID

RATE_VALUE_ID

VISA_PERMIT_ID

- Use the DELETE CHANGES operation type to identify deletes of one or more date effective changes for a date-

effective object.

ORACLE
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Use the ZAP operation type to identify deletes of a date-effective object including the delete of all its date-
effective changes.

Use the Purge HCM Event Archive Data process to purge the data periodically and improve the application
response. The method relies on data captured using the HCM Events framework.

Ignore the deleted objects that appear multiple times in the extract results. Multiple events might record one
delete and therefore a deleted object might appear many times in the extract results.

How Extracts are Validated

Use the Validate feature in the Extract Definitions task to ensure the data you enter in the Design tab is valid and there
are no issues when you submit.

@ Watch video

After creating an extract, go to the Validate tab and click Validate. If there are any issues in the extract design, validation
messages are displayed.

Validate Extracts

When you validate an extract, the application performs validations on the extract design to ensure that:

- The root data group is defined.

- All non-root data groups are linked to the root data group directly or indirectly (for example, through another
non-root data group that is linked to the root data group).

If a sequence of data groups is defined, then the next data group is also defined for processing.
- All Fast Formulas used in the extract exist and are compiled or valid.
- There are no issues detected during Bl Publisher validations.

If the validation is successful, the application marks the extract as valid. However, if the validation fails, the application
marks the extract as invalid and submitting the extract results in errors.

Related Topics
- Do | have to validate existing extracts?

« Why can't | submit an extract run?
 Define Extracts

Review Extract Run Details

Using the View Extract Results task, you can review extract run information and troubleshoot extract runs that are
unsuccessful or have not produced the expected results. You can use the various filters to search the extract or extract
run that you want to analyze.

® Watch video
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To search and view the extract run information on the View Extracts Results page:

1. Click Navigator > My Client Groups > Data Exchange.
In the Data Exchange work area, click View Extract Results.

3. Onthe View Extract Results page, enter the extract instance name or extract name, submission date range, and
its process status.

4. Click Search.
5. Inthe Search Results section, click the extract instance name to view the extract run details.
On the extract details page, you can review the following information:
- General information
- Criteria
Instance details
- Changes Only details
Extract delivery options
Diagnostics

Extract Run Analysis

The following sections detail the information that you can derive from the View Extract Results task.

General Information

The General Information tab displays the extract run details such as the name of the extract and its workflow process
name, the extract process submission and completion date, its status, if the extract run is submitted and completed
successfully or not, and so on. You can also view the process occurrence state and elapsed time.

Criteria

The Criteria tab displays the parameters set for the extract run. For example, Baseline Only, Changes Only, Process Start
Date, Process End Date, Process Configuration Group, and so on.

Instance Details

The Instance Details tab lists the processes and their hierarchy. You can view the process status, start and finish
time, and status of the process. You can also download the process log files to help you troubleshoot failed or time-
consuming extract runs.

Changes Only Details

Use the Changes Only Details tab to review the change in an attribute from the last successful run. This tab is visible
only when the extract is run in the Changes Only mode. You can verify if the Changes Only parameter was set in

the Criteria tab. Select the attribute and enter the attribute value to check the change in the attribute from the last
successful run.

Extract Delivery Options

The Extract Delivery Options tab displays the output files that you can download if the extract run is submitted and
completed successfully.
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Diagnostics
The Diagnostics tab displays the bar graph showing the percentage completion of the following phases:
Preprocessing
- Archive processes
Root data group
- XML generation
Formatting in BIP
Report Delivery

Hover over the bar graph to review the phases that are taking more time.

Extract Run Analysis

The Extract Run Analysis tab displays the line graph comparing ESS jobs, Extract job, and current extract run with other
extract instances to identify the phase-wise timing and improve the processing time for the subsequent runs.

Extract Configuration Groups

Extract configuration groups interface is used to create unique extract configuration groups with custom parameters
and feature settings related to logging and performance.

To access this interface:

1. Go to Navigator > My Client Groups > Data Exchange
2. Inthe Data Exchange work area, select Extract Configuration Groups

Creating a new Extract Configuration Group

1. On the Extract Configuration Groups, you'll find a list of pre-seeded extract configuration groups with default
parameter values.

To create a new extract configuration group, select a suitable pre-seeded extract, click the Actions overflow
menu at the end of the record.

Click Copy.

Enter a name for your custom extract configuration group and click OK.

The newly created configuration group will be available among the existing ones.

You can sort the list by Last Saved or by Name in ascending order and search to find extract configuration
groups by name.

N

cupuw

Editing the new Extract Configuration Group

To create a unique extract configuration group tailored to your requirements, customize the newly created configuration
group as follows:

1. Click on the newly created extract configuration group to launch the Edit Configuration Group page.
2. Review the Default Value for the various attributes in the Parameters and Features sections and provide
Override Value if you want to change the default setting.
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Note: For more information on Extract Specific Process Parameters and Features, see: Extract Process
Configuration Parameters

3. Click Validate to check for errors and update the values accordingly.
4. C(lick Save and Close.

Once you create your new Extract Configuration Group, it'll automatically appear in the following drop downs:

- Configuration Groups in the Payroll Process Configuration page
o Navigate to Home > My Client Groups > Show More > Payroll Process Configuration task

- Process Configuration Group in the Submit Extract Instance page
o Navigate to Home > My Client Groups > Data Exchange > Submit Extracts task

Export Extract Configuration Groups

To bulk-export your custom extract configuration groups as an XML file:
- Click Export to launch Select Extract Configuration Group page.
- Select the required user created extract configuration groups from the list.
« Click Add.

- Click on Download on the confirmation message to access the XML file.

Import Extract Configuration Groups
To bulk-import custom extract configuration groups XML file to the page:
- Click Import to launch Import Configuration Group page.
- Click Browse to select the XML file.
- Click OK.
Note: If an existing configuration group is found you may choose to overwrite using the new XML file or keep

the existing configuration. You can also download the log file to review the details of the import.

- Click on OK on the confirmation message.

Refresh the page to see the imported configuration groups listed on the page.

Extract Process Configuration Parameters

Extract processing parameters are system-level parameters that control aspects of extract-related processes.

The following sections describes Extracts specific processing parameters and features and their predefined default
values.

26
ORACLE



Oracle Fusion Cloud HCM
HCM Extracts

Parameters

Parameter Name

Bl Qutput Size

Maximum Errors Allowed

Chunk Size

Threads

Use Bind Parameters

Enable Multithreaded XML Generation

Changes Only Extract Delete Mode

Logging Category

Formula Execution Log Level

Maximum Threads

Trace Level

Enable Trace

Features

Feature Name

Enable BIP XML Splitting and Merging

ORACLE

Description

Determines the size of reports in Bl

Number of consecutive actions that can return
an error before the entire process is given a
status of Error.

Number of relationship actions that should
process together in chunks during the main
processing phase.

Determines the total number of sub-processes
that run under the concurrent manager.

Use bind variables during action creation
phase.

Generate XML for extract using multiple
threads.

Indicates whether a bulk delete or single row
delete will be done when running changes only
extract.

Specifies the type of detailed logs used for
troubleshooting and issue investigation

Specifies the logging level to investigate
formula code problems.

Defines the maximum total number of threads
that the process can spawn dynamically.

Specifies the amount of database trace
information generated when tracing is enabled
for the process.

Enables the database trace facility. Only applies
to application C processes.

Description

Process configuration to enable BIP to split
large XML output from Extracts into multiple

Chapter 1
Working with HCM Extracts

Default Value

999999999999999

20

20

Replace All Binds (Y_ALL)

Yes (Y)

Bulk Delete (B)

NA

No Logging

20

Database Trace (1)

No (N)

Default Value

No (N)
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Feature Name Description Default Value

chunks to allow for parallel processing and
merge after processing.

Download Consolidated Extract Output Only Downloads only the final consolidated output Yes (Y)
file generated from individual HCM Extract XML
fragments. Default is Y. Set to N to download
both the consolidated file and individual output

fragments.

Include Null Values in XML Output Specifies whether null values are written to the = Yes (Y)
XML output.

Store Intermediate XML Output Enables storage of intermediate XML output No (N)

when performing multiple transformations in
HCM Extracts. Default: N

Suppress UCM Delivery for Empty File Specifies the values to suppress UCM delivery Suppress Job and Raise Warning (W)
when the BIP output file size is O KB. Default is
W. Valid values: W, E, M.

Suppress Native SFTP for Empty File Specifies the values to suppress Native SFTP Suppress Job and Raise Warning (W)
when the BIP output file size is O KB. Default
value W. Valid values: W, E, M.

Related Topics
« Extract Configuration Groups

« Payroll Process Configuration Groups

Security Configuration

Users require the following privileges to perform Extract configuration, submit Extract definitions, and access Extract
results.

Privilege / Role Name Privilege / Role Code Description Task Flow Access

Manage Data Exchange Work Area = HRC_MANAGE_DATA_EXCHANGE_ Allows management of the Data Data Exchange Work Area

PRIV Exchange Work Area.
Manage HCM Extract Definition PER_MANAGE_HCM_EXTRACT_ Allows configuration of data to Extract Definitions
DEFINITION_PRIV be extracted and output in any
generic format, such as delineated
text or XML.
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Privilege / Role Name

Run HCM Extract

Run HCM Extracts Report

Manage Payroll Flow Pattern

Download data for Extracts Export;
(Role Name)

Privilege / Role Code

PER_RUN_HCM_EXTRACT_PRIV

PER_RUN_HCM_EXTRACT_
REPORT_PRIV

PAY_MANAGE_PAYROLL_FLOW_

PRIV

HCM_EXTRACTS_EXPORT_RWD

(Role Code)

Description

Allows running of the extract
process and submission of the
write process.

Allows access to the extract data
model when running a report.

Allows management of Payroll
Flow Pattern.

Downloads data file to extracts
related data.

Chapter 1
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Task Flow Access

Submit Extracts

Note:

To submit an extract, users will
require appropriate payroll flow
pattern security profile assigned
to them. For more details on
payroll flows security profile,
see Administering Payroll Flows
guide.

View Extract Results

Note:

To view the results of an

extract run, users will require
appropriate payroll flow pattern
security profile assigned to
them. For more details on
payroll flows security profile,
see Administering Payroll Flows
guide.

Refine Extracts

Note:

You will also require appropriate
payroll flow security profile to
configure the flow tasks for a
specific payroll flow in the Refine
Parameters Page. For more
details on the payroll flows and
payroll flow security profile, see
the Administering Payroll Flows
guide. For details on Refine
Parameters, see Flow Patterns
chapter.

Data Exchange Work Area

If you have a Bl Publisher template for formatting your output, see the Define the Bl Publisher Template in HCM Extracts
to know the required permissions.

ORACLE

29



Oracle Fusion Cloud HCM Chapter 1
HCM Extracts Working with HCM Extracts

Related Topics
- Flow Patterns for Extracts and Reports

« Define the Bl Publisher Template in HCM Extracts
- Flow Security and Flow Owners

Retention Period for Archive Data

Extracts generated archive data is retained for 7 days from the date of archive creation.

Archives generated by full run extracts that are older than 7 days are automatically purged to improve the efficiency of
extract runs.

The retention period of 7 days applies to all non-incremental user-defined extract runs (full extracts) that you schedule.

Note: You can remove the output files generated by extracts that are stored in WebCenter Content using the Delete
HCM Extract Documents process.

Purge Extracts Archive Information

You can remove redundant archive data, which is older than 7 days, to free up space and improve overall performance in
your database.

Use the Business Intelligence Publisher (BIP) report to know the top 20 storage-consuming extracts and basic
recommendations for purging to free up space and improve the runtime and operational efficiency of your system. You
can find the Purge Recommendation Report in the BIP catalog.

Use the Purge Extracts Archive Data process to remove the unnecessary information.

Note: For significant optimization and runtime efficiency, it's recommended that you run this process for full extracts.

Here's how you can purge the redundant extracts archive information:

1. Select and search Purge Extracts Archive Data job under Scheduled Processes. The archive data includes the
associated payroll actions, object actions, and action information rows generated by extracts.

2. Inthe Process Details page, define the criteria for the purge process by selecting the appropriate values for the
process parameters.

Parameter Name Values Default Value

Report Mode Yes/No Yes

o Yes: Provides details of the archive
data you want to purge

o No: Purges the archive data generated
by the selected Extract List
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Parameter Name Values Default Value
Extract List Lists the extracts to purge or generate a N/A
report
3. Click Submit.

4. You can search for the job and check the completion status with any scheduled processes.
5. If you run the process in Report Mode, the output file provides a report including these details:

o Extract definition Name
o Extract Type
o Archive data count

o Storage recovered by the purge process

o

Use the details in the report to identify data that you want to clean up from the application.

I Note: You can run only one instance of this ESS job at any time.

Purge Extracts Archive using Remove Person Information Process

You can clean-up the extracts generated archive data, when running the Remove Person Information process for an ex-
employee, by selecting the 'Extracts Archive' from the list of available business objects.

Purge process relies on the User entities used in the threading blocks and the contexts set by these user entities to
determine the archive data for a given ex-employee to be purged. User entities setting any of the following contexts will
facilitate associating the archive data to the person number passed to the purge process.

Person Id
HR Assignment Id
- Work Relationship Id

Payroll Relationship Id
Payroll Assignment Id

Note:
- When extracts is run again for these disposed of ex-employees, any leftover data, might still get reported in the
extracts and archived. You should consider excluding these disposed of employees from your extracts run.

- You can run the Purge Extracts Archive Data to purge archive data generated by specific extracts and archives
that are older than 7 days.

Related Topics
- What are scheduled processes?
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Delete HCM Extracts Documents in UCM

Delete HCM Extracts generated attachments and documents that are stored in UCM.

You can now purge the HCM Extracts generated attachments and documents stored in UCM that are older than the
retention period. Use the Delete HCM Extract Documents process to purge the documents. When extracts are run,

following files are placed for various extract runs and delivery options defined.

Extract Type Delivery Option
- Customer-defined extracts with 7 days Bl Publisher (BIP) delivery options:
retention period
- Predefined extracts with a predefined . Email
retention period
- FTP
- None
« Customer-defined extracts with 7 days - WebCenter Content

retention period
P - Inbound Interface

- Predefined extracts with a predefined
retention period

UCM Content

Files generated and stored as attachments for
delivery options other than WebCenter Content
and Inbound Interface.

Content generated by WebCenter Content and
Inbound Interface delivery options in UCM.

The Delete HCM Extract Documents process cleans up the files described in the table above and uses the following

parameters:
Parameter Name Description
Report Mode Uses a Yes/No value.
- Yes: Runs the process in Report Mode
- No: Purges eligible documents from UCM.
Extract Definition Lists the extracts to purge or generate a report.

Value

Yes/No

Default: Yes

Not applicable.

The following privileges and duty roles are required to run the purge process for the Delete HCM Extract Documents

process:
Privilege Name / Duty Role Name Privilege Code / Duty Role Code
Manage Scheduled Processes FND_MANAGE_SCHEDULED_PROCESSES_PRIV

Submit a Payroll Flow (Duty Role Name) ORA_PAY_PAYROLL_FLOW_SUBMISSION_DUTY

ORACLE
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Note: The Delete HCM Extract Documents process doesn't purge the Payments, Payroll Archive, and Payslip extract
types. To know the defined retention period of predefined extracts, refer the documentation for respective extract

type.

It is recommended to periodically clean up the documents generated by Extracts to remove any redundant document.
This improves the runtime and operational efficiency of your system.

Extracts Process Diagnostics Report

You can run the Extracts Process Diagnostics Report process to generate the diagnostics report of an HCM Extracts
definition or for a specific HCM Extracts process.

This process generates the Extract design time, runtime, data, and changes only extract diagnostics report to:

- View recommendations about an Extract definition design, missing or incorrect design choices, and take
corrective actions.

- Identify the phase-wise time and recommendations about an Extract run to improve the processing time for the
next runs.

- Identify the anomalies in the extracted data that prevent the usage of generated HCM Extracts XML data by
Oracle Business Intelligence Publisher or other publishing tools.

- Debug incremental extract changes with the Changes Only modes.

To submit and run the process from the Scheduled Processes work area:

1. Click Navigator > Tools > Scheduled Processes.
2. On the Scheduled Processes Overview page, click Schedule New Process.
3. Leave the type as Job, search and select the Extracts Process Diagnostics Report process, and click OK.
4. Inthe Process Details dialog box, select the Scope and Scope Value:
o For Design Time Diagnostics scope, the available extract definitions are listed as the scope value.
o For Runtime Diagnostics, Data Diagnostics scope, and Changes Only Diagnostics the extract runs or
instances are listed as the scope value.
5. For Changes Only Diagnostics, select the mode category and attribute name and ID.
6. Define the schedule, output, and notifications for the process set, as you'd do for any scheduled process. Set
any other options and click Submit.

The runtime and data diagnostics can be generated for any extract instance, whereas the design time diagnostics is
generated for user-defined extract definitions. After the process is complete and successful, review the log and the
process report to know about dependencies, warnings, and potential solutions.

Design Time Diagnostics

The Design Time Diagnostics for a user-defined extract definition provides the following information:

- How to reset the context user entity
- Tips on using threading database item usage for incremental and changes-only extracts

- Considerations for historic user entities in threading data groups
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- Delivery options and the associated BIP reports, if any

- Design practices that are commonly seen to impact extracts performance including the usage of advanced
conditions, override conditions, and record the sort order

These recommendations can help improve and optimize the Extracts design.

Note: You can also run the process for design time diagnostics from the Data Exchange work area> Extracts
Definitions page. Search for and select an extract definition and click the Validate button. In the Execution page, click
the Validate > Run Extended Validation. The action automatically triggers the process. You can download the results
and view the log details.

Runtime Diagnostics

The Runtime Diagnostics for a specific HCM extract provides the following information:

- Parameter values for the extracts run
- Volume of data processed by the extracts run
- Delivery status for the delivery options defined in the extract, including the BIP job IDs and job statuses

- Phase-wise timing of the extracts run includes the start and end time of each of these phases: Archive, XML
generation, BIP job process times, and Delivery. This provides an understanding of performance issue and
suggests resolution too.

- Tips to improve the process timings. You might want to consider them when updating or improving the extracts
design.

Data Diagnostics

The Data Diagnostics for a specific HCM extract data provides the following transformation and parsing information:

- Transformation details such as:
o Instance name and library used

o Extract Definition ID and name

o XML tag name of main block and database item (DBI)

o Number of processed and error records

o Status of the transformation, with start and completion time

- Problem descriptions such as:
o Invalid characters in the output

o Empty DBI tag name, without threading DBI
o Error details listing the Object Action ID number, its location, and tag name

Changes Only Extracts Diagnostics

The Changes Only modes in the diagnostics report are used to debug incremental extract changes to generate the
current status of the data, compare it with the baseline data from previous runs, and identify anything new and
modifications. The modes are:

- Previous Extract Run: It is used for basic Changes Only extracts with parameter cuances oNLY = ¥
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- Object Extracted But Not Expected: It is used for advanced Changes Only extracts with parameter
CHANGES_ONLY= ATTRIBUTE, ATTRIB_OLD, BLOCK_OLD, O BLOCK

- Object Not Extracted: It is used for data that was extracted in the past runs but isn't extracted in the current
run. You've to provide the threading object ID of the missing object from the earlier run to identify the changes.

- Record Not Extracted: It is used when the data record for the marked primary key isn't extracted in the current
run. To identify the changes, you've to provide the Threading Object ID, select the extract record name, and
enter the pipe delimited name value pair (for example: Extract All Phone Number=6623889833||Extract All
Phone ID=300100625351893||) as key attributes that weren't extracted from the earlier run.

- Unwanted Record Extracted: It is used when an unintended record and data elements are extracted to find
the intended changes in the record attributes. Based on the attribute changes, the report displays the record
status as changed, added, or deleted. To identify the changes in the record attributes, select the Object Action
attribute and provide the Object Action ID, select the record name and enter the name value pair (for example:
Extract All Phone Number=6623889833||Extract All Phone ID=300100625351893||) as key attributes to find
the threading data element and primary key, and do the comparison between the past and current run.

Related Topics
 Guidelines for Using Different Modes for HCM Extracts

« User Entities in HCM Extracts
« Submit Scheduled Processes and Process Sets

OTBI Reporting for HCM Extract Definitions

The following folders are available in the HCM Integrations Real Time subject area. Use these folders to create your
reports within OTBI and BI Publisher.

HCM Extracts

Folder Name Description

Extract Attributes Information related to HCM Extracts attributes, such as name, default, required status, and who
created and last updated.

Extract Data Groups Data group and record details.

Extract Definition Basic information related to an extract definition.

Extract Delivery Option Delivery options for an extract.

Extract Parameters Parameters for an extract.

Extract Runs Information related to the HCM Extracts that have been run, such as start date, total process time, and
status.

Fact - HCM Extracts Numeric facts about extracts, such as the number of extract definitions and the number of extract

runs.
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Folder Name Description
Process Configuration Group Information about the process configuration group.

FAQs for Working with HCM Extracts

How can | edit a delivered or a seeded extract?

For delivered or seeded extracts, you can't edit the extracts. Make a copy of the extract and change or add a parameter.

How can | enable email bursting?

Here's how you can enable email bursting for HCM Extracts.

1. Create HCM Extract including columns that define how the report will be burst into separate reports.
2. Include the email address where that the report should be sent to for each separate bursting value.

Note: In this example, PersonNumber and Email are used from PER_EXT_SEC_PERSON_UE.

3. Define a delivery option that points to the BIP report. Set the delivery type to E-Mail in the Delivery Option
Details.
4. Set the following additional details:

o Key: Set it to the bursting column in the report.
o E-Mail Address: Set it to the Email column in the report.
o From: Set to either a fixed value or an attribute from the report.
o Subiject: As required.
o Message Body: As required.
5. In BIP, make a copy of the /Shared Folders/Human Capital Management/Payroll/Data Models/

globalReportsDataModel.xdo.
Edit the bursting definition by doing the following:

1. Set the Split By and Delivery By to reference the column used to burst the report. In this example this is: /
DATA_DS/G_1/G_2/FILE_FRAGMENT/JRTestEmail/Person/PersonRec/PersonNumber.
2. Set the SQL Query to the following:

SELECT key key

, TEMPLATE , OUTPUT_FORMAT
,OUTPUT_NAME

,CALENDAR

,'true' SAVE OUTPUT
,DEL_CHANNEL

, PARAMETER1

, PARAMETER2
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, PARAMETER3

, PARAMETER4

, PARAMETERS5

, PARAMETERG6

, PARAMETER7

, PARAMETERS8

, PARAMETER9

, PARAMETE10

,LOCALE

, TIMEZONE

FROM FUSION.PAY REP DELIVERY DTLS

where payroll action_id=:payrollActionId
and ext delivery option_id=:deliveryOptionId

W

Split By and Deliver By fields are List Of Value (LOV) fields, and show predefined values appearing in the LOVs.

4. Click LOV and the text appears as "-- Enter --". After selecting, you can manually enter the required value in this
field.

How can | create a changes only extract?

When you create or import an extract, make sure you keep the Changes Only option selected. This option creates an
extract that captures the incremental changes only and not a full extract.

The Changes Only option automatically adds the Changes Only parameter to the extract. When you run the extract, you
can set the value of the parameter to capture changes. The extract generates the current status of the data, compares it
with the baseline data from previous runs and identifies anything new and any modifications.

Remember that you also need to set up threading database details to fully implement the changes only behavior.

What's the Simplified page in HCM Extracts?

The Simplified page is part of the extract process for defining, designing, delivering, and previewing the extract
definitions.

The Simplified page replaced the Professional page (Advanced Edit options) to create, edit, and maintain extracts. The
Simplified page extract components now help you create extract definitions that define what information you want the
application to extract and report on. It also explains how the application displays, formats, and delivers the information.

Related Topics
« Define Extracts

What's an extract data group connection?

Data group connections enable you to define the master-detail of parent-child relationship between the entities. For
example, the Employees and Departments data groups are linked with Department ID.
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Related Topics
- Extract Components

How can | delete an HCM Extract after it has run?

After an extract is created, you can't delete it. Hard delete isn't allowed as the extract-generated payroll flow and was
run. You can delete an extract only when there are no flow instances or the flow was never run.

Inactivate the extract so that by default the extract doesn't appear. The search page in manage extracts doesn't list
these extracts by default; only active extracts are listed. The payroll flows don't allow inactive extracts to be run, and it
would be preferred to not list the flow.

You can search for inactive extracts by using the show filters option in the search page and setting the status filter to
Inactive.

How can | default the effective date of a scheduled HCM Extract?

When you schedule an HCM Extract to set the effective date as SYSDATE, the Basis Value needs to be entered on the
Edit Task Details screen rather than on the Parameters screen.

There are two places to set parameter basis and basis value for effective date:

Data exchange > Refine HCM extracts > Payroll flow > Parameters tab.
Data exchange > Refine HCM extracts > Payroll flow >Tasks tab > Parameter Details.

To set the effective date as SYSDATE, follow these steps:

Log in to the application as an HCM Administrator.

Navigator > Data Exchange > Refine HCM Extracts.

Select the Payroll Flow.

On the Manage Payroll Flow Patterns page, go to the Tasks tab, highlight the appropriate task, and click Edit.
Click the pencil icon below the tabs (Tasks, Task Sequence, Parameters).

Click the Edit pencil icon next to the task that you want to edit.

On the Edit Task Details: Basic Information flow, locate the Effective Date parameter and click on that row. The
Effect Date: Parameter Details region will now show at the bottom of the screen.

8. Inthe Effect Date: Parameter Details region, set these parameter values:

NOoUuhAUWNRA

o Parameter Basis = Context Binding

o Basis Value = System Date

How can | create a custom schedule for an HCM Extract?

Currently by default only daily, weekly, monthly options are provided for recursive scheduling.
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If you want to create a custom schedule, you need to create a fast formula of type Flow Schedule and return when next
flow has to be run, for example after 5 days.

To create a fast formula:

Go to My Client Groups > Show More > Payroll > Fast Formulas.

Click the Create icon.

On the Create Fast Formulas window, in the Type field, select Flow Schedule.
Write a formula to return the number of days.

PAWANA

JhFkdkkkokkkkkokkkkkkkkkkkkkkkkkkkkkkkhkkkkkhkkkkkkkkkkkkkkkkkkkkkkk**k** FORMULA NAME: Daily Weekday

Schedule FORMULA TYPE: Flow Schedule DESCRIPTION: Formula to return a date time. Returns

NEXT SCHEDULED DATE; FORMULA RESULTS: NEXT SCHEDULED DATE This is a date time value with yyyy-MM-
dd HH:mm:ss format. ***kkkkkkkkkkkkhkhkkhkhdkhkhhkkhhhkkhhdkhhhkkhhhkkhkkhkhkkkhkkkkkkkkkkkkkk**x/ /% Inputs

*/ INPUTS ARE SCHEDULED DATE (DATE) /* Calculations */ add = 1 /* Get day number for Friday. */
A FRIDAY = TO_DATE('2012-01-06', 'YYYY-MM-DD') FRIDAY NUMBER = TO_CHAR(A_FRIDAY, 'D') day_number
= to_char (SCHEDULED DATE, 'D') if (day number = FRIDAY NUMBER) then add = 3 NEXT_ SCHEDULED DATE
=ADD_DAYS (SCHEDULED DATE, add) /* Returns */ RETURN NEXT_ SCHEDULED_ DATE /* End Formula Text */

How can | enable data chunking for high-volume extracts?

Run the following payroll extracts for larger data sets using the XML Data Chunking feature of Bl Publisher.

- Payroll Activity Report for the Latest Process
- Statutory Deduction Register for the Latest Process

- Payroll Register for the Latest Process

Note: You can split large volumes of report output into manageable chunks of XML files, to ease parallel processing
and later be merged into a single report. The XML data chunking capability in Bl Publisher reduces the time and
memory used for processing large data. You can't use this functionality for PDF and text output of the report.

Do the following to enable XML chunking:

1. Use a process configuration group to enable Bl Publisher to chunk the high-volume XML extract output.
2. Create a Payroll Process Configuration Group. You'll use this process configuration group for running your
Extracts and for processing the XML file.
3. Add the parameter Split and Process large XML output Process configuration to enable BIP to split
large XML output from Extracts into multiple chunks to allow for parallel processing and merge after
processing. Set the default value to Y and use this process configuration group to run the report.
The process configuration enables BIP to split large XML output from Extracts into multiple chunks, allowing for parallel
processing and merging after processing.

Note: Although the output for each chunk is merged into a single Excel workbook, the output for each chunk will

be in a separate worksheet in that workbook. Although the XML size at which Bl Publisher performance begins to
improve significantly by this feature can vary between customers due to extraneous factors beyond the control of the
report. It's recommended to turn this feature on for report XML sizes greater than 1 GB.
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Related Topics
- Efficient Processing of Large XML Files in Bl Publisher

» How can I chunk high-volume XML data?

Can | use a user entity as a root data group?

Search for the user entity in the User Entity Details UL. If it's a multiple row user entity that doesn't require any context,
you can use this user entity as the root data group.

You can access the User Entity Details Ul:

From the Data Exchange tasks pane.
- When creating a data group in the Design tab of the Extracts Definitions task.

Related Topics
- Best Practices for Viewing User Entity Details

« Why can't | find a newly delivered user entity?

How can | cancel an HCM Extract schedule?

From the Checklist Overview tab, search for the extract that was scheduled, select the extract that has been scheduled
in the actions menu, and choose the option to cancel it.

Go to My Clients Group > Payroll > Flow Submission and Results > View Flows.

Search for the extract.

Click on the Action link.

Select the option to cancel a flow and recurring schedule. After canceling, the user interface status will not
change to Canceled, but new extracts will not be triggered.

Note: The cancel action is available to the user who submitted the flow.

PUNa

If you need to cancel a process with another user other than the one submitting the flow:

1. Login as a user who has IT security manager role.
2. Navigate to Tools > Scheduled Processes.

3. Search for the scheduled job.

4. Inthe Actions menu, select Cancel Process.

What's the difference between the Always Display and the Mark as
Changed attributes?

You can see the difference between the Always Display and the Mark as Changed attributes when you have a parent
child relationship in the extract.
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If an attribute is set as Mark as Changed, and a change occurs on the same record, then the application includes this
attribute in the output. If no attributes change on the record, but an attribute changes in another record, for example a
parent or sibling record, then the application doesn't include the attribute in the output.

If an attribute is set as Always Display and a change occurs on the record or in the hierarchy below the record, then the
application includes this attribute in the output. The application includes the attribute even if there are no changes in
the attribute's record. If there is a change beneath the record, then it's included.

Related Topics
 Guidelines for Using Different Modes for HCM Extracts

How can | disable an extract?

You can disable an extract by using the Extract Definitions task in the Data Exchange work area. Search for the extract
that you want to disable. Open the extract and change the status of the extract to Inactive.

After disabling an extract, you can't submit the extract run again and records will be deleted when the purge process is
run. The previous data extracted by a disabled extract is purged to improve the efficiency of extract runs.

Why can't | find an extract?

Probably because it's a payroll or seeded localization extract which is Legislative Data Group (LDG) enabled and you're
looking in the Data Exchange work area. Search for your extract by LDG using the Show Filters option in the Extracts
Definitions Ul.

You need to use the Submit a Flow task in the Payroll or Data Exchange work area to submit these types of extracts.

Inactive extracts aren't available in the default search either. You can search for inactive extracts by using the show
filters option.

Why can't | find a newly delivered user entity?

Probably because the new user entity is delivered after applying the release patch. You need to update and download
the user entity information by manually running the user entity data dictionary process.

You can download the objectsData.txt and attributData.txt files that contain the list of user entities with their
database objects and items, respectively. Run the user entity data dictionary process to download these files.

To submit the user entity data dictionary process:

1. Click Navigator > Tools > Scheduled Processes.
2. On the Scheduled Processes Overview page, click Schedule New Process.
3. Leave the type as Job, select the Generate User Entity Data Dictionary process, and click OK.
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4. Inthe Process Details dialog box, select the report mode:
o Select No to update the new user entity information.

o Select Yes if you want to view the route, database item, and user entity details in a report.

5. Define the schedule, output, and notifications for the process set, as you would do for any scheduled process.
6. Set any other options and click Submit.

Related Topics
- Best Practices for Viewing User Entity Details

» Canluse a user entity as a root data group?
« User Entities in HCM Extracts

How can | keep an extract safe from unwanted edits?

Keep an extract locked to ensure no edits are made while the extract is in use. The lock feature can help you avoid
situations such as a Changes Only extract being edited while in use and resulting in a full run extract.

Find the Lock Definition option and the Unlock Comments field on the Define page. The extract definition must be
valid before you lock it and you must provide a reason before you can unlock it. Unlock the extract definition if it does
require a change by providing a justification or comments that you can refer in the future.

Why can't | submit an extract run?

You can't submit an extract run when:

- The status of the extract is inactive. An inactive extract indicates that it's disabled. To submit an extract run, the
status must be Active. Inactive extracts aren't available for submission in the Submit Extracts task.

- The extract is invalid. After creating an extract, if you validate it and there are some validation errors, the extract
is marked as invalid. If you try to submit an invalid extract, the process fails and errors are displayed. Resolve
the validation errors and validate the extract. Then submit the extract run again.

- If the extracts definition name is different from the associated flow name, you can't submit these extracts from
the Submit Extracts Ul in the Data Exchange work area.

Related Topics
« How Extracts are Validated

Why can't | find my inactive extracts?

You can't find the inactive extracts because by default, the search results display active extracts only. To view inactive
extracts, use the Extract Definitions task in the Data Exchange work area.

In the Extract Definitions page, select Show Filters, Inactive in the Status drop-down list and click Search.

42
ORACLE



Oracle Fusion Cloud HCM Chapter 1
HCM Extracts Working with HCM Extracts

If you want the search results to display both active and inactive extracts, select the blank option in the Status drop-
down list.

Do | have to validate existing extracts?

No. It's not required to validate existing extracts. Extracts that aren't validated are marked as Not Yet Validated. You can
submit extracts that aren't validated.

However, if there are issues with the extract design, then errors might occur or the result data might be incorrect. To
avoid any errors, ensure that you validate the extract before submitting.

How can | download log files for the extract run processes?

Use the View Extract Results task. Search for the extract and click the extract instance name link in the search results,
for which you want to view the extract result details. In the extract details page, the Instance Details tab lists the extract
run processes. You can download the process log files to troubleshoot the extract run.

You can review the log files to identify the records that did not retrieve the expected data and to identify time
consuming processes.

Related Topics
« Review Extract Run Details

Can | run a Changes Only extract with successful runs only?

Yes. Use the Include changes from last successful run option to exclude the extract runs that did not complete
successfully when you run a Changes Only extract.

Leave the option deselected if you want the application to include archives from both successful and unsuccessful runs
when running a Changes Only extract. Run the extract as Changes Only set to Yes for the first time to retrieve all the
records. When you run the same extract again with the same option Changes Only set to Yes, it would return only the
changed records.

How can | create and run a baseline extract?

Use the Baseline Only parameter in your extract to create a baseline that you can use for all subsequent changes only
extracts to compare against.

This parameter can save time when running the extract because it doesn't generate an XML file and it doesn't deliver
any output. You set the Display option to Yes or Mandatory for the Baseline Only parameter. It creates a full extract in
less time and uses less storage in your application.
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How can | improve the performance of the Extracts run?

There are several options you could try to optimize the performance during such phases.

Improve the performance of your extract runs by using the new Baseline Only parameter. Use this parameter in your
extract to create a baseline against which you can run all subsequent changes only extracts against. The baseline only
parameter saves time when you run the extract because it does not generate an XML file and it does not deliver any
output. It creates a full extract in less time and uses less storage in your application. Use this feature by selecting the
Show hidden parameters option, and setting the Display column to Yes or Mandatory for the Baseline Only parameter.
Use the Baseline Only parameter when submitting a baseline extract, and if the changes only parameter is set to
mandatory, then use the All Attributes option.

Free up storage space in your application and improve performance by using the Delete Archive parameter. Use this
parameter when you create a full extract of data, and not for changes only extract. When you run the extract the
application generates the XML and archive and delivers the output to the destination. After the application delivers the
output, for example the WebCenter Content, you have the option to discard the archive data and XML files, therefore
reducing storage consumption by deleting these extract archives. Use this feature by selecting the Show hidden
parameters option, and setting the Display column to Yes or Mandatory for the Delete Archive parameter.

Contact the help desk to manually gather the database table statistics for your pod. You might experience slow HCM
Extract operations during certain testing phases of your implementation cycle, especially when the application tests
bulk data loads at the same time. During regular operations the collection of statistics is scheduled to run weekly.
However, if the data volume is high due to bulk data loads, then you should request this process to run manually.

How can | increase the extract output threshold?

When using any delivery type such as None, FTP, Email, the output generated will be stored in UCM only if the
generated output file size is less than 10 MB.

However, complete output will be sent to the FTP server or email based on the delivery type selected. Use the
appropriate delivery type such as, FTP for storing the complete output file that can be used for further processing.

Do the following:

Select Setup and Maintenance.

Click the Tasks icon on the right-hand side of the screen.

Click Search, and search for Manage Common Lookups. Search for paY_ACTION PARAMETER TYPE

In Pay_acTion_parameTER_TYPE: LOOkup Codes search for B1_ouTpur_sizE.

Add a lookup code to the B1_outpur sizk to the lookup type pAY ACTION PARAMETER TYPE.

Go to My Client Groups > Payroll > Payroll Process Configuration.

Add parameter name: Maximum Bl Output Size for Direct HCM Upload and set Default value as 999999999999.

In the Manage Payroll Process Configuration task in Setup and Maintenance, add the above parameter to the
Default Group. The value is the count of bytes. So entering a 999999999999999 should allow a very large file.

OO U A WNRA
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How can Extracts definitions be downloaded?

You can download or export an extract definition by navigating to the search page of the Extracts Definitions from the
Data Exchange work area.

The downloaded or exported definition will be an XML file that includes the information on the data groups, records and
data elements, delivery options defined.

To retrieve the extract definition:

Go to Navigator > My Client Groups > Data Exchange.

In the Data Exchange work area, click Extract Definitions.
On the Extract Definitions page, search for the Extract.

In the Search Results section, click Actions > Export Extract.
Save the file.

UuhWNRA

How can | access Extract results?

To access HCM Extract results, you will need the required roles and privileges to access the associated payroll flows.

You create payroll flow security profiles and attach the generated data roles to your user account to access the Extracts
results.

1. Login as an application implementation consultant user.

2. Go to Setup and Maintenance > Manage Data Roles and Security Profiles.

3. Create a new data role or edit an existing data role that is created on either a Payroll Administrator or a Payroll
Interface Coordinator job role.

4. Edit the data role and choose the View All Flows for the Flows Pattern Security Profile or a specific profile that

you create to access specific flows.

Submit the changes.

6. If you created a new data role in step 3 above, assign this data role to the user account to view the extract
results.

w

Why do | get a full extract upon running a Changes Only extract?

There are several reasons why a Changes Only extract runs in a full mode or extracts all data.

Do the following:

Rollback all the incomplete runs caused due to the forceful cancellation of an extract run. Now, run your
Changes Only extract again.

- Select Changes Only since last Successful Run in the Extracts Definitions page of the extract and try again.
- Verify if the configured threading database item uniquely identifies the extracted data.

- Avoid including parameters as record elements in your extracts definition. For example, the effective date
parameter is unique for each run and if you include it in your definition as a record element, it can result in full
extract even when you run a Changes Only extract.
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Why can't | see some of my extracts in the drop-down list when
submitting extract runs?

From the Submits Extracts page in the Data Exchange work area, you can submit extracts that have the Extracts
definition name matching the flow name associated with it.

If Extracts have custom flows created with a name that does not match the Extracts definition name, these can only be
submitted from the Submit Flows page.
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2 Working with Enhanced HCM Extracts

Overview of Enhanced HCM Extracts

Enhanced HCM Extracts use a redesigned extracts engine that improves how extract data is processed, generated,
and delivered. This engine provides a more scalable and efficient framework compared to the earlier extracts engine,
especially for organizations that process large volumes of data or use complex extract definitions.

Enhanced extracts aren’t enabled by default. You must explicitly enable the feature and upgrade existing extract
definitions before you can use the new engine. After upgrading, the extract runs entirely on the enhanced processing
framework, which introduces changes in performance behavior, delivery handling, and supported design patterns.

The enhanced extracts framework also standardizes processing across supported extract types. This consistency
reduces variation in extract behavior and simplifies long-term maintenance. It improves processing performance by
enabling multi-threaded preprocessing. This allows the system to process large datasets more efficiently and reduces
execution time for extracts that use complex selection criteria.

They also support scalable output processing. Large extract outputs can be split into smaller chunks, which improves
delivery reliability and prevents failures caused by file size limitations.

In addition, the enhanced extracts engine standardizes processing behavior across supported extract types. This
ensures consistent execution and reduces differences in how extracts behave across implementations.

Enhanced extracts provide improved delivery capabilities, including better integration with Bl Publisher and
downstream systems such as FTP servers and data loading interfaces.

Supported Extract Types
Benefits Carrier extracts
HR Archive extracts
- Other Payroll Archive extracts
Payroll Interface extracts
Full Profile extracts
Recruitment Archive extracts

Before upgrading individual extracts, you must enable enhanced extracts for the required extract type using extract
configuration groups.

Enable and Upgrade Extracts to Use Enhanced Extracts

To use enhanced extracts, you must first enable the feature for the required extract type and then upgrade individual
extract definitions. The upgrade process creates a new extract definition that runs on the enahnced extracts engine.

47
ORACLE



Oracle Fusion Cloud HCM Chapter 2
HCM Extracts Working with Enhanced HCM Extracts

Enable Enhanced Extracts for an Extract Type

Before you can upgrade an extract, you must enable enhanced extracts for the corresponding extract type.

1. Navigate to My Client Groups > Data Exchange > Extract Configuration Groups

2. Select the System Defaults extract configuration group, set the override value for the desired extract types to
2.0 (HEX_V2), and then save and close the configuration group.

Creating New Extract Definitions Based on Enhanced Extract Types

1. Navigate to My Client Groups > Data Exchange > Extract Definitions
2. Select + > Create New

3. Select an upgraded extract type on the Create Extract Definition page, and provide values for Name,
Consumer, and select OK.

4. On the Define page, verify that Version is Enhanced and proceed with creating the extract.

Upgrade Existing Extract Definitions To Enhanced Version

1. On the Extract Definitions page, select the extract definition and choose Upgrade Extract from the Actions
menu.

2. Provide an Extract Name in the Upgrade Extract dialog box and select OK to validate the extract.
3. Validation results of the migration process:
o Successful: If the enhanced version migration was successful, you'll see a confirmation message

o Select Continue to proceed with the upgrade.
o On successful upgrade, select OK in the confirmation box.

o Select the upgraded extract on the Extract Definitions page to verify that the version is updated to
Enhanced.

o Validate the extract and submit it.

o In Error: If the validation failed due to issues during migration, you'll be able to download log file to

troubleshoot the problem. You can either fix the existing extract definition or create a temporary version
to analyze.

o Correct any validation errors and revalidate the extract.

o After successful validation, select the extract definition and verify that the Version field displays
Enhanced,

o Enable all the required delivery options and submit the extract.

Note: All the delivery options are disabled by default on migration.

o A custom flow is created for the newly migrated extract. Any manual modifications made to the source
flow must be manually replicated in the newly created custom flow.
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Enhanced Extract Processing and Performance Features

Enhanced extracts provide several runtime and output-processing features that improve extract execution, scalability,
and validation.

These features help optimize preprocessing performance, support large extract outputs, and simplify report validation
before delivery.

The enhanced extracts engine supports preprocessing multithreading, output file chunking, and previewing extract
output using a sample Bl Publisher run.

Seeded Extract Configuration Groups

Enhanced extracts provide the following seeded extract configuration groups that can be copied and customized to
support performance tuning and runtime feature configuration:

Extract Default V2

High Performance V2

Extreme Performance V2

Use these configuration groups as the base configuration when enabling enhanced extract runtime features such as
preprocessing multithreading and output file chunking

Preprocessing Multithreading
Purpose:

During preprocessing, the enhanced extracts engine identifies the business objects that must be included in the extract
and stores them for downstream processing. For extracts that process large volumes of data or use complex selection
criteria, preprocessing can become a performance bottleneck if the operation runs in a single thread.

Preprocessing multithreading improves performance by distributing preprocessing operations across multiple threads.
This reduces overall execution time and improves scalability for large extract runs.

Feature Processing:

When multithreading is disabled, preprocessing runs sequentially in a single thread. In extracts that contain complex
criteria or large object sets, this can significantly increase processing time.

When multithreading is enabled, preprocessing tasks are distributed across multiple threads so that multiple object sets
can be processed concurrently. This improves throughput and reduces delays during extract initialization.

Preprocessing multithreading supports only the following object types:

Person ID
« Assignment ID
Payroll Relationship ID

Period of Service ID
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- Payroll Assignment ID

Note: Extract definitions that don’t support multithreaded processing must be updated before this feature can be
used.

Parameters:
Use the following parameters to configure preprocessing multithreading:

- ORA_HEX MULT THRD PRE_PROC - Enables or disables preprocessing multithreading. Valid values are Enabled and
Disabled. Default value is pisabled.

- ORA_HEX PRE_PROC_THREAD COUNT - Specifies the number of preprocessing threads to use when multithreading is
enabled. Valid range is 2 to 32. Default value is 8.

Adding Parameters to New Extract Configuration Group to include Multithreading:

1. Navigate to My Client Groups > Data Exchange > Extract Configuration Groups

2. Create a copy of Extreme Performance V2 configuration group

3. Onthe new configuration group page,
a. Set the Preprocess Multithreading parameter as Enabled
b. Set the Preprocess Multithread Count parameter to an appropriate value with the range
c. Click Save

Chunking of Output Files

Purpose:

Large extract output files can create delivery and processing issues, particularly when files exceed downstream system
limitations or transfer thresholds.

Output file chunking improves scalability by splitting a large extract output into multiple smaller files. This simplifies
delivery and improves reliability for large extract runs.

Feature Processing:
When chunking is enabled, the enhanced extracts engine divides the extract output into multiple files based on a
configured chunk size.

The engine automatically creates sequential output chunks during extract generation, which can then be delivered
independently to downstream systems.

Output file chunking isn’t supported for the following scenarios:

- Documents of Record (DOR)
- Bursting operations

Parameters:
Use the following parameters to configure preprocessing multithreading:

- ORA_HEX_ OUTPUT_CHUNKING - Specifies whether output file chunking is enabled. Valid values are ¥ and n. Default
value is v.

- ORA_HEX OUTPUT_CHUNK_ SIZzE - Specifies the number of records included in each output chunk. Default value is
50000.
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Adding Parameters to New Extract Configuration Group to include Auto-chunking:

1. Navigate to My Client Groups > Data Exchange > Extract Configuration Groups
2. Create a copy of Extreme Performance V2 configuration group
3. Onthe new configuration group page,

a. Set the Chunk Output parameter as Yes

b. Set the Output Chunk Size parameter tas 5000

c. Click Save

Previewing Extract Output Using Sample Bl Publisher Run

Purpose:

The sample BI Publisher run feature allows you to preview extract output before submitting the extract for delivery. This
feature helps validate report templates, delivery options, and output formatting during extract development and testing.
The preview capability is available for custom extracts.

Generating Preview Output:

1. In the Extract Definitions page, select the extract and click Preview on the left pane

2. Enter an effective date for the preview run and click Preview to generate a preview version of the extract output
using the selected extract definition and report configuration

Select Delivery Options: After generating preview data, select the delivery option to preview.
The preview run supports the same Bl Publisher delivery configurations used during extract processing. This allows you
to validate the

Report templates
« Output formatting

Delivery-specific rendering

before running the extract in production.
View the Report Output:

1. Click Show Report
2. The system displays a preview of the final Bl Publisher output generated from the extract data and associated
report template.
3. Use the preview output to validate the following aspects before submitting the extract for production
processing:
o Data formatting
o Report layout
o Template configuration

o Delivery behavior
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Configure Bl Publisher Data Models and Reports for
Enhanced Extracts

Enhanced extracts use a revised Bl Publisher integration model that supports the enhanced extracts engine.

To generate report output for enhanced extracts, you need to update the Bl Publisher data models so they reference
the new enhanced extract output tables. You must also configure Bl Publisher reports and associate them with extract
delivery options.

Supported Data Models

Enhanced extracts support the following Bl Publisher data models.

GlobalExtractsDataModel

- Use this data model for extract definitions that run only on the enhanced extracts engine.

- Bl Publisher location: /shared Folders/Human Capital Management/Extracts/Data Models/
GlobalExtractsDataModel

UnifiedExtractsDataModel

- Use this data model for environments that support both earlier extracts and enhanced extracts.

- Bl Publisher location:/shared Folders/Human Capital Management/Extracts/Data Models/
UnifiedExtractsDataModel

Enhanced Extract Output Tables

Enhanced extracts store output data in new database tables used by Bl Publisher reports. You need to configure BI
Publisher data models to reference these tables when generating report output for enhanced extracts.

Table Name Description

HEX_RUN_SEED_OUTPUT Stores XML output for seeded extracts for both full and changes-only runs when the retention period
exceeds 90 days.

HEX_RUN_CUST_OUTPUT Stores XML output for custom extracts and seeded full extract runs with retention periods less than or
equal to 90 days.

HEX_RUN_CHG_OUTPUT Stores XML output for changes-only extract runs.
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Create a Bl Publisher Report

1. Create a Bl Publisher report using the GlobalExtractsDataModel or UnifiedExtractsDataModel data model.
2. Save the report definition.

The report can then be associated with extract delivery options.
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Configure Extract Delivery Options

After creating the Bl Publisher report, configure extract delivery options.

Open the extract definition.
Navigate to Extract Delivery Options
Add a delivery option.
Specify the following values:
o Report path

P WN

o Template name
o Output format

5. Save the delivery configuration.

Validate Report Output
Submit the extract definition and verify the generated report output from the View Extract Results page.
Validate the following before using the extract:
« XML output
Bl Publisher formatting
- bursting behavior
- delivery processing

Report rendering
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5 Filtering and Delivering HCM Extracts

Guidelines for Using Different Modes for HCM Extracts

You can create an extract in different modes using the Extract Definitions page. These modes allow you to control the
extraction of all data or only the data that has changed since the previous extract run.

For example, whenever there's a change in the employee's location, the current status of the data is compared with the
previously base lined version. The changes-only extract identifies and outputs only the records and attributes that have
been newly added or modified. Whenever an Extract Definition is changed, this will require a new baseline to be created,
and hence the entire data would be extracted.

You can fine-tune this comparison in a changes-only extract to either exclude or include certain attributes, regardless
of whether the attribute has changed or not using the exclude from comparison option. By selecting this option, the
attribute won't be compared while identifying changes to include in the generated output of the next extract runs.

As a result, even if the attribute value has changed since the previous run, it will not be included in the next extract
output. You can also select an option to always include an attribute in the generated output of an extract run, even if the
attribute hasn't changed.

Extract Modes

To enable different modes in an extract, you include the CHANGES_ONLY parameter and set up threading details in

the extract definition. While running the extract you can use the CHANGES_ONLY parameter to control the extract
mode. For example, to find out if the job name has changed on a person's assignment, set up multithreading database
items at assignment level and include the CHANGES_ONLY parameter. When you run the extract in the ATTRIBUTE
mode, the extract compares data from the multithreading level and outputs the incremental changes. You can link the
PER_EXT_CHANGES_ONLY lookup or the ORA_HRY_CHANGES_ONLY lookup to the CHANGES_ONLY parameter so that
you can select a mode when you submit the extract.

The following table describes the different extract modes, their lookup values and descriptions.

Mode Lookup Value Description

N All attributes Includes all data in the extract. A full extract is
run which produces the full data output at that
point of time. The archived data is used as a
baseline.

Note: The Changes Only extracts that ran
only in full extract mode but never ran in
Changes Only modes will be automatically
converted to full extracts after applying the
release patch.

Y Changed attributes Compares this extract run with the previous
extract runs and by comparing against the
baseline (to identify the incremental data),

displays the data that has changed only.
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Mode

ATTRIBUTE

ATTRIB_OLD

BLOCK_OLD

BLOCK

Related Topics

Lookup Value

Changed and marked attributes

Changed and marked attributes with previous
values

Changed, marked attributes, previous data
under threading group

Changed and marked attributes under
threading group

« Extracts Process Diagnostics Report
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Description

Includes elements that have changed or marked

as required

Displays elements that have changed or marked

as required plus their previous value
Displays the following data under threading
data group:

Changed data

Data marked as required

Previous values

Parent data group values

Displays the following data under threading
data group:

Changed data

Data marked as required

Parent data group values

Filter Extracts Using Advanced Filter Criteria

Use advanced filter criteria to filter and extract data using complex SQL queries. You can also filter data using
expressions or fast formulas. When using expressions, the available operators might not be enough to build complex

expressions.

You can use fast formulas to build complex filter criteria. However, using advanced filter criteria can improve the
performance of the extract run. To use advanced filter criteria, you must have good understanding of the table aliases

and writing SQL constructs.

Extracting Employees on Leave

This example explains how to use advanced filter criteria to extract employees who are going on leave in the next seven
days. Managers can use this information to find the list of employees who have approved leaves starting in the next

seven days.

1. On the Extract Definitions page, create an extract definition.
2. Open the extract definition you created and select the Design tab.
3. Select the Data Group link from the hierarchy, click the Add icon and select Data Group.

ORACLE
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4.

R N

10.

1n

12.
13.
14.

In the Data Group section, search the user entity PER_EXT_SEC_PERSON_UE and click Advanced to display the
User Entity Details window.

In the Query tab, review the user entity tables and aliases that you want to use, and click OK.
In the Data Group section, now select the Filters tab to display the Filter Criteria section.
Click the Add icon.

Click the Edit icon in the Filter Criteria column.

In the Edit Filter Criteria Condition window, create the following expression for retrieving only employees:
Extract Person System Person Type = 'EMP"

Click Advanced. The application converts the expression in the basic mode to the following SQL construct:
(pptum.system_person_type="EMP")

You can now append new SQL construct by using the EXISTS clause. Entering the following SQL construct will
extract employees who are going on approved leave in the next seven days:

((pptum.system person_type='EMP') and EXISTS

(
select 1 from fusion.ANC_PER ABS_ENTRIES abs

where

abs.person_id = pptum.person_id and abs.start datetime between

pay_report utils.get_parameter value date ('EFFECTIVE_DATE') and
(pay_report utils.get parameter value date ('EFFECTIVE DATE')+7)

and abs.approval_status_cd = 'APPROVED'

)

)

When writing an SQL query to retrieve any parameter value at runtime, use the
'pay_report_utils.get_parameter_value_date('ESS PARAMETER')' function. The ESS Parameter is typically,
unless explicitly changed, the capitalized parameter name where any space is replaced by an underscore. For
example, the ESS Parameter of Effective Date is EFFECTIVE_DATE.

Note: When you delete the existing filter criteria and create a new one, more than 4000 characters can be
accommodated in a SQL query constructed from the filter criteria.

To validate the SQL construct for any syntactical errors, click Validate.
Click OK.

To verify if the advanced SQL criteria is applied correctly, run the extract in GMZFT logging mode and check the
logs.

Related Topics

« How many characters can the SQL query for the data group filter criteria have?

HCM Extract Formula Types

You can launch the Fast Formulas Ul from the Navigator Menu Payroll Calculation work area Clicking on the task Fast
Formulas.

The following table lists the different types of formula you can use for extracts:
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Formula Type

Extract Criteria

Extract Rule

Extract Advanced Condition

Extract Record
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Description

Formulas of this type are listed in the Data Group Criteria Fast Formula list. Use this type to specify
complex criteria and to indicate if record should be extracted or not.

Formulas of this type are listed in the Rule Type Attributes Fast Formulas list. Use this type to calculate
and derive the attribute value if based on complex logic or business rules.

Formulas of this type are listed in the Record Attribute Fast Formulas list. Use this type to specify
complex conditions to indicate if an action should be raised (for example, a log or warning).

Formulas of this type are generated automatically when using the Generate Formula option in Extract
Records.

Guidelines for Delivering Extracts

You specify delivery options as part of the extract definition. Delivery option parameters specify the output format, the
delivery method (email, FTP), support the file encryption of files held on the Oracle WebCenter Content server (UCM) for
processing by HCM Data Loader (HDL) and HCM Spreadsheet Data Loader (HSDL), and other parameters required for
integration with the Bl Publisher layer.

How Delivery Options Work

HCM Extracts archives the extracted data into result tables and stores it as an XML output in the database. The
application transforms the XML output into a formatted output such as HTML, PDF, EDT, or XLS. The formatted output
is then delivered through the delivery options you set in the extract definition.

You can convert the raw XML generated by HCM Extracts to a specific format using the Bl Publisher templates. The
following table defines the key properties that you can use when defining a delivery option.

Property

Delivery Option Name

Delivery Type

Output Type

ORACLE

Description

Specifies the name to identify your delivery option.

Specifies the delivery type. The available options are Email, FTP, WebCenter Content, Data Loader
Interface, Inbound Interface, and None.

Note:
None can't process large output files. Use this option for test purposes only.

Specifies the format of the output file.

- Data - It is the default HCM Extracts format and this option provides an XML Output file.
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Property Description

CSV - HCM Extracts supports this option without any other need for Bl Publisher templates.

Any other format from the list of available choices requires a Bl Publisher template for formatting
and processing in the Bl Publisher layer.

Report Specifies the Bl Publisher report that you define for transforming the XML output generated by
Extracts to the format of your choice. This is applicable only for output types other than Data or CSV.

Provide the complete Bl folder path for the report. Ensure that this path matches with the directory
structure of the report in the Bl Publisher setup.

If your output type is Data or CSV, you can leave this property blank.

Template Name Specifies the template associated with the Bl Publisher report. It is required only when you provide a
value for the Report property.

Bursting Mode You can specify the bursting mode when you want the XML output to be split and delivered as separate
files. For example, payslips to the individual employees.

Note: When you select the output type as CSV, there's no need for other Bl Publisher templates and the files are
delivered to either WebCenter Content or to SFTP destination based on your configuration. Any other delivery type
such as Email, requires a Bl Publisher template.

Use the Required option on the Deliver tab to specify which delivery options must complete successfully for the extract
run to be considered successful. For example, select Required for critical delivery options, such as payroll bursting.

If a Required delivery option fails, the entire extract run will also fail because it depends on that delivery completing
successfully.

For non-critical delivery options, such as an email notification to yourself, you can leave Required deselected. In that
case, even if the delivery option fails, the extract run will still complete successfully because it doesn't depend on that
delivery.

Use the Enabled option on the Deliver tab to enable or disable delivery options for seeded and non-seeded extracts. By
default all the delivery options are enabled for an extract definition.

Using Delivery Types
The type of delivery you select decides the destination of the extract. Some delivery types require more information.

You can select Documents of Record as the delivery mode to store the output in the database and allow employees to
view the output from Document of Records. An example of a document is a payslip. If the XML output is split and burst
as separate files, then you can select the bursting node. For example, if you want all employees to receive an email with
their payslips, then set the bursting node to Employee_ID.

Select the WebCenter Content delivery type to create extracts with data and send them to Oracle WebCenter Content.
When executing the extract, encrypted files uses the public fusion-key to post them to the UCM. You need to generate
the Pretty Good Privacy (PGP) key pair on the Security Console. You can download the public key to encrypt files that are
inbound into HCM Cloud (for example, data files for HCM Data Loader). To sign these inbound files, you can use your
private key, which is verified using your public key in Oracle HCM Cloud. You must have imported the customer public
key.
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You can also transfer the data manually or use your scripts to your server. For more information, see Oracle Fusion File
Transfer Automation and Data Security on My Oracle Support.

For each of the delivery types, you can set up more details to complete the configuration. The following table provides
information on the more details required for configuring delivery type.

Delivery Type and Attribute Description

Delivery Type: FTP Specifies the name of the FTP configuration from the File Transfer Configuration page in the Data
Exchange work area.

Attribute: Configuration Name
Configuration Name is blank if you've defined the FTP configuration in Bl Administration.

Delivery Type: FTP Specifies the name of the server in case you've defined the FTP configuration in Bl Administration.

Attribute: Server Name

Delivery Type: FTP Specifies the location of the remote directory to transfer a file to, for FTP configuration in BI.

Attribute: Remote Directory

Delivery Type: Specifies whether the file generated is to be encrypted or not.
- WebCenter Content

- Data Loader Interface

« Inbound Interface

Attribute: Encryption Mode

Delivery Type: WebCenter Content Specifies the key to be used for encryption if you choose to encrypt.

Attribute: Encryption Key

Delivery Type: Specifies whether to compress the generated file. You can also specify the order of compression and
- WebCenter Content encryption.

- Data Loader Interface

- Inbound Interface

Attribute: Compress

Delivery Type: Specifies the name that forms the content ID in WebCenter Content (UCM Content ID). The first 11
. WebCenter Content characters of the Integration Name suffixed by the process ID of the extract run form the UCM Content
ID <first-11-characters-of-the-integration-name><process id>
- Data Loader Interface

. Inbound Interface Integration Name can contain only alphabets and numbers.

Attribute: Integration Name

Delivery Type: Email Specifies the email address of the sender from which you want to email the generated output to the
recipient.
Attribute: From Email

60
ORACLE



Oracle Fusion Cloud HCM Chapter 3

HCM Extracts Filtering and Delivering HCM Extracts
Delivery Type and Attribute Description
Delivery Type: Email Specifies the email address of the recipient to which you want to deliver the generated file.

Attribute: Email Address

Delivery Type: Email Specifies the free text that's added to the email as the body.

Attribute: Email Body

Delivery Type: Email Specifies other email-specific configurations.

Attribute: CC / BCC / Reply-To

Define Output File Name

When you create a delivery option for the extract, you can define the output file name by selecting an extract attribute
and a date. The application adds this information as dynamic output to the Output Name and translates it internally into
code.

The output name consists of the following components:
- Delivery option name (appears by default)
- Extract attribute
- Date

You can add one data element (sqae) to form a part of the file name and also add the date of file generation in different
formats to the file name. The table lists the date components:

Date Component Description

sy | sm | %d Year | Month | Date component of the system date

$H | $M | %S Hour | Minute | Second component of the system time

%edy | %edm | %edd Year | Month | Date components of the time in the Effective Date parameter that you provide during

the Extract Run

$edH | %edM | %edS Hour | Minute | Second components of the time in the Effective Date parameter that you provide
during the Extract Run

Follow the steps to configure the output file, where the formation of the file name with the date and time components is
shown in the Output Name attribute:

1. Create a new FTP delivery option.

2. Enter the report and template name in the Basic Information section and change the output type if necessary.

3. Enter the configuration details for delivery type in the Advanced section.

4. Inthe Output File Name section, select the appropriate attribute and click Add to append data element (sde) to
Output Name and associate the runtime file name with the selected attribute.
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5. If required to add the date components in the output file name, select the required date format.
6. Click Add and save the delivery option.

Report Category

You can group delivery options as Report Categories and have extract runs to deliver using specific categories. For
example, you can have an Extract with Report Category 1 (FTP and Email) and Report Category 2 (WebCenter Content).
When you choose Report Category 1, the output is delivered through FTP and Email.

Use the Report Category option in the Extracts Definition page to create the categories. This option appears only in the
Advanced Edit Mode of the Extracts Definition page.

Note: It isn't recommended to use multiple Report Categories.

Related Topics
 Set up Encryption for File Transfer

- Best Practices for Delivering Encrypted Data Using HCM Extracts

Define the Bl Publisher Template in HCM Extracts

Bl Publisher is a set of tools you use to create highly-formatted reports based on data models. With Bl Publisher, you
can:

- Author, manage, and deliver documents

- Create interactive management reports

- Create highly-formatted, customer-facing documents
- Create government documents

- Create electronic funds transfer (EFT) documents

Bl Publisher transforms the extracted data from the database and presents that data in a format of your choice.

This example shows you how to set up a Bl Publisher template and create a document in the required format, using the
extracted data. You can find Bl Publisher using the Reports and Analytics link from the navigator. When the Reports and
Analytics page is accessible, you can browse through the catalog using the Browse Catalog option.

FAST bank must send an XML file on their employees and departments to a third party and the HR Manager with
employee details grouped by departments as a Headcount Report.

The following table summarizes some key decisions:

Decisions to Consider In this Example

Why do I've to set up Bl Publisher? You set up Bl Publisher to format the extracted XML data into the required format and to deliver the
report or business document to the appropriate destination.

How does BI Publisher connect to HCM You install the Template Builder for Word plug-in.
extracts?
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Decisions to Consider In this Example
Do | need a separate license? No, Bl Publisher is included with Core HR.
Tasks
1. Creating the Bl Publisher Report Template
2. Setting up the Data Model
3. Uploading the Report

Create the Bl Publisher Report Template

1.

2.
3.

v oA

6.

On the Extract Definitions page in the Data Exchange work area, navigate to Extract Execution Tree using the
Validate button.

Export the XSD file for your extract using the Export XML Schema option.

Install the Template Builder for Word plug-in from the Bl Publisher Enterprise Home page.

This plug-in provides sample documents, demos, templates and Template Viewer. Use these samples to help
you understand the concepts and to create templates such as EFT and RTF to view the formatted XML output.
Open MS Word and find the Add-ins tabbed region to view the Oracle Bl Publisher option.

Select the Load XML Schema option and load the exported XSD file. You can create a default RTF template
using the All Fields option.

After the XML schema has been loaded, you can arrange the fields and alter the layout, if required.

Save the template.

Set up the Data Model

VA WNA

o

Click Navigator > Tools > Reports and Analytics.

On the Reports and Analytics page, click Browse Catalog.

On the BI Publisher Home page, click Create > Report to select a data model for the report.
Select Use Data Model to create a report using the existing data model.

Search and browse for the data model from the directory and click Next.

Note: Use the existing standard globalReportsDataModel data model (available at: /Shared Folders/
Human Capital Management/Extracts/Data Models/GlobalExtractsDataModel) for all your reports,
unless you've a requirement to burst the output. For example, create a new data model for Documents of
Record.

Select the Report Editor option and click Finish to complete the data model setup.
Provide a name and save the report in the following folder: /Shared Folders/Custom/Human Capital
Management/

Upload the Report

1.

Select the Upload option from the Upload or Generate Layout region and enter the following information:

Parameters Details

Layout Name RTF Layout
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Parameters Details

Template File Select the file name of the RTF template saved on your local drive.

RTF Template

Locale English (United States)

2. Save the Bl report in the following location: /Shared Folders/Custom/Human Capital Management/.

This Bl Publisher report template is now ready for you to select in the Delivery Options section when creating
the extract definition.

Verify the permissions for the report (Shared Folders > Human Capital Management > Payroll > Data Models
> globalReportsDataModel > More > Permissions) and ensure the report is accessible for the user account
(Enterprise Scheduler Job Application Identity for HCM or fusion_apps_hcm_ess_appid) that runs the Extracts
process. You can either add full control access to this user or to the Bl Consumer Role.

Note: Before including this report in the HCM Extracts definition, test the report to verify the formatting and
delivery configuration functions as designed. You can run the report from Bl and provide your Extracts run
instance name as input parameter to generate the output for verification of the layout and format defined in
your Bl report.

Bursting as Documents of Record

You can burst the output of HCM Extracts as a document of record (DoR) for specific person records.

1.

Create a custom data model by creating a copy of globalReportsDataModel from /Shared Folders/Human
Capital Management/Payroll/Data Models.

Save the copied data model in the custom folder /Shared Folders/Custom/Human Capital Management.
In Bursting properties, edit the copied data model and update the values for the following attributes:

o Split By - Contains the X-path of a data element, which has a unique value and has the following

pattern: /DATA_DS/G_1/G_2/FILE_FRAGMENT/<ExtractTagName>/<DataGroupTagName>/
<RecordTagName>/<RecordTagName>

Deliver By - Same as Split By
Bursting query - Use the following query:

SELECT key, TEMPLATE, OUTPUT FORMAT,
OUTPUT_NAME, CALENDAR, 'true' SAVE_OUTPUT,
DEL_CHANNEL ,
PARAMETER1 , PARAMETER2 , PARAMETER3 , PARAMETER4
PARAMETERS5, PARAMETER6 ,PARAMETER7 ,PARAMETERS ,
PARAMETERY9 ,PARAMETE10 ,
LOCALE, TIMEZONE

FROM FUSION.PAY REP DELIVERY DTLS

where payroll action_id=:payrollActionId
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and ext delivery option_id=:deliveryOptionId

Note: Take extra care when editing the above Split By and Deliver By values, as you can't correct the
typed content using backspace. There's also no option to see the typed content while typing, neither is
there an option to the paste content. If you misspell, you'll need to clear and start over.

Use the above data model to complete your Bl Publisher template and report creation.

If you want the XML output to be split and delivered as separate files, in the delivery options that you define
in the Extracts Definitions page for your Extracts, define the Bursting node to match with the Split By value
defined above.

6. Define the following other details for the Documents of Record delivery type:

v s

Property Value

Key Attribute: PersonID

Document Name <Any name>

Locale en-US

Person Id Same path as Split By or Bursting query
System Document Type <Document Type Code> used by DoR

To disable the bursting feature in the BIP report and deliver a merge output:
o Select None as the delivery type on the Deliver page when creating a delivery option for the HCM extract.

o Select Disable in the Bursting field to disable the bursting options associated with the BIP template.

Related Topics
 Guidelines for Delivering Extracts

« Define Extracts

Compress Output in HCM Extracts

You can use the compress feature to reduce the size of your output and encrypt your extracts more efficiently.
Compressing the extract speeds up large file transfers, uploads, downloads, and uses less disk space.

With the WebCenter Content delivery option, select a compression option that works for you:

- Yes Compress First. This is the most efficient way to ensure the extract runs quicker. The compression results
in a smaller file, which reduces the overall time it takes to transmit the file to its destination. With this option,
the application compresses the file first and then encrypts it.

- Yes Encrypt First. Select this option for the application to encrypt the file first and then compress it.
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No. This option doesn't compress or encrypt the file.

Best Practices for Delivering Encrypted Data Using HCM
Extracts

You can deliver encrypted files using HCM Extracts to Oracle WebCenter Content. You use the WebCenter Content
delivery type in the Deliver page of the Extract Definitions task to create an encrypted extract. HCM Extract transfers the
encrypted file to Oracle WebCenter Content.

You can then transfer the files manually, or write scripts to perform the transfer. By selecting the WebCenter Content
delivery type you can enter more details to ensure the extract is identifiable in Oracle WebCenter Content. For example,
specify the integration name, select whether you want to encrypt the file using the encryption mode, and a file name
for your reference. This additional setup ensures the document has the correct encryption mode and is stored in Oracle
WebCenter Content with a specific file name. For more information, see Oracle Fusion File Transfer Automation and
Data Security on My Oracle Support.

Related Topics
« Set up Encryption for File Transfer

 Guidelines for Delivering Extracts

Define SFTP Configurations

You can define the SFTP configuration directly from the Data Exchange work area without any need to define them
externally in the BIP layer. SFTP configuration that you define can be used in Extracts with support for compression and
encryption of data.

By avoiding the BIP layer for the SFTP definitions, it simplifies the configuration and improves the runtime efficiency.
However, you can continue to use the SFTP definitions defined in the BIP Administration.

1. From the Data Exchange work area, go to the Data Exchange Configurations region> File Transfer
Configurations task.

2. Inthe Configurations page click Add to create a configuration.

3. Specify the info in the Details, Server, and Security regions.

4. Click Save and Close.

Note: The Extract SFTP configuration only supports password-based authentication. For key-based authentication,
use the BIP based SFTP delivery option.

SFTP configurations that you define are available in the Delivery Options section of the Extracts Definitions page. HCM
Extracts doesn't store the files that you transfer to the SFTP hosts using the SFTP configuration locally. The files aren't
available for download from the View Extract Results page. You can review these files only from the remote directory,
where the files are delivered.
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Efficient Processing of Large XML Files in Bl Publisher

When large XML files are generated by Extracts that are processed and formatted in Bl Publisher, processing efficiency
can be improved to minimize or avoid failures by using chunking option supported by Extracts and Bl Publisher.

The following steps explain the configuration of chunking option for Extracts using Bl Publisher formatting option.
Prerequisite: You need Bl Administrator privilege to complete the configuration.

1. Under My Clients Group, click Show More in the Quick Actions. Navigate to Payroll > Payroll Process
Configuration.

2. Edit the process configuration group that you use or create a new process configuration group and add the

parameter Split and Process large XML output. Set the default value to Y. You'll use this process configuration

group for running your Extracts and for processing the XML file efficiently using chunking in BIP.

Navigate to the Extracts Definitions page from the Data Exchange work area.

Query your extract definition and ensure a threading DBI is defined for the Extracts.

5. Make sure this threading DBI is also used as one of the attribute or data element in one of the records in the
threading data group.

6. Create a new delivery option after the threading DBI is defined and attach the Bl template used for formatting
in BIP. Existing delivery options that are defined before configuring the threading DBI will not use the chunking
option support.

7. Navigate to Bl > Administration > Runtime Configuration > Properties and set the following properties
present under Data Model node:

o Enable Data Chunking to True

o Data Chunk Size to 100 MB.

8. Edit your Bl report and from the Report Properties window for the report, check the property Enable Chunking
in the General tab.
You can now use the process configuration group and the Extracts definition with the Bl delivery option configured
above to use the chunking option in BIP. You'll notice chunking related XML tags are presented in the generated
Extracts XML file. You'll also see XML chunks processed by the BIP as separate outputs (interim files) from the Report
Job History page in BIP.

P W

Related Topics
« How can | enable data chunking for high-volume extracts?

» How can I chunk high-volume XML data?

FAQs for Filtering and Delivering HCM Extracts

How many characters can the SQL query for the data group filter
criteria have?
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The SQL query for the data group filter criteria is stored as a Character Larger Object (CLOB) type data. The SQL query
can have more than 4000 characters when you delete the existing data group filter criteria and create a new one.

Related Topics
- Filter Extracts Using Advanced Filter Criteria

How can | chunk high-volume XML data?

The HCM Extracts diagnostics enables you to split high-volume XML data into multiple smaller chunks to reduce the
time and memory used for processing high-volume data.

Use the XML data chunking feature of Business Intelligence Publisher (BIP) when you face an issue that disables a
business-critical process while running reports for large volumes of data.

The XML data chunking process involves the following stages:

Schedule the Extracts data chunking process

Create a BIP report based on the predefined data model to generate an output
Schedule a BIP job to deliver the output remotely

. (Optional) Automate the Extracts SFTP delivery option to deliver the data chunks

PUNA

Schedule Extracts data chunking process

Click Navigator > Tools > Scheduled Processes.
On the Scheduled Processes Overview page, click Schedule New Process.
Leave the type as Job, search and select the Extracts Process Diagnostics Report process, and click OK.
In the Process Details dialog box, under the Basic Options section:
o Select Data Chunking as the scope for the chunking process.

AWN S

o Select the instance name as the scope value from which you want to chunk the data.
o Enter a numeric value indicating the number of required chunk sizes (number of objects in one chunk).

5. Define the schedule, output, and notifications for the process set, as you'd do for any scheduled process.
Set any other required options and click Submit.

7. Download the report and log and check the number of chunks generated. Generally, the number of chunks
generated is based on the chunk size and total objects. (Total Chunks Generated = Total Objects/Chunk Size)

o

Use the following query to know the total number of chunks generated:

select count(*) from hry ext parse dtls where transformation_id = (select max(transformation_id) from
hry ext_ transformation where processing type = 'CHUNKING' and instance name = :flow_instance_name)

The data tables used for data chunking:

o hry ext transformation

o Hry ext parse dtls

Use BIP to generate and deliver data outputs

1. Click Navigator > Tools > Reports and Analytics.
2. On the Reports and Analytics page, click Browse Catalog.
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3. Onthe BIP Home page, copy the report associated with the extract definition, and change globalReportsDataModel
to DataChunkingDm data model available in the shared directory ( Shared Folders/Human Capital Management/Extracts/
Data Models/ ).

. Enter the name and description of the report and save it in the Custom directory. (Shared Folders/Custom/...)
Click OK to open the report pane.

Click View Report.

Click Action > Schedule to schedule a report job.

In the General tab, enter the values for Flow Instance Name and Chunk Number parameters.

Execute the report for each generated chunk, starting from chunk 1.

0 0N o v A

For exampile: If you've 100,000 objects to process and you're using a chunk size of 25000 objects, then 4 chunks
will be generated. To generate a report for all objects, you'll need to run the report for chunks 1through 4 until all 4
chunks are processed.

10.1n the Output tab, select FTP as the destination type and click Add Destination.
11. Select the FTP Server from the servers list.

12. Enter the remote directory folder path to deliver the data chunks.

13. Enter a file name for the generated file.

14.Click Submit to schedule the report job.

(Optional) Automate delivery option to deliver data chunks

1. Open the extract definition and click the Deliver tab.
2. Add a new delivery option with the delivery type FTP.
3

. The delivery option will keep the same report and template names. Enter the remote directory path and SFTP server
name.

Delete the Extract Delivery Mode additional details created for the newly added delivery option.
Validate and save the extract definition.

6. Follow the steps mentioned above to run the data chunking process and provide the delivery option name to trigger
automatic delivery to an SFTP server.

v A

Related Topics
- Efficient Processing of Large XML Files in Bl Publisher

» How can | enable data chunking for high-volume extracts?

How do | integrate the Extract Data Chunking Task into a flow with
multiple Extract tasks?

For a flow with multiple extract tasks, you can integrate the extract chunking task as follows:

Initial set up of Bl Publisher: In your existing report (or by making a copy), update the data model by replacing it with
the provided data model:

Data Model Path: Human Capital Management/Extracts/Data Models/DataChunkingDm
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Initial set up of the Extract related to a specific task:

On the Data Exchange work area, select Extract Definitions.
For each extract task, on the Deliver tab, click Add to create a new delivery option with delivery type: FTP.

On the delivery option details page:
o Specify the path of the report you have just modified (or created), along with the associated template.

o Enter the Remote Directory (the target location where the data chunks will be delivered) and the Server
Name (the SFTP server).

o Click Save.

Delete the newly created chunk delivery option name from the Report Category component on the Delivery
Options page.

Validate the extract if it is newly created or if any changes were made apart from updating the delivery options.

Add Extract Data Chunking task to extract flow:

Navigate to My Client Groups > Data Exchange.

Select Refine Extracts under HCM Extracts.

Provide the flow name in the Flow Pattern field and click Search.

Click Edit next to the record in the search results to open the flow pattern in edit mode.

Select the Tasks tab and click + to add a flow task.

Search for Extract Data Chunking Task in the search pop-up click Done. You'll find it in the flow task list.
Click on the Go to Task icon against the Extract Data Chunking Task flow task.

On the Extract Data Chunking Task Details page, you can view basic information such as :Extract Delivery
Option Name, Extract Run Name, Root XML Tag, Base Flow Task Name, Data Chunking Scope, Sequence,
Chunk Size, and Threading XML Tag.

Enter the required values for Extract Run Name, Extract Delivery Option Name, and Base Flow Task Name.
Leave all other parameters blank.

Parameter Name Parameter Basis Basis Value

Extract Delivery Option Name Constant Bind Delivery option name provided in the earlier
steps.

Extract Run Name Post SQL Bind select INSTANCE_NAME from pay_
flow_instances WHERE FLOW_
INSTANCE_ID = :pFlowInstanceld

Base Flow Task Name Post SQL Bind select pft.base_flow_task_name

from pay flow_tasks_vl pft,pay_
flows_vl pf where pft.base_flow_
id = pf.base_flow_id and pf.flow_
name = <Flow Name> and pft.flow_
task_name = <Flow Task Name>

The Flow Task Name needs to be the
name of the Extract task, and not the Data

70

ORACLE



Oracle Fusion Cloud HCM
HCM Extracts

Parameter Name Parameter Basis

- Under the Task Sequence tab, ensure that the sequence is correct.
- Verify the changes and click Submit.
+ Run this flow task in Submit Extracts

Chapter 3

Filtering and Delivering HCM Extracts

Basis Value

Chunking task that was added to the flow as
described earlier.

The Data Chunking task expects the base
Flow Task Name (or the flow task name
derived from the Extract definition) from
which it retrieves the input Extract XML
for splitting. The POST SQL bind is used to
identify this based on the Flow Name and
Flow Task Name.

select pft.base flow_task name
from pay flow_tasks_vl pft,pay_
flows_vl pf where pft.base_ flow_
id = pf.base_flow_id and pf.flow_
name = 'Employee Report' and
pft.flow_task_name = 'Employee
Report Task'

Note: Task name that will be provided to
the above query should always be unique
in a single flow.

Note: Run or submit this only after the previous flow has completed (successfully or with failure). Submitting
a new flow while a previous flow is still running may affect the outcome of the earlier flow and cause issues.

Workaround for Duplicate Task Names in Custom Flows

When same extract task is added multiple times to a flow with the same name, you need to manually update the flow
task name so that each task is uniquely identified. For example, if the Person Extract task is added four times within the
same flow, it is added with the same default name each time. In such cases, manually edit the flow task name to make

them unique within the flow.

Use a unique flow task name when defining the POST SQL bind in the earlier step for the base flow task name, so that

the correct flow task data is clearly identified and passed to the data chunking job.

- Navigate to My Client Groups > Data Exchange and select Refine Extracts.
- Enter the relevant flow name in the Flow Pattern field and click Search. Once the results are displayed, click

Edit icon on the right.

- Select the task that is required for the current scope and has a duplicate name.

- Click Edit icon and rename the flow task name.
- Click Submit.
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How can | create multiple output files in HCM Extracts?

There are multiple approaches to create multiple extract results.

Run/Schedule Extracts separately for different Legal Entity ID/Legal Entity or other criteria per your
requirement.

If Legal Entities (or other filter parameter) are constant, create separate delivery options and filters to show only
records related to different Legal Entity filtering in the RTF/ETEXT template.

Enable bursting by changing the Extract Results Delivery type when creating or editing a delivery option in the
Extract Definitions page. Click Enable in the Bursting to enable the bursting options associated with the BIP
template.

How can | set time zones during scheduling of an Extract?

The schedule date and time are displayed in the local time zone (as defined by the Preferences setting.)

To set the time zone preference, follow these steps:

1. From the main page, click the down arrow next to your name.
2. Go to Set Preferences > Regional and select your time zone.

Note: The schedule date and time are stored in the servers as Coordinated Universal Time (UTC). Any dates coming
from HCM Extract will be in UTC.

How can | restrict the records to be extracted?

You can define a set of filtering conditions the application must perform on an extract data group using the extract data
group criteria. You specify the criteria conditions using an expression or fast formula.

You can specify to data group filter as an expression or as fast formula, and you can choose one or both. You can build
criteria using the available database items, parameters, and operators (conditional and logical). The filter criteria will
be more efficient as it gets appended to the User Entity SQL at the time of execution. If you can't specify the criteria as
an expression, then you can place logic inside a fast formula and select here. Fast formulas return values of Y or N to
indicate if you must extract the record or not. If both criteria and formula are specified, then both the conditions are
applied.

Related Topics
- Extract Components

« Define Extracts
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Why is Effective date a required parameter for the Extracts?

HCM Extracts uses the effective date to determine the records that are eligible for extracts.

If the effective start date of a record is less than the effective date and the effective end date of the record is higher than
the effective date, the record is eligible for processing by Extracts. Effective date is used by all date effective user entities
delivered by HCM Cloud.

Can | view the results of an extract run that have delivery options
other than WebCenter Content?

You can use the View Extract Results task in the Data Exchange work area to view the extract run information. You need
to use the filters on the View Extract Results page to search the extract or extract run. Click the extract instance name
in the search results to view the extract run details on the extract details page. You can download the extract run results
from the Extract Delivery Options tab if the extract run is submitted and completed successfully.

Can | rollback an extract run?

You can rollback an entire extract run using the Rollback option from the View Extract Results UL.
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4 Flow Patterns

Flow Patterns for Extracts and Reports

A flow pattern exists for each extract or report process. Flow patterns for extracts and reports typically contain a single
flow task and they define the submission parameters.

Use the Manage Payroll Flow Pattern task from the Payroll Checklist work area or the Refine Extract task in the Data
Exchange work area to edit flow patterns. You can edit a flow pattern to add additional tasks. Each flow pattern you
create must be associated with a security profile. Each flow pattern you create must have a Legislative Data Group.

Checklist and Flow Tasks

When you submit a flow pattern it creates an instance of the flow. For every submitted flow, the application generates a
checklist by default.

Use the Checklist page to manage and monitor the the status of a submitted flow and take corrective action to resolve
issues.

You can also use the View Flows page, and click on a single task or task flow to go to the Checklist page of the selected
flow.

Here's what the checklist might include, depending on the flow pattern.

- Automatic tasks, such as extracts, reports, and processes
Manual tasks, such as the Verify Payroll Process verification task, required to complete a flow

Here's what you can do with checKlists.

Monitor the status of the flow tasks

Manage the flow tasks, such as reassigning tasks, marking tasks as completed, and performing corrective
actions

- View task details, such as a list of records processed by the flow

While working on a task in the flow, you can remain on the Checklist page or go to a related page that includes tasks in
the flow. For example, while reviewing the results for the Calculate Payroll task, you can go to the related pages to review
the person's calculation card or element entries.

What You Can Do on the Checklist Page

Perform these tasks to manage and monitor flows from the Checklist page.

- View the flow statistics displayed at the top of the page. It displays the number of overall activities included in
the flow. You define the activity information when you create the flow.
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Review the flow analytics to check the number of Connected Flows, Linked Flows, and Related Flows. Click on
any of them to further drill down and view the details.

Drill down to each individual task and view the task status and take an action specific to the individual task.

The actions available to you when working with a task depends on its status and the status of the tasks that
precede or follow it. For example, if a task has completed with alerts, it indicates that the process has completed
with one or more records in error status, the process has been rolled back, or marked for retry.

Click on the task to view the process results and drill down to the records that have errors and need correction.
After making the corrections, you can come back to the Checklist page and resubmit the task to process the
records that were in error.

- Validate a manual task within the flow and mark as complete, so that downstream tasks within the flow can
begin.

For example, a payroll manager may review and validate the details of the generated payments register and
make corrections if any, before enabling the payments processing task to proceed. The payroll manager must
manually set the status of the Run Payments Register task to complete, so that other downstream tasks can be
initiated.

Reassign a task to a different owner. Drill down to a task and select the Change Owner task action to change the
owner of the task.

Drill down to the Parameters section to view the flow parameter details.

Drill down to the Linked Flows section to view flows and tasks linked to the current flow. Click on the flow to
view the details of the flow linked to the current flow. Use the Back arrow to return to the current flow page.

Drill down to the Process Results page to view all messages and errors for a task. Once you have identified the
records that have errors, click on the person name to see what the error is, and take corrective action on them.
You may have to return to the person's record to correct the errors.

Drill down to the Process Results page to access output information for a task such as reports and log files.

Use the Roll Back All option from the Actions menu on the checklist page to roll back multiple tasks within a
flow. You don't have to manually select each task to roll back the tasks within the flow.

Verify a Process

Use the Verify option on the Tasks tab of the Payroll Flow Pattern pageand enable the Verify option on a flow task so
thatthe flow doesn’t move onto the next task in the flow sequence, until this task is verified. For example, enable verify
on the Calculate Payroll task to enable the payroll team to verify the payroll results before the flow automatically submits
the payroll reports.

When this option is enabled, the flow considers the task as active until it's verified by a flow owner.

Once enabled, the Verify action is available for the task on the Checklists page. This option is available only on the
Checklists page and only for completed tasks. The Checklists page displays a verification status message and for
verified tasks, the details of the person who verified the task.

Note: This option is available for all processes only. This option isn't available for manual tasks.
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Submit a Report

Use the Submit a Report action to submit a report that's not included in your flow. This feature enables you to perform
ad-hoc reporting for the processes in your flow directly from the Checklist page. The Submit a Report action supports
the following:

- The parameters of the task from where you added the report is defaulted automatically to the report.
- The report gets added after the task you used to submit the report.

- When you submit the report, the report runs only after the previous task in the flow has completed.

- The results of the report are based on the previous task that we are running this report on.

In the case of any issues with the process, you can take corrective actions and resubmit the report without
rolling back the report.

- You can view the report output directly from the Checklist page and without you navigating to the process
results page.

Use the Resubmit option and resubmit the report with the same parameters and the report output replaces the
previous version of the report output.

If the same report is resubmitted multiple times, you can use the View History action to view the submission history.

Roll Back and Payroll Relationship Groups

Use the Roll Back Errors option to roll back records that have errors. The application includes the rolled back records

in a payroll relationship group. You can select either an existing payroll relationship group or create a new payroll
relationship group. The existing group can be a group already created for this flow, or for another flow, or one that’s
manually created. You can now use a single payroll relationship group for the whole flow across multiple tasks within the
flow.

You can also roll back employees who may not be in an error state. For example, the payroll administrator who runs the
regular payroll may be notified of an employee who is terminated during a payroll period. If the employee record isn’'t
rolled back and removed from the payroll process, the company may end up overpaying the terminated employee. The
payroll administrator can roll back this employee and add the record to a new or existing PR group.

After you have rolled back results for a process, navigate to the Payroll Relationship Group page and open the PR Group
to view and correct the rolled back records.

How Tasks Within Flow Patterns are Edited

You can create or copy a flow pattern and then add, delete, or move tasks in the flow pattern. This topic provides
examples of edits you can perform to tasks in a flow pattern.

Perform these edits on the Task Sequence tab of the Payroll Flow Patterns page. For extract flow patterns, use the
Refine Extracts task.

Edit Tasks

This table lists a few examples of edits you can perform and the probable impact the edits can have on the flow.
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Edits

Add a task

Delete a task

Move a task to a different activity

Reorder the list of tasks displayed in a checklist

Impact

You add a task to position it as the last task
in the activity or task group. Update the task
sequence.

If you repeat a task, rename it to make clear its
purpose on the checklist.

When you delete a task you may impact
subsequent tasks in the flow that depend on its
results. Review the subsequent tasks.

The activity determines the work areas where
you can submit the flow patterns you define,
and controls how the checklist displays.

The sequence specified for the task further
determines the task order within an activity on
the checklist.

Flow Pattern Parameters

Chapter 4
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Examples

You add a manual verification task after each
report. You rename each task with the report
name.

You delete a task. The Parameter Basis of the
next task is Bind to Task and its Basis Value is
the value of the deleted task. The you must
update the Parameter Basis of the subsequent
task as required, for example, to Bind to Flow.

You move a task in a payroll flow pattern for
a report from the Payments activity to the
Statutory activity.

You decide to flatten the checklist sequence to
group all the tasks within a single activity.

1. On the Tasks page, you confirm that each
task belongs to the same activity and task
group.

2. You edit each task, specifying a value in
the Sequence column on the Edit Task
Details Owners and Details page.

The lowest number is used for the first
task in the checklist. For example, you
might specify a sequence of 10 for

the payroll calculation task and 20 for
the prepayments calculation task. On
the checklist, the payroll calculation

is displayed before the prepayments
calculation task .

Each task in a flow pattern supports task actions, such as submit, roll back, mark for retry, retry, and view. Task action
parameters control how the application processes a task and how the task relates to other tasks in the flow pattern.

Flow parameters are a subset of task action parameters. They supply the information required to successfully complete

the tasks in the flow pattern.

ORACLE
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Flow Pattern

Task Task Task
Task Action Task Action Task Action
Task Action Task Action Task Action
Parameters Parameters Parameters

Use as Flow
Parameters?

Flow Parameters

The values of some task parameters can't be derived or defaulted, and you must make a manual entry. The other
parameters are defaulted or are derived. You can add new flow parameters from the list of available task parameters, or
update the details of the existing flow parameters.

A parameter is defined in the application database using a Base Flow Parameter Name. If the report parameter name,
exposed in the Ul at the flow-level, matches the Base Flow Parameter Name, then the list of values are defaulted
directly. The Base Flow Parameter Name isn't exposed on the UL.

If required, edit a base flow parameter and rename it. You can see the edited parameter name on the flow submission
page when you submit the flow. The base flow parameter name isn't displayed on the UL.

- When you create a flow pattern, review and edit the task parameters for the Submit task actions.

- Before you submit a flow, review and edit the task action parameters and the flow parameters for each task
within the flow. Task action parameters control task interactions.

These are the parameter details you can edit.

Display and Display Formats

Use the Display parameters to control the format and availability of the flow parameter on the UL.
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Parameters

Display

Display Format

Purpose
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Determines whether the parameter displays on the page when you submit the flow.

Identifies the type of data displayed, such as a date or text, or choice list

Display parameters work with other parameters, such as Parameter Basis and Basis Value. For example, most task
action parameters don't display the Request parameter because the application obtains the value for this parameter

from the context.

This table displays the display format options that you can use for the different types of flow parameters.

Display Formats of Flow Parameters

Display Format

Date

Choice List

Lookup Choice List
Number
Positive Number

Smart LOV

Text

Value Set

Typed Search
WebCenter Content File
Integer

Positive Rational Number

Code

LK

PN

LoV

T

ORA_VALUESET

TS

Uc™Mm

INT

PRN

Usage

Use this format for a Date parameter. Use the date picker to enter an input value.

Use this option to display a list of values coming from a value object returning a specific
code and meaning.

Use this option to display a list of values defined in a lookup.
Use this option to enter only numbers, such as 0, 1, -1, 0.5
Use this option to enter only non-decimal, positive numbers, such as 0, 1, 2, 3.

Use this option an advanced version of List Of Values supporting user-defined values
based on dependency, View Criteria, Display and Storage attributes backed by a value
object.

Use this option to enter any text.

Use this option to display a list of values defined Value Set.

Use this option to display a list of values defined Value Set using lazy loading support.
Use this option to upload files to UCM and pass the UCM ID to the process.

Use this option to enter only non-decimal numbers, such as -1, 0, 1, 2, 3.

Use this option to enter positive numbers including decimal, such as 0, 1, 2, 2.5, 3, 3.5.

When defining your flow parameter, use the Display value options to determine if the parameter should be displayed on
the Ul and if a parameter value is required when you submit the flow.

Option

Mandatory

ORACLE

Used to

Display the parameter on the Ul and it's mandatory for you to enter a value during flow submission.
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Option Used to
No Derive or default the parameter value, the parameter isn't displayed on the Ul.
Yes Display the parameter on the Ul, but it's optional for you to enter a value during flow submission.

Lookups and Value Sets

Use lookups and value sets for descriptive flexfields to control and validate the data used in the payroll flow pattern.
Select from a list of predefined application lookup values or value sets or ones that you have defined.

This table lists how the lookup values are derived and the corresponding parameter basis you can use.

Lookup Value Parameter Basis to Use

Entered when submitting a flow Bind to Flow

The application derives the value during SQL Bind or Bind to Flow Task or Context Binding
flow submission and presents it. The value

is derived from existing tables, such as the

value for the payroll statutory unit. During

flow submission, you can either use the

derived value presented to you or override

it.

The application derives the value from a Post SQL Bind
Post SQL process

Usage

A parameter can receive information or generate information that subsequent tasks can use. For example, for the
Calculate Payroll task, the Payroll Process parameter for the Submit task action generates an output value for the payroll
action ID. The Retry task action can use this payroll action ID.

For output usage parameters the parameter isn't displayed and its value is derived using the parameter basis.

Parameter Option Setting
Display No
Parameter Basis - Bind to Flow, the application derives the value from the flow parameter and then updates the flow

parameters table with the output value

- If you select no value, the output value results from the task's output

81
ORACLE



Oracle Fusion Cloud HCM
HCM Extracts

Sequence
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Sequence indicates the order in which the parameter is available on the Ul for you to enter a value. Sequence numbers
control the order in which the application processes and displays the parameters. In the case of hidden parameters,
they're processed after a required or dependent parameter is processed.

For example, if you have two lookups and the values of the second lookup depends on the first lookup. You must set the
first lookup to a lower sequence number than the second one.

Parameter Basis and Basis Value

The parameter basis controls how the application derives the value for the parameter. The basis value further specifies
the value the application uses for the parameter.

This table provides list of values to select parameter basis and basis values when you define payroll flows. Also view
examples of when you can select them and how the values are assigned.

Parameter Basis

Constant Bind or Use Specified
Value

Bind to Context

Bind to Flow Parameter

Bind to Flow Task Parameter

Bind to Task Parameter

ORACLE

What the Parameter Basis Does

Assigns a specific value to the
parameter.

Derives the value from the context
of the current flow instance or the
task instance of the flow pattern.

Derives the value from one of the
flow parameter values.

Binds the value to the output of the
previous task.

Resolves the value for the task
parameter.

Basis Value Available

Enter the text as a constant or
value, when you submit the flow.

Select flow, task, or the Request.
The application automatically
generates the parameter value.

Application automatically derives
the parameter value.

Select a value from the previous
task's parameters.

Select a value from the current
task's parameters.

Example

Specify a constant if the value is
the same for all tasks, such as the
payroll statutory unit.

If the task includes a Request
parameter, bind it to the flow
context. Tasks in the flow reference
this task using the Request ID
generated by the application.

Bind the legislative data group
parameter to a task parameter that
supplies the legislative data group.

For example, the legislative data
group for prepayments uses

the payroll as context, because
it's already associated with the
legislative data group.

Bind a parameter to the flow

that several tasks share to avoid
multiple occurrences of the same
parameter.

Bind a parameter to a task, such
as Retry corrective action. When
the flow owner resubmits the task
to retry it, the application uses
the output of the Submit task
parameter.

Bind a parameter to the task if
several tasks share a parameter,
such as a start date, but one task
requires a different date.
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Parameter Basis

No value specified

Post SQL Bind

SQL Bind

What the Parameter Basis Does

Stops the application from
generating a parameter value when
the task executes.

Calculates the parameter but
doesn't display it on the user
interface.

Calculates and displays value
on the user interface, prior to
submission.

Basis Value Available

Application generates a blank
value.

SQL statement calculates the
parameter value.

SQL statement calculates the
parameter value and display it
on the user interface, before
submission.

Chapter 4
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Example

Not applicable

Bind a parameter using the Post
SQL bind to generate data.

For example, use a post SQL
process to use the payroll period
and payroll parameters entered

by you and generate the process
date. The payroll and payroll period
are mandatory parameters. They
have a higher sequence number
than the process date, so that the
process date derives its value after
you enter their values.

Bind a parameter using SQL Bind

For example use SQL Bind to
calculate the payment type
parameter for the Generate Check
Payment task. The application
obtains the payment type ID for the
check payment record.

Use SQL Bind to prompt the
task owner to enter a reason for
a corrective action, such as a
QuickPay.

The Basis Value is related to the Parameter Basis. For example, when the Parameter Basis is Post SQL Bind the Basis
Value contains the SQL used for the Post SQL Bind.

Flow Task Start and Due Dates

Use duration dates and notification options in the payroll flow pattern to give flow owners adequate time before a task
starts, to prepare and address any issues.

Task Start and Due Dates

Let's look at the duration dates you can enter on the Tasks page of the Manage Payroll Flow Patterns page:

- Start date, the date the task owner should start the task.
Note: The start date applies to notifications only. Enter the flow start date on the Scheduling page when you

schedule the flow.

- Due date, the date the task owner should complete the task.

ORACLE
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To specify duration dates:

1. Select the flow parameter date to use as the basis for the duration date.
2. Optionally, offset the date by specifying a plus or minus value depending on whether the date falls before or
after the duration date.

Notifications

Notifications are error and warning messages to inform the task owner when a task starts or ends. The receipt of
notifications depends on the duration dates and their offsets.

1. Specify the notifications the task owner receives.
2. Optionally, specify the number of days before the application automatically deletes a notification from storage.

Use the Manage Payroll Process Configuration task to complete the Notification Expiration Offset parameter.

Examples of Editing Flow Patterns

Review these scenarios to understand how you can edit flow patterns to meet the requirements of your enterprise. Use
the Payroll Flow Pattern task or the Refine Extracts task to edit these scenarios.

Update a Parameter to Use a Specified Value

Your payroll uses a single process configuration group named InFusion Consolidation Group A. You want to specify
a constant for the configuration group task action parameter and hide the parameter to avoid data entry mistakes.
Perform these steps.

1. Query the flow pattern you defined for the payroll cycle.
2. Onthe Parameters tab of the Payroll Flow Pattern page, edit the Process Configuration Group parameter.

Enter these values to maintain a constant value for the Process Configuration Group task action parameter and
avoid data entry mistakes.

Parameter Detail Value

Display No

Display Format Text

Lookup No value

Usage Input Parameter
Parameter Basis Constant Bind
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Parameter Detail Value
Basis Value InFusion Configuration Group A

Supply a Reason for a Corrective Action

Your enterprise typically issues electronic funds transfer payments. You defined a flow pattern to issue check payments
and you want to verify and track the reason managers issue checks. You can add a flow parameter to capture that
information.

1. Query the payments flow pattern you defined.

2. On the Parameters tab of the Payroll Flow Pattern page, Select and Add the Reason parameter to include the
parameter as a flow submission parameter. Enter these details.

Parameter Detail Value

Display Yes

Display Format Text

Lookup No value

Usage Input Parameter
Parameter Basis Context Binding
Basis Value Payroll Flow

Add Tasks and Reorder the Task Sequence

Your flow pattern includes the Calculate Gross Earnings process and the Element Results Register Report. Perform these
steps to run the two extract reports concurrently, and add a verification task, to simplify the checklist to a single list.

1. From the Data Exchange area, select the Refine Extracts task.
2. On the Refine HCM Extracts page, query the flow pattern.
3. On the Tasks tab of the Payroll Flow Patterns page:

a. Add the first extract report, specifying the same Activity and Task Group as the Calculate Gross Earnings.
b. Add the second extract report, specifying the same Activity and Task Group as the Calculate Cross
Earnings.
c. Add a manual verification task, specifying the same Activity and Task Group as the Calculate Cross
Earnings.
4. Edit each task, specifying a sequence number on the Edit Task Details: Owners and Checklist Details page.
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The lowest number is used for the first task in the checklist. For example, you might specify a sequence of:
o 10 for the Calculate Gross Earnings task
o 20 for the first extract report
o 30 for the second extract report
o 40 for the manual verification task

5. On the Tasks Sequence tab, reorder the sequence of reporting tasks in this order to run the two reports
concurrently.

Task Following Task

Start Flow Calculate Gross Earnings
Calculate Gross Earnings First extract report
Calculate Gross Earnings Second extract report
First extract report Manual verification task
Second extract report Manual verification task
Manual verification task End Flow

Automatically Increment Dates in the Scheduled Extract

You create a flow pattern to extract weekly payroll data that requires the user to enter a process date parameter. You
schedule the extract to run weekly. The application evaluates the flow parameters at the time of submission, and the
task parameters at the beginning of task execution. You edit the task parameters to automatically increment the date
field. The date values are derived from the default date parameter values.

You use the Refine Extracts task or the Payroll Flow Patterns task. Perform these actions to edit the task parameters on
the task's Basic Information page.

1. Select the Process Date parameter.
2. Select Context binding from the Parameter Basis field.
3. Select System Date from the Basis Value field.

Add a Bl Publisher Report to a Flow

This example demonstrates how you can create a Bl Publisher report and run the report using a flow. Add single or
multiple Bl Publisher reports to your copied or user-defined flow pattern.
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When you submit the flow, the report automatically generates an output file that you can view. The output file is based
on the template used for the Bl Publisher report, Use the Run Bl Publisher Report task to include the task in the flow
pattern. The Run Bl Publisher Report task belongs to the Statutory activities in the flow pattern.

Complete these tasks to create a user-defined report and include it in a flow.

- Create a Data Model
- Create a report template

- Create a user-defined flow to run the new report

Create a Data Model

A data model is the source of data for the report and it contains a set of instructions for the Bl Publisher to retrieve and
structure data for a report. In this example, you create a data model that has a single data set that retrieves data from a
single data source, the database tables in the HCM application.

You use an SQL query to reference the application database tables and retrieve the list of values for the report
parameters. When you run the report, the report engine executes the query and uses the results to display and populate
the parameter list of values.

You must have Bl Publisher Developer or Bl Publisher Administrator role to create or edit reports from the Bl Publisher.

Follow these steps to create the data model.

Navigate to Reports and Analytics under Tools in My Client Groups on the Home page.
Click Browse Catalog to open Bl analytics in a new tab.

Navigate to /Shared Folders/Custom folder.

Click New and select Data Model under Published Reporting.

Click Add under Diagram and select SQL Query.

Enter this information in the New Data Set - SQL Query window.

ocCuhWUNRA

Field Value

Name Enter a name for the new data model.
Data Source ApplicationDB_HCM

Type of SQL Standard SQL

7. Enter this SQL Query in the Query Builder box.

Select pfi. Instance Name, pfi.Fl Task Status, pfi.Status as Task Status, pci.Status as
Checklist_Status, pci.Owner_ID

from pay flow_instances pfi, Pay Flow_Instances pci

where pfi.flow_instance id = pci.flow_instance_id

and pfi.instance_name = instanceName

and pfi.status = flowStatus

and pci.status = checklistStatus

8. Click OK.
9. Click Parameters under Properties in the left pane.
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10.

1n.

12
13.
14.
15.
16.
17.

Enter these values for each of the three parameters defined for this model, Flow Instance Name, Flow Status,
and Checklist Status.

Field Value

Name Enter a name for the parameter.

Data Type Select String from the list.

Default Value This isn't a mandatory field.

Parameter Type Select a value from the list. Select text for all three parameters in this example.

Row Placement Enter a value to show in which row to place each parameter. By default, all parameters are

placed in row one.

Click the Save As icon, enter a Name for the Data Model, and save the Data Model under the path Shared
Folders/Custom/.

To test the Data Model, select the Data tab.

Click View to view the XML. Provide a value for the three parameters.

Click Table View to view the sample data in a tabular form.

Click Validate.

Click Export and save the XML file locally on your computer.

Click View Engine Log and view the Data Processor log file in XML form. You can save the file to your local
directory.

Create the RTF Report Template

You can either use MS Word which already has the Bl Publisher plug-in integrated to create an RTF template or use Bl
publisher's quick Create Report option from the Data Model editor page. In this example, we will use the Create Report

option.

Follow these steps to create an RTF report template.

1.

Click Create Report.

Under the Select Data tab, click Use Data Model option to create the report using the data model you have
already created in the previous task.

Click Next and under the Select Layout tab, select the report layout to define the page orientation of the report.
The available options are either Portrait or Landscape.

Click Next and under the Create Table tab drag fields from the Data Source and drop them in columns on the
table in an appropriate sequence.

The Create Report process uses the sample data that is saved to the data model. If sample data is not attached
to the data model, the selected column headings display without data.

Click Next and save the report in the Shared Folders/Custom folder.

Navigate to /SharedFolders/Custom and open the report, provide appropriate values for the Instance Name,
Flow Status and Checklist Status as an input parameter and click Apply.
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7.

8.

To add additional roles, for example, Bl Consumer Role, click More and then Permissions, and select the
appropriate Permissions against a role.
Click OK.

Create a User-Defined Flow to Run the Bl Publisher Report

Follow these steps to add the Bl Publisher report to a user-defined flow.

1.
2.

Sl o

N

10.
1n.

Use the Flow Patterns task under Payroll in My Client Groups.
Click Create and enter this information.

Field Value

Flow Pattern Enter a name for the flow pattern.

Description Entering a description for the flow is optional.

LDG Required Select an LDG to restrict this flow for a specific legislative data group.
Flow Status Select Active.

Connector Status Task Flow

Select Statutory in the Activities to Include field.

In the Tasks section, select Run Bl Publisher Report.

Click Next.

On the Parameters page, click Select and Add, and add the three parameters.

The flow parameters map to the Bl Publisher arguments. For example, if your report is based on a SQL query,
the first argument is the first bind variable of a SQL query data model.

Tip: To easily determine the sequence of arguments, view the list of parameters for the generated report in
Bl Publisher.

For example the First Argument is the Instance Name, the Second Argument is the Flow Status and so on.
Optionally, rename the parameter to a more meaningful name.
On the Task parameters page, in the Parameter Details section, complete these steps:

a. Confirm that the Parameter Basis for the First Argument value is Bind to Flow.
b. Select the Report Path parameter and enter the parameter Basis as Constant and Basis Value as the
report path. Enter the path of the XDO.

For example, if the Bl Publisher data model is saved to the Custom folder in Shared Folders you would
Specify /Custom/yourBIreport.xdo.

Verify that the first, second and third argument parameters are bound to the flow parameter correctly.

Click Next, review the flow and save it.

Use Submit a Flow task from Payroll in My Client Groups on the Home page and submit the flow.
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12. Submit the flow and view Checklist. Keep refreshing until flow is completed. Once completed, click on the Run
Bl Publisher Report link and view the report output.

Create a Flow within a Flow

In this example you copy the Transfer Batch flow and modify it to include a predefined report flow pattern you created
earlier. The predefined flow you add submits a report to check for any batch line errors during the Transfer Batch
process.

If the transfer fails, you can skip the transfer process or mark it as complete, and then view the report for error details.

Create the Parent Flow Pattern

In the Payroll Checklist work area, select the Manage Payroll Flow Patterns task.
Search for and select the row for Transfer Batch, and then click Copy.
Enter the name of the new flow pattern, such as Transfer Batch with Error Report.
Enter a description, such as "Transfer a batch and view any batch line errors that occurred.” and then click Save
and Close.
Search for and select the Transfer Batch with Error Report flow pattern, and then click Edit.
Here's the list of tasks to add the parameter that derives batch name from the batch ID.
a. On the Parameters tab, click Add.
b. Select the added row and click Edit.
c. Add these values.

PWN

owm

Field Value

Flow Parameter Batch Name
Use for Searches No

Display No

Display Format Text

Sequence 3

Usage Input parameter

Parameter Basis

Basis Value

ORACLE

Post SQL Bind

select batch_name from pay batch_headers where batch_id = :BATCH
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7. Click Save.

Add the Report to the Parent Flow

1. On the Tasks tab, click Select and Add.
2. Inthe Search window, search for and select Submit Another Flow, and then click Done.

3. Inthe row for Submit Another Flow, click Edit on the menu bar and set these values to define the task you have
added to generate the batch lines error report.

Field Value

Task Run Batch Lines Report

Activity Statutory

Task Group Reporting

Description Submit the batch lines error report for the specified batch.

4. Edit task parameters as follows:

a. Inthe row for Run Batch Lines Report, click Edit Task.

b. Configure these predefined task parameters. Select a parameter and the corresponding parameter basis
and basis value.

Parameter Parameter Basis Basis Value

Flow Name Constant Bind The name of the flow, for example Batch
Lines Report. This value is case-sensitive.
Enter the name exactly.

From Flow Instance ID Context Binding Payroll flow
From Flow Task Instance ID Context Binding Payroll task
Use to Calculate Results Constant Bind Y

Parameter Name 1 Constant Bind Batch Name
Parameter Value 1 Bind To Flow Batch Name
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c. Click Next, and optionally complete the owner and checklist information.
d. Click Next, and optionally complete the duration and notification information.
e. Click Submit.

5. Perform these steps to edit the task sequence:

a. Onthe Task Sequence tab, edit these two rows to enter the flow tasks and sequence in the flow.

Start Flow Following Task
Transfer Batch Run Batch Lines Report
Run Batch Lines Report End Flow

b. Click Submit.

Test the Flow

1. Create and save a test batch that should cause an error.

Alternatively, you can search for an existing batch that was transferred with errors using this SQL query:

select * from pay batch headers where batch_status = 'E';

On the Submit a Process or Report page, select a legislative data group.

Select the Transfer Batch with Error Report task, and then click Next.

Enter a unique name for the current flow instance.

Enter the name of the batch with errors that you saved or queried, and then click Submit.

Click OK and View Checklist, and then click the Refresh icon until the Transfer Batch task shows as in progress
with error.

7. View the report in the flow as follows:

cuppuwN

Select the row with the Transfer Batch task, and then select Skip Task in the Actions menu.
In the row for Run Batch Lines Report, click Go to Task.

In the Processes and Results section, click the name of the report.

In the row for Run Bl Publisher Report, click Go to Task.

On the Process and Reports tab, click View Results.

Click the PDF file name to open the report.
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Related Topics
« Create a Flow within a Flow
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FAQs for Flow Patterns

What happens if | don't enter a task owner in a flow pattern?

The person who submits the flow becomes the flow owner and the task owner. The person's security privileges
determine whether the person can submit the flow.

How can | rearrange tasks in a flow pattern?

Every flow pattern begins with a Start Flow task, which doesn't belong to an Activity or Task Group, and concludes with
an End Flow task. Edit the task sequence by selecting a different task in the Following Task column.

When you create a flow, use the Task Sequence page to rearrange the tasks. When you edit a flow, select the task and
edit its sequence on the Create Flow Pattern: Basic Information page. When you submit a flow, processes in the flow use
and build upon the results of the previous processes. To maintain data integrity, ensure the sequenced tasks follow a
consecutive order.

How can | improve performance and troubleshoot flows?

Add parameters to a payroll process configuration group to optimize performance and troubleshoot your payroll
processes. To process large volumes of records, use the Threads and Chunk Size parameters.

To troubleshoot processes, add the Logging Category or Formula Execution Logging parameters to a configuration
group and rerun the process using that configuration group. Using these parameters enables you to investigate formula
code problems.

How can | run tasks concurrently in a flow?

Use the Manage Payroll Flow Patterns task in the Payroll Checklist. Search for and open your flow pattern. Click the Task
Sequence tab. Specify that each concurrent task follows the same previous task.

For example, you create a flow pattern with a payroll calculation task and two reports. The flow ends when both reports
complete. You can use these actions to run the payroll calculation task and the two reports run concurrently.

1. For the first row, specify the Start Flow task with the Calculate Payroll as the following task.

For the second row, specify Calculate Payroll as the task, and the first report as the following task.
For the third row, specify Calculate Payroll as the task, and the second report as the following task.
For the fourth row, specify the first report as the task and End Flow as the following task.

For the last row, specify the second report as the task and End Flow as the following task.

v phWN
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5 Transferring Encrypted Data

Set up Encryption for File Transfer

You use encryption keys to encrypt files for secure transfer between Oracle HCM Cloud and your own servers through
the Oracle WebCenter Content server. This PGP-based encryption support is available for secure file transfer using HCM
Data Loader and HCM Extracts.

The process for inbound files (into Oracle HCM Cloud) is:

1. You encrypt files using the Oracle HCM Cloud public key.
2. The data-loading process decrypts files using the Oracle HCM Cloud private key.
The process for outbound files (generated by Oracle HCM Cloud) is:

1. Oracle HCM Cloud encrypts files using your public key.
2. You decrypt files using your private key.
Therefore, before you can encrypt or decrypt files, you must:

1. Import your public key to Oracle HCM Cloud.
2. Generate the PGP encryption key pair and download the Oracle HCM Cloud public key.
You can also sign the files, as follows:

- Outbound files are signed using the HCM Cloud private key. You verify these files using the HCM Cloud public
key.

Inbound files are signed using your private key. The data-loading process verifies inbound files using your
public key.

This topic describes how to set up encryption, decryption, and signing of files.

Encryption and Signature Keys

This table shows you the keys that are used for encryption, decryption, signing, and verification in each supported
encryption mode.

Encryption Mode Encryption Key Decryption Key Signing Key Verification Key
Outbound PGP Signed customer-key_pub customer-key_priv fusion-key_priv fusion-key_pub
Outbound PGP Unsigned customer-key_pub customer-key_priv N/A N/A

Inbound PGP Signed fusion-key_pub fusion-key_priv customer-key_priv customer-key_pub
Inbound PGP Unsigned fusion-key_pub fusion-key_priv N/A N/A
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Importing Your Public Key

You use your public key (customer-key_pub) for encrypting outbound files. You can decrypt the files using your private
key (customer-key_priv). If you also want outbound files to be signed, then use the HCM Cloud private key (fusion-
key_priv) for signing. You can verify signed outbound files using the HCM Cloud public key (fusion-key_pub).

To import the customer public key:

Sign in to Oracle HCM Cloud with the IT Security Manager job role or privileges.
Select Navigator > Tools > Security Console to open the Security Console.

Click the Certificates tab to open the Certificates page.

Click Import to open the Import page.

Set Certificate Type to PGP.

In the Alias field, enter a name to uniquely identify your key.

Click Browse to identify the location of the customer public key.

Click Import and Close to import the public key into the Oracle HCM Cloud keystore.
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Your public key now appears on the Security Console Certificates page.

Generating the PGP Encryption Key Pair

You generate the PGP key pair on the Security Console. You download the public key to encrypt files that are inbound
into HCM Cloud (for example, input data files for HCM Data Loader). To sign these inbound files, you can use your
private key (customer-key_priv), which is verified using your public key (customer-key_pub) in Oracle HCM Cloud. You
must have imported the customer public key.

To generate the PGP Encryption Key Pair:

Sign in to Oracle HCM Cloud with the IT Security Manager job role or privileges.
Select Navigator > Tools > Security Console to open the Security Console.
Click the Certificates tab to open the Certificates page.

Click Generate to open the Generate dialog box.

In the Generate dialog box, set Certificate Type to PGP.

In the Alias field, enter fusion-key.
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Note: You must enter fusion-key in this field. Otherwise, the encryption APIs can't use this key to decrypt all
encrypted inbound files.

7. Inthe Passphrase field, enter a passphrase for the private key. This passphrase is needed when you edit,
delete, or download the private key.

Note: If you forget the passphrase, then you may have to raise a service request for help to delete the private
key. Once the old key is deleted, you can generate a new key using the process described here.

8. Inthe Key Algorithm field, select RSA.
9. Inthe Key Length field, select either 1024 or 2048.

10. Click Save and Close. The fusion-key pair is generated and ready for download. You can see the fusion-key pair
on the Certificates page of the Security Console.

11. In the Status actions for the fusion-key pair on the Certificates page, select Export > Public key. Save the
HCM Cloud public key (fusion-key_pub.asc) to your desktop. Use the downloaded key to encrypt files that are
inbound to Oracle HCM Cloud.
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Transfer Files Automatically from HCM Extracts with PGP
Encryption

Transfer encrypted files to Oracle WebCenter Content using HCM Extracts and your encryption key. HCM Extracts can
generate encrypted output and store it on the WebCenter Content server. For example, you can encrypt and decrypt
files that contain sensitive employee data or confidential documents.

Use HCM Extracts to generate encrypted files and deliver them to the WebCenter Content server. You write your own
programs to collect the files.

I Note: You must set up your encryption keys before you try to encrypt or decrypt data.

Outbound Integrations

Set up the following information to use HCM Extracts with your outbound integrations:

In the Data Exchange work area, select the Manage Extract Definitions task.
Select the WebCenter Content delivery type on the Deliver page.
Enter an Integration Name. The application uses this name to create the title of the entry in WebCenter Content.

Select an Encryption Mode. The encryption mode is one of the values from the
ORA_HRC_FILE_ENCRYPT_TYPE lookup type. It identifies how the application encrypts the file before loading
it to WebCenter Content. When HCM Extracts transfers the file to WebCenter Content it generates a content ID
automatically with the following format: UCMFAnnnnnn.

P UWNa

The file includes the following properties:

Field Name Value

Author FUSION_APPS_HCM_ESS_APPID
Security Group FAFusionimportExport

Account hcm$ /extracts$/export$

Note: If there's an explicit reference to the Account in your scripts, ensure that your scripts
are updated to see this dDocAccount.

Title HEXTV1CON_{Integration Name}_{Encryption Type}_{Date Time Stamp}

For example: HEXTV1CON_ExtractConn1_PGPUNSIGNED_17-11-2014 14-16-44
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5. Configure the HCM Extract delivery option to output an XML (data) file directly to WebCenter Content without
formatting it in Bl Publisher. You can achieve this by selecting Data as the output format, omitting a template
name, and selecting the WebCenter Content Delivery Type.

6. Download the encrypted files from WebCenter Content using client command-line tools or a web service call.

Decryption of Outbound Files

Using your private key, you can decrypt encrypted files that are generated from Oracle HCM Cloud. To verify signed
files, you use the Oracle HCM Cloud public key. Ensure that these two keys are imported into the keystore. For both
Microsoft Windows and Linux, use this command to decrypt both signed and unsigned files:

gpg --decrypt <inbound file name> --output <output file name>
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6 HCM Data Loader Extracts

Overview of HCM Data Loader Extracts

HCM Extracts provides four extracts for HCM Data Loader, as shown in this table.

Extract Name Description

HCM Data Loader Data Set Summary Provides status values and record counts for both a specified data set and each business object in the
data set. It reports all error messages and identifies all records affected by each error.

Compensation Changes Extract For a specified compensation run, extracts assignment, salary, and bonus changes made by the run.
This extract is most useful if you're implementing a coexistence scenario.

Integration Object User Key Refresh Retrieves latest user key values. Run this extract before running the Integration Object User Key Map
Extract.
Integration Object User Key Map Extract Extracts GUIDs, source keys, surrogate IDs, and user keys for a specified business object hierarchy.

The output from all extracts is in XML format by default. You can provide a Bl Publisher layout to reformat the output.
You can also define options to automate delivery of the output.

Before users can run any of these extracts, you:

1. Copy the predefined extract, specify a delivery option, and compile the formulas for your copy of the extract.
2. Configure your copy of the extract.
Once the extract is configured, users can run it and view the output.

To learn how to create a HCM Extract delivery option to format your output into a HDL file and define a payroll flow
pattern to initiate the extract and submit HDL, see the tutorial: Initiate HCM Data Loader for HCM Extract Generated
Files

Related Topics
« Manage an HCM Data Loader Extract Definition

« Configure a Copied HCM Data Loader Extract

Setting Up HCM Data Loader Extracts

Manage an HCM Data Loader Extract Definition

HCM Extracts provides four predefined extracts for HCM Data Loader:
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HCM Data Loader Data Set Summary

- Compensation Changes Extract
Integration Object User Key Refresh
Integration Object User Key Map Extract

This topic explains how to copy a predefined extract, specify a delivery option, and compile the formulas for the copied
extract. You can follow these instructions for any of the HCM Data Loader extracts.

Copy the Extract

Follow these steps to copy an HCM Data Loader extract:

In the Data Exchange work area, click Extract Definitions.

On the Extract Definitions page, search for the extract.

Select the extract in the search results and click Actions > Copy or Rename.

In the Copy Extract Definition dialog box, enter a name for your copy of the extract and click OK.
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A confirmation message appears when the copy is complete.

Specify a Delivery Option for the Copied Extract

Follow these steps to specify a delivery option:

On the Extract Definitions page, search for your copy of the extract.

Click the extract name in the search results to display the extract definition on the Extract Definitions page.
Click Deliver.

In the Extract Delivery Options section, click Add.

Specify a delivery option. To keep the default XML output, set the Output Type to Data.

For the XML delivery option, specify Delivery Option Name, Output Name, and Delivery Type values.

CUPAWND

I Tip: The values that you must specify vary by output type.

7. Click Save.

For more information, see Oracle Fusion HCM Extracts: Delivery Options (document ID 1573099.1) on My Oracle Support
at https://support.oracle.com.

Compile the Formulas for the Copied Extract
Follow these steps to compile the formulas:

1. On the Extract Definitions page, click Validate.

2. Inthe Extract Execution Tree section, click Compile All Formula to compile the formulas.

3. Refresh the table periodically until all formulas are successfully compiled. A check mark means success.
4. Click Submit.

Once these steps are complete, perform the Refine Extracts task in the Data Exchange work area to configure the
copied HCM Data Loader extract.

Related Topics
« Overview of HCM Data Loader Extracts

» Configure a Copied HCM Data Loader Extract
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Configure a Copied HCM Data Loader Extract

HCM Extracts provides four predefined extracts for HCM Data Loader:

HCM Data Loader Data Set Summary

- Compensation Changes Extract
Integration Object User Key Refresh
Integration Object User Key Map Extract

This topic explains how to configure an extract after copying it, specifying a delivery option, and compiling its formulas.
Follow these steps:

1. On the Tasks panel tab of the Data Exchange work area, select Refine Extracts to open the Payroll Flow
Patterns page.

2. On the Payroll Flow Patterns page, enter the name of your copy of the extract in the Flow Pattern field and click
Search.

3. Inthe search results, select your extract and click Edit.

4. Click the Parameters tab to review the parameter definitions.

5. Edit the Display, Sequence, Parameter Basis, and Basis Value for each parameter. You can also edit the
parameter names, if required.

6. Save your changes.

Users can now run the extract.

Related Topics
- HCM Data Loader Data Set Summary Extract Parameters

- Compensation Changes Extract Parameters
- Integration Object User Key Refresh and Integration Object User Key Map Extract Parameters

HCM Data Loader Data Set Summary Extract Parameters

This topic describes how to configure the parameters of the HCM Data Loader Data Set Summary extract.

To configure the parameters, you perform the Refine Extracts task in the Data Exchange work area.

Configuring the Parameters

This table shows the parameters that you must edit and the required values for the HCM Data Loader Data Set
Summary extract. You can ignore parameters not shown here.

Parameter Display Sequence Parameter Basis Basis Value
Effective Date No 3 Context Binding System Date
Start Date No 9 Not applicable Not applicable
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Parameter

Content ID

Data Set Name

Process ID

Show Messages

Show Stack Trace

Related Topics

Display

Yes

Yes

Yes

No

No

Sequence

12

13

n

14

15

» Configure a Copied HCM Data Loader Extract

+ Overview of HCM Data Loader Extracts

Parameter Basis

Not applicable

Not applicable

Not applicable

Constant Bind

Constant Bind

Compensation Changes Extract Parameters

Chapter 6
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Basis Value

Not applicable

Not applicable

Not applicable

This topic describes how to configure the parameters of the Compensation Changes Extract for HCM Data Loader.

To configure the parameters, you perform the Refine Extracts task in the Data Exchange work area.

Configuring the Parameters

This table shows the parameters that you must edit and the required values for the Compensation Changes
Extract. You can ignore parameters not shown here.

Parameter

Effective Date

Start Date

Extract Target

Period Name

Plan

Process Id

Run Id

ORACLE

Display

No

No

No

Yes

Yes

Yes

Yes

Sequence

15

12

n

13

14

Parameter Basis

Context Binding

Not applicable

Constant Bind

Not applicable

Not applicable

Not applicable

Not applicable

Basis Value

System Date

Not applicable

HDL

Not applicable

Not applicable

Not applicable

Not applicable
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Parameter Display Sequence Parameter Basis Basis Value
Related Topics

« Configure a Copied HCM Data Loader Extract
« Overview of HCM Data Loader Extracts

Integration Object User Key Refresh and Integration Object User
Key Map Extract Parameters

This topic describes how to configure the parameters of these HCM Data Loader extracts:

- Integration Object User Key Refresh
- Integration Object User Key Map Extract

To configure the parameters, you perform the Refine Extracts task in the Data Exchange work area.

Configuring the Parameters

This table shows the parameters that you must edit and the required values for the Integration Object User Key
Refresh extract.

Parameter Display Sequence Parameter Basis Basis Value
Effective Date Mandatory 3 Context Binding System Date
Start Date No 9 Not applicable Not applicable
Process Configuration Yes 17 Not applicable Not applicable
Group

Business Object Yes 76 Not applicable Not applicable
Component Discriminator ~ Yes 81 Not applicable Not applicable
Include Child Components = Yes 9N Not applicable Not applicable

Note: You're recommended to change the name of the Business Object parameter to Business Object
Discriminator.
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This table shows the parameters that you must edit and the required values for the Integration Object User Key

Map Extract.

Parameter

Effective Date

Start Date

Process Configuration
Group

Business Object

Component Discriminator

Include Child Components

Source System Owner

Baseline Only

Changes Only

Delete Archive

Display

Mandatory

No

Yes

Yes

Yes

Yes

Yes

No

No

No

Sequence

17

22

23

24

25

81

91

101

Parameter Basis

Context Binding

Not applicable

Not applicable

Not applicable

Not applicable

Not applicable

Not applicable

Not applicable

Not applicable

Not applicable

Basis Value

System Date

Not applicable

Not applicable

Not applicable

Not applicable

Not applicable

Not applicable

Not applicable

Not applicable

Not applicable

Note: You're recommended to change the name of the Business Object parameter to Business Object

Discriminator.

Related Topics

« Configure a Copied HCM Data Loader Extract

+ Overview of HCM Data Loader Extracts

Running HCM Data Loader Extracts

Submit an HCM Data Loader Extract

HCM Extracts provides four predefined extracts for HCM Data Loader:

- HCM Data Loader Data Set Summary

ORACLE

104



Oracle Fusion Cloud HCM Chapter 6
HCM Extracts HCM Data Loader Extracts

- Compensation Changes Extract
- Integration Object User Key Refresh
- Integration Object User Key Map Extract

This topic explains how to submit a configured HCM Data Loader extract.

Select the Extract

Follow these steps:

1. On the Tasks panel tab of the Data Exchange work area, select Submit Extracts to open the Submit a Process
or Report page.

2. Using the query by example fields, find your extract and click Next.
The Enter Parameters page opens.

3. Inthe Payroll Flow field, enter a flow name for this run of the extract.

4. Enter the parameter values for your extract.

Enter Parameters for the HCM Data Loader Data Set Summary Extract

This table shows the parameters for the HCM Data Loader Data Set Summary extract. Enter any one of the Content ID,
Process ID, and Data Set Name parameters. You can find all of these values for a specific data set on the Import and
Load Data page.

Parameter Description

Content ID The content ID associated with the data set. This ID was assigned when you uploaded your source file
to the Oracle WebCenter Content server.

Data Set Name The data set name, which is also your source file name.
Process Configuration Group Leave blank.
Process ID The process ID of the process that created the data set. This ID was assigned when you submitted your

source file for processing by HCM Data Loader.

Enter Parameters for the Compensation Changes Extract

This table shows the parameters of the Compensation Changes Extract. To identify the compensation run to report on,
use one of the following parameters or pairs of parameters:

- Plan and Period Name

- Process Id
« Runlid
Parameter Description
Plan The compensation plan name
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Parameter

Period Name

Process Id

RunId
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Description

The period name for the compensation run

The process ID for the compensation run

The run ID for the compensation run

Enter Parameters for the Integration Object User Key Refresh Extract
This table shows the parameters of the Integration Object User Key Refresh Extract.

Parameter

Business Object

Component Discriminator

Include Child Components

Process Configuration Group

Description

The file discriminator of the business object for which you want to refresh keys. For example, for
some or all components of the Worker object, set this parameter to Worker. You can find the file
discriminator values on the Business Object Details page for the object in the Data Exchange work
area.

The file discriminator of the business object component. For example, to refresh keys for the Work
Relationship component of the Worker object, set this parameter to WorkRelationship. You can find
the file discriminator values on the Business Object Details page for the object in the Data Exchange
work area.

Set to Yes to include the child components of the business object or component in the refresh.

Leave blank.

Enter Parameters for the Integration Object User Key Map Extract
This table shows the parameters of the Integration Object User Key Map Extract.

Parameter

Business Object

Component Discriminator

Include Child Components

ORACLE

Description

The file discriminator of the business object for which you want to extract keys. For example, for
some or all components of the Worker object, set this parameter to Worker. You can find the file
discriminator values on the Business Object Details page for the object in the Data Exchange work
area.

The file discriminator of the business object component. For example, to extract keys for the Work
Relationship component of the Worker object, set this parameter to WorkRelationship. You can find
the file discriminator values on the Business Object Details page for the object in the Data Exchange
work area.

Set to Yes to include the child components of the business object or component in the extract.
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Parameter Description

Tip:
If you're extracting a large number of records, then you're recommended to set this parameter to No
and extract each component separately.

Process Configuration Group Leave blank.

Source System Owner If required, select a value to extract the keys for a specified source system owner. The extract includes
all types of keys, but only for those object instances with this source system owner.

Submit the Extract

Follow these steps:

1. Click Next until you reach the Review page.
Click Submit.

A confirmation message appears when your extract is submitted successfully.
3. Close the Confirmation dialog box.

You can now view the extract output.

To learn how to create a HCM Extract delivery option to format your output into a HDL file and define a payroll flow
pattern to initiate the extract and submit HDL, see the tutorial: Initiate HCM Data Loader for HCM Extract Generated
Files

Related Topics
« Overview of HCM Data Loader Extracts

« View the Results of an HCM Data Loader Extract

View the Results of an HCM Data Loader Extract

HCM Extracts provides four predefined extracts for HCM Data Loader:

- HCM Data Loader Data Set Summary

- Compensation Changes Extract

- Integration Object User Key Refresh

- Integration Object User Key Map Extract

This topic explains how to view the output from an HCM Data Loader extract. Follow these steps:

1. Click Navigator > My Client Groups > Data Exchange.
In the Data Exchange work area, click View Extract Results.

3. Onthe View Extract Results page, enter the extract instance name or extract name, submission date range, and
its process status for which you want the results.

4. C(lick Search.
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5. Inthe Search Results section, click the extract instance name link for which you want to view the extract result
details.

6. On the extract details page, click the Extract Delivery Options tab to download the extract results output file.

To learn how to create a HCM Extract delivery option to format your output into a HDL file and define a payroll flow
pattern to initiate the extract and submit HDL, see the tutorial: /nitiate HCM Data Loader for HCM Extract Generated
Files

Related Topics
« Overview of HCM Data Loader Extracts

« Submit an HCM Data Loader Extract
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7 Benefits Data Extract

Guidelines for Extracting Benefits Data Using HCM

Extracts

Consider these key guidelines before you extract benefits data.

Aspect

Extract type

Option Type

Extract Plan Type Names

Extract Option Names

Benefits Extract Plan Code

Lookup value mapping

Extracts data for terminated employees

Contacts (dependents)

Participant or dependent address

Data Groups

ORACLE

Details

When you create an extract definition, ensure that you select Benefits Carrier from the Extract Type
list.

You select the option type on the Manage Plan Types page. Make sure that the option type of the plan
type that you're using to create an extract definition is one of these types.

« Health Coverage
- Spending Account
- Life Insurance Coverage

Other types aren't supported at this time.

You need to enter the name of the extract plan type correctly when you create or edit the plan type.
See the related links section in this topic for a full list of valid extract names.

You need to enter the extract option name correctly when you create or edit the option. See the related
links section in this topic for a full list of valid extract names.

You need to enter the correct plan code on the Additional Configuration step when you create or edit a
plan. The plan code is an identification code provided by the carrier, such as UHCORCLOO1.

Make sure that you map the required lookup values accurately in the Mapping tab on the Manage Plan
Carriers page.

The data for terminated participants and their dependents won't be included in the extracts after the
extract process runs for the second time after the employee's termination date.

You need to map the contact lookup accurately. For example, if you need to include the contact's
marital status in the extract, the mapping value should be True, and shouldn't have a NULL value.

Ensure that addresses are categorized accurately. For example, if there is no address that's marked as
Home, or if there are several addresses that are marked as Home, the addresses won't be included in
the extract.

Create a PER_EXT_SEC_PERSON_UE (Person) data group and select it as the root data group. The
following benefits data groups are available:
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Aspect Details

BEN_EXT_ENRT_RSLT_UE (Enrollment Results)
BEN_EXT_ENRT_DPNT_UE (Dependents)
BEN_EXT_ENRT_BNF_UE (Beneficiaries)
BEN_EXT_ENRT_RTCVG_UE (Rates and Coverage)

Sequence of extract records After you create the data groups, ensure that you sequence the data groups to identify which data
group the application processes next:

Person
Dependents
Beneficiaries
Enroliments

Rates and coverage

Related Topics
« Valid Extract Names

« Define Extracts

Configure Benefits for Extracting Data

This topic covers how to set up benefit plan carriers and offerings so that you can then generate and transmit
enrollment data extracts. You extract benefits enrollment information into a single XML file for each benefits carrier.

To configure the benefits data extract, you complete these tasks in the Plan Configuration work area:

1. Create the plan carrier and configure extract settings.
2. Add the benefits extract plan type name.

3. Add the benefits extract plan code.

4. Add the benefits extract option name.

Creating Plan Carrier

Set up carrier data and configure extract options in the Plan Configuration work area that apply whenever you run the
extract for that carrier.

1. In the Tasks panel drawer, click Manage Plan Carriers to open the Manage Plan Carriers page. On the Mapping
tab, you can view the mapping of lookup codes to the lookup value that you transmit to carriers. Edits to
mapping values affect all plan carriers that use the lookup.

2. On the Search Results toolbar, click the Create button.

3. Enter the carrier information. In the Active field, select Active.

4. Enter the extract options.

The following table provides comments to help you with your extract field entries and selections.
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Field

Extract Type

Output File Name

Processing Frequency

Processing Type

Upload Custom Layout

Chapter 7
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Comments

Select whether to run a full extract or extract only the changes since the previous extract.

Generally, you run a full extract after an enroliment period closes and enrollments are
completed. You run subsequent extracts on a periodic or scheduled basis, in either full or
changes only mode.

Obtain the value that you enter here from the extract file recipient.

A common practice is to schedule your extracts to run after your regular payroll runs. You might
want to set the processing frequency accordingly.

By default, all extracts have the same format, regardless of which carrier receives the

extract. You can contract with Oracle's partner, BenefitsXML, to have a carrier's extract data
transformed and delivered to the carrier, according to its specifications. For more information
about BenefitsXML, see http://www.benefitsxml.com.

If you don't use this partner, you can transform and deliver the extract data file directly to each
of your plan carriers, according to their specifications.

This button is available if you select the Custom layout processing type.

o Specify the layout for the individual carrier. For details, see the Benefits Extract: User-
Defined Layout topic

5. Enter the file transfer details, which you obtained from the extract file recipient. You can transmit extract files
directly to the recipient. Alternatively, you can transmit extract files to the Oracle cloud, using its file transfer
details, and have your recipient download its extract from there.

Field

Host

Remote Folder

User Name

Password

Comments

The name of the server to which you transmit the recipient's extract files.

Path on the host to the location where your transmission places the extract file.

Part of the sign-in credentials required for your transmission to access the host.

Part of the sign-in credentials required for your transmission to access the host.

6. Click Save and Close to return to the Manage Plan Carriers page.
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Adding Benefits Extract Plan Type Name

Complete these steps in the Plan Configuration work area to identify each type of plan included in the extract file for the
recipient.

In the Tasks panel drawer, click Manage Plan Types to open the Manage Plan Types page.
Search for and click the plan type, for example, Medical.
On the Plan Type Definition section Actions menu, select Update.
Enter the valid benefits extract plan type name, for example, Health.
5. Click Save and Close to return to the Manage Plan Types page.
See the guidelines topic for more info on the valid option types to use for the plan type that you want to include in the
extract.

P UWNa

Adding Benefits Extract Plan Code

Complete these steps in the Plan Configuration work area to link the plan to the extract file recipient.

In the Tasks panel drawer, click Manage Benefits Plan Details to open the Manage Benefits Plan Details page.
Search for and click the plan that you want to link to the extract file recipient.

Click Next to open the Edit Plan Additional Configuration page.

On the Configuration Details section Actions menu, select Update.

Enter the benefits extract plan code, which the extract file recipient provided to you for this specific plan.

Click Save and Close to return to the Plans tab.

cuhlhunNA

Adding Benefits Extract Option Name

Complete these steps in the Plan Configuration work area to identify each option included in the extract file for the
recipient.

In the Tasks panel drawer, click Manage Benefit Options to open the Manage Benefit Options page.
Search for and click the participant option, for example, Participant Only.

On the Basic Details section Actions menu, select Update.

Enter the valid benefits extract option name, for example, Employee Only.

Click Save and Close to return to the Manage Benefit Options page.

A WN

Next Steps

After you complete the previous tasks, you're ready to generate and transmit the extract data. The details of this
process are covered in the Generating and Transmitting Benefits Data Extract for Plan Carriers: Procedure topic.

Related Topics
« Valid Extract Names

« Generate and Transmit Benefit Extracts
 Guidelines for Extracting Benefits Data Using HCM Extracts
» Example of a Custom Layout for Benefits Extract

12
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Valid Extract Names

Chapter 7
Benefits Data Extract

Oracle partner BenefiX provides valid extract names that you can enter for benefits plan types and options. You can add

values to this list, as required.

Benefit Extract Plan Type Names

Valid benefits extract names for plan types:

« 24 Care
Dental
Dental Capitation
Exclusive Provider Organization
Health
Health Maintenance Organization
Hearing
Long Term Care
Long Term Disability
Mail Order Drug
Major Medical
Medicare Risk
Mental Health
Point of Service
Preferred Provider Organization
Prescription Drug
Preventative Care
« Short Term Disability
- Utilization Review
- Vision

Benefits Extract Option Names

Valid benefits extract names for options

« Children Only
Dependents Only

- Employee and Children
Employee and Five or More Dependents
Employee and Four or More Dependents
Employee and One Dependent

ORACLE
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Employee and One or More Dependents
Employee and Spouse
Employee and Three Dependents
Employee and Three or More Dependents
Employee and Two Dependents
Employee and Two or More Dependents
Employee Only
Family
Individual
Not Applicable
« Spouse and Children
- Spouse Only
« Two Party
Employee and Domestic Partner
Domestic Partner and Children
Domestic Partner Only
Employee and Spouse or Domestic Partner
- Child or Children of a Domestic Partner

Generate and Transmit Benefit Extracts

You can extract benefits enrollment information into a single XML file for each benefits carrier and transmit it to the
carrier. This topic covers how to generate and transmit the extract file.

Note: If a carrier provides more than one plan, the single extract contains information related to all plans provided by
that carrier. Example: Four different carriers provide ten plans. You run four separate extracts, one for each carrier.

To generate and view the extract, you complete these tasks in the Evaluation and Reporting work area.

1. Submit the extract request.
2. View and transmit the extract details.

Prerequisites

You must first configure your plan carriers, or extract recipients, and add the relevant extract data to the appropriate
plan types, plans, and options. The details of this process are covered in the Configuring Benefits Data Extract for Plan
Carriers: Procedure topic.

Submitting Extract Request

To run and monitor extracts, in the Evaluation and Reporting work area:
1. Inthe Tasks panel drawer, click Extract Benefits Data to open the Extract Benefits Data page.
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2. On the Search Results toolbar, click Submit.
3. Enter the extract request options.

Field Comments

Extract Type For a particular carrier, you can select whether to run a full extract or extract only the changes
since you ran the previous extract.

o Generally, you run a full extract after an enrollment period closes and enroliments are
completed.

o You run subsequent extracts on a periodic or scheduled basis, in either full or changes
only mode. Common practice is to schedule your extracts to run after your regular payroll
runs.

Transmit You can transmit the extract as part of the extract request, or after the requested extract
completes and before or after you view the extract details.

4. C(Click Submit to submit your process and return to the Extract Benefits Data page.

Viewing and Transmitting Extract Details

You can view, query, and download extracted records for a specific extract run after it completes. You can also transmit
the extract after the requested extract completes and before or after you view the extract details.

1. Inthe Search Results section of the Extract Benefits Data page, click the Request ID for the most recent extract
request for the plan carrier.

2. Review, query by example, and download to a spreadsheet the extracted data, as appropriate.

3. Click Done to return to the Extract Benefits Data page.

4. Inthe Search Results section, click the Transmit icon button for the most recent extract request.

Related Topics
« Configure Benefits for Extracting Data

Example of a Custom Layout for Benefits Extract

An implementor or developer can create a custom layout to transform the format of extracted benefits enroliment data
to match the specifications of a particular carrier.

This topic provides:
- Descriptions of the tags that you require to create the custom layout

- Table aliases and a sample custom layout

The custom layout becomes the default layout for the plan carrier after you upload it to the plan carrier's extract
options.

The following code shows the structure of the XML tags in the custom layout.

<Layout
<Table

15
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Record Type
<Field
Name
Source
Width
Padding
Field>
Table>
<Table
<Field
Name
Source
Width
Padding
Field>

Table>
<Table

Table>
Layout>

The data source for a field on the custom layout can be a:

- Column on the benefits extract staging tables
- Column on one of the other tables listed in the Source tag description
- Constant into which you enter the exact value

Tip: To identify table column names, you can use the data model query builder in Oracle Bl Publisher. Search for the
table name and view the columns.

XML Tag Descriptions

This section describes each XML tag and lists its attributes, elements (subtags), and parent tags.

Layout

Description: Root tag.

Attributes: None

Elements (Subtags) Parent Tag

Table None

Table

Description: Specifies the database table from which to extract the data.

Attributes: 1. tableName: Supported values = {BEN_EXTRACT_REQ_DETAILS,BEN_EXTRACT_REQUEST,
DUAL,PER_ALL_PEOPLE_F,PER_PERSONS,PER_ALL_ASSIGNMENTS_M,PER_PEOPLE_LEGISLATIVE_F,BEN_PL_F,BEN_PL_TYP_I

16
ORACLE



Chapter 7

Oracle Fusion Cloud HCM
HCM Extracts Benefits Data Extract

Elements (Subtags) Parent Tag

1. RecordType Layout

2. Field: See Field tag description

Record Type

Description: Specifies how to delimit or lay out the data in the extract file.

Attributes: Supported values: FIXEDWIDTH, CSV

Note: Anything other than CSV is delimited as FIXEDWIDTH by default.

Elements (Subtags) Parent Tag

None Table

Field

Description: Corresponds to one column in the extracted document. Source the text in this column from a database
table, an SQL function, or a constant.

Attributes: None

Elements (Subtags) Parent Tag

Name Table
Source

Width

Padding

PUWNA

Name
Description: Name of the field

Attributes: None

Elements (Subtags) Parent Tag

None Field

17
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Source
Description: Specifies the source of data for the current field.

If the source is a table, the value passed is the column name.
If multiple tables are involved, use a fully qualified column name.

The list of allowed tables includes the table aliases.

SQL functions in place of column names: Values in this tag are treated as column names if the type is set to TABLE. The
column name is used directly while constructing a query, so an SQL function can be used on a column.

Example 1

<Source type="TABLE">GENDER FLAG</Source>

Example 2

<Source type="TABLE'">DECODE (GENDER_FLAG, 'F',1,2) </Source>

Attributes:

1. type:
o Supported values = {TABLE, CONSTANT}

- TABLE specifies that the data comes from a database table.
- CONSTANT specifies that the data is given in the value column of this tag.
2. table: Use this tag only if the intended column isn't from the table given in the tableName attribute of this Table
tag. If this tag isn't used, the column is searched for in the table given in tableName.
o Supported values:
- {BEN_EXTRACT_REQ_DETAILS
- PER_ALL_PEOPLE_F
- PER_PERSONS
- PER_ALL_ASSIGNMENTS_M
- PER_PEOPLE_LEGISLATIVE_F

- BEN_PL_F

- BEN_PL_TYP_F

- BEN_OPT_F

- BEN_PGM_F
Elements (Subtags) Parent Tag
None Field

Width

Description: Specifies the intended width of this field in the extract file. The number passed is the number of character
spaces on the file.
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Attributes: Supported values are positive integers.

Elements (Subtags)

None

Padding

Description: Specifies the alignment of data in each column.

Parent Tag

Field

Attributes: Supported values: {LEFT, RIGHT}

Elements (Subtags)

None

Table Aliases

Allowed Table

BEN_EXTRACT_REQ_DETAILS
PER_ALL_PEOPLE_F
PER_PERSONS
PER_ALL_ASSIGNMENTS_M
PER_PEOPLE_LEGISLATIVE_F
BEN_PL_F

BEN_PL_TYP_F

BEN_OPT_F

BEN_PGM_F

Sample XML Layout

Parent Tag

Field

Alias

REQ

PEO

PER

ASG

LEG

PLN

TYP

OPT

PGM

<?xml version="1.0" encoding="utf-8"?>

<Layout>

<Table tableName="DUAL">

ORACLE
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<RecordType>FIXEDWIDTH</RecordType>
<Field>

<Name>"Record Type'"</Name>

<Source type="CONSTANT">001</Source>
<Width>3</Width>

<Padding>Left</Padding>

</Field>

</Table>
<Table tableName="BEN_EXTRACT REQ DETAILS">
<RecordType>CSV</RecordType>

<Field>

<Name>"Last Name'"</Name>

<Source type="TABLE">LAST NAME</Source>
<Width>25</Width>

<Padding>Left</Padding>

</Field>

<Field>

<Name>"First Name'</Name>

<Source type="TABLE">FIRST_NAME</Source>
<Width>50</Width>

<Padding>Left</Padding>

</Field>

<Field>

<Name>"Filler"</Name>

<Source type="CONSTANT">XXXXXXXXXX</Source>
<Width>10</Width>

<Padding>None</Padding>

</Field>

<Field>

<Name>"Plan Name'"</Name>

<Source type="TABLE">PLAN</Source>
<Width>70</Width>

<Padding>Left</Padding>

</Field>

<Field>

<Name>"Coverage Start Date"</Name>

<Source type="TABLE">COVERAGE_START_DATE</Source>
<Width>15</Width>

<Padding>Left</Padding>

</Field>

<Field>

<Name>"SSN"</Name>

<Source type="TABLE">NATIONAL_IDENTIFIER</Source>
<Width>12</Width>

<Padding>Left</Padding>

</Field>

<Field>

<Name>"Gender"</Name>

<Source type="TABLE">DECODE (GENDER FLAG,'F',61,2)</Source>
<Width>1</Width>

<Padding>Left</Padding>

</Field>

<Field>

<Name>"Person Number'"</Name>

<Source type="TABLE" table="PER_ALL_PEOPLE_F">PERSON_NUMBER</Source>
<Width>30</Width>

<Padding>Left</Padding>

</Field>

<Field>

<Name>"Country of Birth"</Name>

<Source type="TABLE" table="PER_PERSONS">COUNTRY_OF_BIRTH</Source>
<Width>30</Width>

<Padding>Left</Padding>

</Field>

<Field>

<Name>"Assignment type"</Name>
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<Source type="TABLE" table="per all assignments_m">assignment_type</Source>
<Width>30</Width>

<Padding>Left</Padding>

</Field>

<Field>

<Name>"Legislation code"</Name>

<Source type="TABLE" table="per people legislative f">LEG.LEGISLATION CODE</Source>
<Width>30</Width>

<Padding>Left</Padding>

</Field>

<Field>

<Name>"Legislation code"</Name>

<Source type="TABLE" table="ben pl f">PLN.PL ID</Source>
<Width>30</Width>

<Padding>Left</Padding>

</Field>

</Table>
<Table tableName="DUAL">
<RecordType>FIXEDWIDTH</RecordType>
<Field>

<Name>"Record Type'"</Name>

<Source type="CONSTANT">999</Source>
<Width>3</Width>

<Padding>Left</Padding>

</Field>

<Field>

<Name>"Record Type'"</Name>

<Source type="SYSTEM">RECORDCOUNT</Source>
<Width>3</Width>

<Padding>Left</Padding>

</Field>

</Table>
</Layout>
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8 Salary Extracts

User Entities for Extracting Rate-Based Salary
Components

You can extract rates-based component details on a particular date or for a particular date range
for payroll processing and interfacing with tools such as HCM Extracts. The user entities to use are
ORA_CMP_ASSIGNMENT_SALARY_RATES_UE and ORA_CMP_ASSIGNMENT_SALARY_RATES_RGE_UE.

To get the rate amount for a specific assignment base rate, use the GET_SALARY_RATE_DATA function.

ORA_CMP_ASSIGNMENT_SALARY_RATES_UE

Use the Assignment Salary Rates Data user entity to extract this information on a particular date:

- Assignment Salary Rate Salary Identifier

- Assignment Salary Rate Assignment Identifier

- Assignment Salary Rate Salary Date From

- Assignment Salary Rate Salary Date To

- Assignment Salary Rate Base Name

- Assignment Salary Rate Factor

- Assignment Salary Rate Amount

- Assignment Salary Rate Annual Amount

- Assignment Salary Rate Annual Full-time Amount
- Assignment Salary Rate Frequency Code

- Assignment Salary Rate Currency Code

- Assignment Salary Rate Overall Salary Indicator

- Assignment Salary Rate Full-time Indicator

- Assignment Salary Rate Pay Component Identifier
- Assignment Salary Rate Salary Basis Identifier

- Assignment Salary Rate Display Sequence

- Assignment Salary Rate Base Salary Indicator

- Assignment Salary Rate Definition Identifier

ORA_CMP_ASSIGNMENT_SALARY_RATES_RGE_UE

Use the Assignment Salary Rates Data user entity to extract this information for a date range:

- Assignment Salary Rate Salary Identifier Array
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- Assignment Salary Rate Assignment Identifier Array

- Assignment Salary Rate Salary Date From Array

- Assignment Salary Rate Salary Date To Array

- Assignment Salary Rate Base Name Array

- Assignment Salary Rate Factor Array

- Assignment Salary Rate Amount Array

- Assignment Salary Rate Annual Amount Array

- Assignment Salary Rate Annual Full-time Amount Array
- Assignment Salary Rate Frequency Code Array

- Assignment Salary Rate Currency Code Array

- Assignment Salary Rate Overall Salary Indicator Array

- Assignment Salary Rate Full-time Indicator Array

- Assignment Salary Rate Pay Component Identifier Array
- Assignment Salary Rate Salary Basis Identifier Array

- Assignment Salary Rate Display Sequence Array

- Assignment Salary Rate Base Salary Indicator Array

- Assignment Salary Rate Definition Identifier Array

Related Topics
« Extract Components

» Get the Rate Amount for an Assignment Base Rate
 Define Extracts

User Entities for Extracting Simple Salary Components

You can extract simple component details on a particular date or for a particular date
range for payroll processing and interfacing, with tools such as HCM Extracts. The user
entities to use are ORA_CMP_ASSIGNMENT_SALARY_SIMPLE_COMPONENT_UE and
ORA_CMP_ASSIGNMENT_SALARY_SIMPLE_COMPONENT_RGE_UE.

ORA_CMP_ASSIGNMENT_SALARY_SIMPLE_COMPONENT_UE

Use the Assignment Salary Simple Components Data user entity to extract this information on a particular date:

- Assignment Salary Simple Component Salary Identifier

- Assignment Salary Simple Component Assignment Identifier
- Assignment Salary Simple Component Start Date

- Assignment Salary Simple Component End Date

- Assignment Salary Simple Component Basis Identifier
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- Assignment Salary Simple Component Identifier

- Assignment Salary Simple Component Display Sequence

- Assignment Salary Simple Component Processing Sequence

- Assignment Salary Simple Component Type

- Assignment Salary Simple Component Type Meaning

- Assignment Salary Simple Component Code

« Assignment Salary Simple Component Meaning

- Assignment Salary Simple Component Based on Component Code
- Assignment Salary Simple Component Based on Component Meaning
- Assignment Salary Simple Component Amount

- Assignment Salary Simple Component Annual Amount

- Assignment Salary Simple Component Annual Full-time Amount

- Assignment Salary Simple Component Percentage

- Assignment Salary Simple Component Adjustment Amount

- Assignment Salary Simple Component Adjustment Percent

- Assignment Salary Simple Component Default Value

- Assignment Salary Simple Component Overall Salary Impact

- Assignment Salary Simple Component User Selected Component

ORA_CMP_ASSIGNMENT_SALARY_SIMPLE_COMPONENT_RGE_UE

Use the Assignment Salary Simple Components Data user entity to extract this information for a date range:

- Assignment Salary Simple Component Salary Identifier Array

- Assignment Salary Simple Component Assignment Identifier Array

- Assignment Salary Simple Component Start Date Array

- Assignment Salary Simple Component End Date Array

- Assignment Salary Simple Component Basis Identifier Array

- Assignment Salary Simple Component Identifier Array

- Assignment Salary Simple Component Display Sequence Array

- Assignment Salary Simple Component Processing Sequence Array

- Assignment Salary Simple Component Type Array

- Assignment Salary Simple Component Type Meaning Array

- Assignment Salary Simple Component Code Array

- Assignment Salary Simple Component Meaning Array

- Assignment Salary Simple Component Based on Component Code Array
- Assignment Salary Simple Component Based on Component Meaning Array

- Assignment Salary Simple Component Amount Array
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- Assignment Salary Simple Component Annual Amount Array

- Assignment Salary Simple Component Annual Full-time Amount Array
- Assignment Salary Simple Component Percentage Array

- Assignment Salary Simple Component Adjustment Amount Array

- Assignment Salary Simple Component Adjustment Percent Array

- Assignment Salary Simple Component Default Value Array

- Assignment Salary Simple Component Overall Salary Impact Array

- Assignment Salary Simple Component User Selected Component Array
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9 Talent Review and Succession Management
Data Extract

Guidelines for Extracting Talent Review Data Using HCM
Extracts

You can use HCM Extracts to extract Talent Review data.

Here's the data that you can extract with a few examples of the attributes that you can extract for each:
- Meeting details: Meeting ID, meeting dashboard template ID, meeting date
- Facilitators' details: Facilitator ID, facilitator person number, facilitator creation date
- Participants' details: Participant ID, participant business group ID, participant person number
- Talent pools' details: Talent pool ID, talent pool meeting ID, talent pool creation date

- Prior rating details: Prior rating date range ID, prior rating date range meeting ID, prior rating date range
creation date

- Details of the person reviewed: Person ID, meeting ID, person number
- Review content details: Review content ID, review content meeting ID, review competencies
- Succession plans' details: Succession Plan ID, succession plan meeting ID, succession plan creation date

In this topic, we discuss only the information that you need for extracting Talent Review data. For more information
about creating an extract definition and publishing the extract results, see the related topics.

Create Talent Review Extract Definition

To create an extract definition, you must determine these details:

- The user entity details to create data groups
- The database item group details to create attributes
- The extract definition type

You create an extract definition using the Manage Extract Definitions task in the Data Exchange work area.

This table lists the Talent Review related user entities and the starting characters of the database items that correspond
to these user entities. You can search the Talent Review related database items using these characters.

Talent Review Data to Extract User Entity Database Items Start With
Meeting details HRR_EXT_MEETINGS HRR_MEETINGS_
Meeting facilitators HRR_EXT_MEETING_FACILITATORS HRR_MEETING_FACILITATORS_
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Talent Review Data to Extract User Entity Database Items Start With
Meeting participants HRR_EXT_MEETING_PARTICIPANTS HRR_MEETING_PARTICIPANTS_
Associated talent pools HRR_EXT_MEETING_TALENTPOOLS HRR_MEETING_TALENTPOOLS_
Meeting prior rating date ranges HRR_EXT_PRIOR_RATING_DATE_RANGES HRR_PRIOR_RATING_DATE_RANGES_
Meeting review population HRR_EXT_MEETING_REVIEWEES HRR_MEETING_REVIEWEES _
Meeting review content HRR_EXT_MEETING_REVW_CONTENT HRR_MEETING_REVW_CONTENT_
Associated succession plans HRR_EXT_MEETING_SUCCPLANS HRR_MEETING_SUCCPLANS_

While creating the Talent Review extract definition, select the extract definition type as HR Archive.

With the information in this topic, you're now ready to extract Talent Review data.

Related Topics
- HCM Extract Types

- Filter Extracts Using Advanced Filter Criteria

« Extract Components

 Define Extracts

« Define the Bl Publisher Template in HCM Extracts

Guidelines for Extracting Succession Management Data
Using HCM Extracts

You can use HCM Extracts to extract Succession Management data.

Here's the Succession Management data that you can extract with a few examples of the attributes that you can extract
for each:

- Plan details: Plan type, status, incumbent ID, alert information

- Internal candidate details: Candidate person number, status, readiness value

- External candidate details: First name, last name, employer name, current job title, email address
- Owner details: Owner person number, meaning of the owner type code

In this topic, we discuss only the information that you need for extracting Succession Management data. For more
information about creating an extract definition and publishing the extract results, see the related topics.

128
ORACLE



Oracle Fusion Cloud HCM Chapter 9
HCM Extracts Talent Review and Succession Management Data Extract

Create Succession Management Extract Definition

To create an extract definition, you must determine these details:

- The user entity details to create data groups
- The database item group details to create attributes
- The extract definition type
You create an extract definition using the Manage Extract Definitions task in the Data Exchange work area.

This table lists the Succession Management related user entities and the starting characters of the database items that
correspond to these user entities. You can search the related database items using these characters.

Succession Management Data to Extract User Entity Database Items Start With

Plan details HRM_EXT_PLANS_UE HRM_PLANS_

Plan internal candidates HRM_EXT_PLAN_CANDIDATES_UE HRM_PLAN_CANDIDATES_

Plan external candidates HRM_EXT_EXTERNAL_CANDIDATES_UE HRM_PLAN_EXTERNAL_CANDIDATE_
Plan owners HRM_EXT_PLAN_OWNERS_UE HRM_PLAN_OWNERS_

While creating the Succession Management extract definition, select the extract definition type as HR Archive.

With the information in this topic, you're now ready to extract Succession Management data.

Related Topics
- HCM Extract Types

- Filter Extracts Using Advanced Filter Criteria

« Extract Components

- Define Extracts

 Define the Bl Publisher Template in HCM Extracts
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10 Time Repository Data Extracts

Overview of HCM Extracts for Time and Labor and
Scheduling

You can extract time card data from the WFM time repository to load in third-party scheduling and payroll applications.
Here's just some data you can extract:

- Schedule and person information

Dates

- Assignment entries that exist in the time repository

Hidden derived values, such as primary assignment ID or project unit

- Time entry information

Delivered and custom time attributes

For example, you want to transfer approved time data or unapproved but appropriately prepared time entries to a third-
party payroll application. Here's what you can do:

1.

Extract the appropriate data for payroll processing using either the Time Cards Ready To Transfer Extracts

or Time Entries Ready To Transfer Extracts extract. Or you can create your own extracts with the delivered
HWM_EXT user entities and database items. Either way, use the My Client Groups > Data Exchange > Manage
Extract Definitions task and the HR Archive extract type.

Load the extracted data in your third-party payroll app.

For each transferred time entry, send the updated status to Time and Labor from the external payroll app using
the statusChangeRequests REST service.

Update the statuses in the time repository by running the Update Extracted Time Cards from Ready to
Transfer to Transferred process.

131

ORACLE


https://docs.oracle.com/en/cloud/saas/human-resources/25a/farws/api-status-change-requests.html

Oracle Fusion Cloud HCM
HCM Extracts

Prepare
Unapproved
Tirme Entries

Tirne Cards Ready To Transfer
Tirne Entries Ready To Transfer

Llser Entities

HWM_EXT TIMEENTEY ATTRE
HWM EXT TIMEEWNTREY PREVIOUS XFR

¥

- 0
o REST Status
and
I 1
File Customn Update Process

Extracts Extracts

I
"
Third-Party
Payroll
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To extract time repository data, you can use these delivered extracts.

« Published Schedule Extract
- Time and Payroll Info for Reconciliation
- Time Cards Ready To Transfer Extracts

- Time Entries Ready To Transfer Extracts

Chapter 10
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You can also copy the existing extract that's closest to what you need and adjust the copy as appropriate. Or you can

create your own extract using the delivered HWM_EXT user entities and database items.
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Related Topics
- Extract Components

« Define Extracts
« Update Extracted Time Cards from Ready to Transfer to Transferred Process

Data Groups and Records for the Time Repository

The time repository stores reported and calculated time at various levels of time card details. To keep the relationship
among the time card data you're extracting, you configure the data group hierarchy, as modeled here.

Level 1 Time card header
Level 2 — Time card header atribute
— Time card day

Level 3 Time card day atiribute

Time card entry

Level 4 Time card entry atiribute
Level Details Description User Entities
1 Time card header A group of hours for a person over .« HWM_EXT_CALCULATED_
the time card period TIMECARD_HDR_UEHWM_
EXT_REPORTED_TIMECARD_
HDR_UE
2 Time card header attribute Additional information that applies « HWM_EXT_CALCULATED_
to the entire time card period, such TIMECARD_ATTRIBUTE_
as a comment explaining why the HDR_UEHWM_EXT_
person submitted their time card REPORTED_TIMECARD_
late. ATTRIBUTE_HDR_UE
2 Time card day A 24-hour period of the time « HWM_EXT_CALCULATED_
card, such as Monday, Tuesday, or TIMECARD_DAY_UEHWM_
Wednesday EXT_REPORTED_TIMECARD_
DAY_UE
3 Time card day attribute Additional information that applies - HWM_EXT_CALCULATED_
to a 24-hour period of the time TIMECARD_ATTRIBUTE_DAY_
card, such as a comment applicable UEHWM_EXT_REPORTED_
to all hours for Monday
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Level Details Description User Entities

TIMECARD_ATTRIBUTE_DAY_

UE
3 Time card entry A range of time defined by start « HWM_EXT_CALCULATED_
and stop times or a time duration TIMECARD_DETAIL_UE

on the time card
HWM_EXT_REPORTED_

TIMECARD_DETAIL_UE

4 Time card entry attribute Additional information that applies - HWM_EXT_CALCULATED_
to a time entry, such as the project TIMECARD_ATTRIBUTE_
name, payroll time type, and DETAIL_UEHWM_EXT_
department REPORTED_TIMECARD_

ATTRIBUTE_DETAIL_UE

The time repository has other user entities that're independent of these hierarchy levels. To find all time user entity and
database items, search for names that start HWM_EXT.

Extract Refinement
To create filter conditions that refine the extract contents, you can use available database items. Here are some

examples:
- Status values, such as time card status, approval status, or transfer status
- Time consumer, such as project costing or payroll
- Selected time attribute values, including custom time attributes
- Calculated time, reported time, or both types of time entries
- Person name or assignment

- HR attributes that you can use to identify the person or assignment values, such as Department, Job, Position,
and Manager. For example, all people with Job = X

- Date and date ranges, for example, the effective date minus start date of the time card is less than 90 days

Related Topics
« Extract Components

« Define Extracts

Published Schedule Extract

To extract published WFM schedules, you can use the Published Schedule Extract extract, which has these parameters:
« Assignment Number
- Effective Date
« Person Number
- Start Date
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It also includes this two-level group hierarchy.

Level Object Name Description User Entity

1 HWM Assignment The extract block that holds the HWM_EXT_PERSON_
assignment records. ASSIGNMENT_UE

2 HWM Published Schedule Extract all the published schedule HWM_EXT_PUBLISHED_
shifts, for a given period and SCHEDULE_ALL_UE

a given person or assignment,
including those shifts that overlap
an absence.

Time Entries Ready To Transfer Extracts

To extract unapproved but appropriately prepared time entry data for transfer to a third-party payroll application, you
can use the Time Entries Ready To Transfer Extracts extract. The extract includes these parameters:

- Assignment Number
- Consumer

- Effective Date

« From Approval Date
- LDG or Business Unit
« Person Number

- Start Date

It also includes this two-level group hierarchy:

Level Object Name Description User Entity

1 Time Entry Ready To Transfer A range of time defined by start HWM_EXT_TIMEENTRY_XFR_UE
and stop times or a time duration
on the time card

2 Time Entry Attributes Additional information that applies HWM_EXT_TIMEENTRY_ATTRB_
to a time entry, such as the project = UE
name, payroll time type, and
department

Extract Transferred Entries with Adjustments

To include previously transferred time entries that got adjusted later, you can copy and adjust this extract. Here's an
example of how you can add the code to the copied extract definition:

--------------- HWM_EXT TIMEENTRY PREV_XFR UE (new UE - previous time entry transferred)
———————————————————— HWM_EXT TIMEENTRY ATTRB UE (existing UE - current attributes)

You can link the HWM_EXT_TIMEENTRY_PREV_XFR_UE user entity to the existing HWM_EXT_TIMEENTRY_PREV_XFR
user entity by Time Record Group Id, Version, and Time Consumer.
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These user entities include the database item (DBI) that identifies the time consumer:

« HWM_EXT_TIMEENTRY_XFR_TCSMR_CODE
« HWM_EXT_TIMEENTRY_PREV_XFR_TCSMR_CODE

The extract uses the DBI to link a group hierarchy level to the next lower level (n and n-1). The DBI also filters the levels
for the same time consumer code.

Submit Extract Instance Process

You don't have to select a consumer if your extract definition includes the user entities with the time consumer DBI.

- If you leave the Consumer field blank, the process extracts time entry data for all time consumers.

- If you select a time consumer, the process extracts data associated with only that time consumer.

Time Cards Ready To Transfer Extracts

To extract approved time card data for transfer to a third-party payroll application, you can use the Time Cards Ready To
Transfer Extracts extract. The extract includes these parameters:

- Assignment Number
» Consumer

- Effective Date

- From Approval Date
- LDG or Business Unit
- Person Number

- Start Date

It also includes this three-level group hierarchy:

Level Object Name Description User Entity

1 Time Card Ready To Transfer A group of hours for a person over  HWM_EXT_TIMECARD_XFR_UE
the time card period

2 Calculated Time Card A group of hours calculated from HWM_EXT_TIMECARD_ENTRY_
reported time, for a person over XFR_UE

the time card period

3 Time Entry Attributes Additional information that applies HWM_EXT_TIMEENTRY_ATTRB_
to the calculated time entry, such UE
as the project name, payroll time
type, and department

Extract Transferred Entries with Adjustments

To include previously transferred time card and entries that got adjusted later, you can copy and adjust this extract.
Here's an example of how you can add the code to the copied extract definition:
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——————————————— HWM_EXT TIMEENTRY PREV_XFR UE (new UE - previous time entry transferred)

———————————————————— HWM_EXT TIMEENTRY ATTRB UE (existing UE - current attributes)

You can link the HWM_EXT_TIMEENTRY_PREV_XFR_UE user entity to the existing HWM_EXT_TIMECARD_ENTRY_XFR
or HWM_EXT_TIMEENTRY_PREV_XFR user entity by Time Record Group Id, Version, and Time Consumer.

These user entities include the database item (DBI) that identifies the time consumer:

HWM_EXT_TIMECARD_XFR_TCSMR_CODE
HWM_EXT_TIMECARD_ENTRY_XFR_TCSMR_CODE
HWM_EXT_TIMEENTRY_XFR_TCSMR_CODE
HWM_EXT_TIMEENTRY_PREV_XFR_TCSMR_CODE

The extract uses the DBI to link a group hierarchy level to the next lower level (n and n-1). The DBI also filters the levels
for the same time consumer code.

Submit Extract Instance Process

You don't have to select a consumer if your extract definition includes the user entities with the time consumer DBI.

If you leave the Consumer field blank, the process extracts time entry data for all time consumers.

If you select a time consumer, the process extracts data associated with only that time consumer.

Time and Payroll Info for Reconciliation

To reconcile worked time with paid time, you can use the Time and Payroll Info for Reconciliation extract.

The generated file data compares time reported in Oracle Fusion Cloud Time and Labor with time paid in Oracle Fusion
Cloud Global Payroll. A difference of O signifies that the hours reconcile, while a negative difference signifies that some
hours didn't transfer to payroll. The extract includes time cards that cross the current payroll period. You can also
include old time cards retroactively adjusted during the current period. And you can see people who need to submit
time cards, who are missing time cards.

The extract includes these parameters:
Department
HCM Group
Include retroactive updates made after this pay period starts
Location
Payroll Name
Payroll Period

It also includes this two-level group hierarchy.
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Group Hierarchy Levels

Level

ORACLE

Object Name

Person and Assignment Details for
Reconciliation Data Group

Time and Calculation Card Details
for Reconciliation Data Group

Description

Person and assignment details for
the specified reconciliation data

group

Time card and payroll calculation
card details for the specified
reconciliation data group.

Chapter 10
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User Entity

ORA_HWM_PERSON_
ASSIGNMENT_DETAILS_UE

ORA_HWM_TIME_CARD_
CALCULATION_CARD_SUMMARY_
INFO_UE
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